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Statement

SonoScape Medical Corp. (hereinafter called SonoScape) owns the intellectual property rights to this manual, and also
maintains the contents of this manual as confidential information. This manual is a reference for the operation, maintenance
and cleaning of this product and does not convey any license under the patent rights of SonoScape, nor the rights of others.

This manual contains the information protected by copyrights or patents. Reproduction, amendment or translation of this
manual in any manner whatsoever without the written permission of SonoScape is strictly prohibited.

All information contained in this manual is believed to be correct. SonoScape shall not be liable for errors contained herein or
for incidental or consequential damages in connection with the furnishing, performance or use of this manual. SonoScape does
not assume any liability arising out of any infringements of patents or other rights of third parties.

This manual is based on the maximum configuration and therefore some contents may not apply to your product.

This manual is subject to change without prior notice and legal obligation.

Manufacturer’s Responsibility

SonoScape is responsible for the effects on safety, reliability and performance of this product, only if all the following
requirements are met.

e  All installation operations, expansions, changes, modifications and repairs of this product are conducted by SonoScape
authorized personnel.

e  The use or application of the product or the use of parts or accessories is approved by SonoScape.
e  The electrical installation of the relevant room complies with the applicable national and local requirements.
e  The product is used in accordance with the instructions for use.

Documentation

SonoScape provides the documentation consisting of various manuals:
e  The basic user manual describes the basic functions and operating procedures of the system.

e  The advanced user manual provides information about the measurements and calculations available in each mode.

Understand the meanings of the following items clearly before reading this manual.

Item Meaning
WARNING Indicates a potentially hazardous situation which, if not avoided, could result in death or serious injury.
CAUTION Indicates a potentially hazardous situation which, if not avoided, may result in malfunction or damage of
the system.

Indicates a potentially biological hazardous situation which, if not avoided, may result in disease

ar
S

transmission.

s

NOTE Indicates precautions or recommendations that should be used in operating the system.




Boldfaced Indicates controls on the control panel, or on-screen objects such as menu items or keys.
Word

Click Move the cursor to the controls on the display and press the confirm key on the control panel.
> Select a menu item or a key following the path.
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1 Safety

This chapter describes the important information for operating this ultrasound system. To ensure the safety of both

operator and patient, please read the relevant details in this chapter carefully before using this system.

You should be thoroughly familiar with the precautions provided in this manual. Otherwise, the manufacturer is

not responsible for the effects on safety, reliability and performance of the system.

1.1

ifWARNING

1.2

1.2.1

iiWARNING

Intended Use

The system is a general-purpose ultrasonic imaging instrument intended for use by a qualified physician for
evaluation of Fetal, Abdominal, Pediatric, Small Organ (breast, testes, thyroid), Cephalic (neonatal and adult),
Trans-rectal, Trans-vaginal, Peripheral Vascular, Cerebral Vascular, Musculo-skeletal (Conventional and
Superficial), Cardiac (pediatric and adult), Trans-esoph.(Cardiac), Laparoscopic, OB/Gyn and Urology.

The system also provides the measurement and calculation packages used for clinical diagnosis purposes. For

details, please refer to the advanced user manual.

Contraindication: The system is not intended for ophthalmic use or any use causing the acoustic beam to pass
through the eye.

Precautions must be considered in the use of any application. Otherwise, it may result in system damage or serious

injury.

Safety Precautions

Read and understand all precautions in this manual before attempting to use the system. Keep this manual with the
system at all times. Review the procedures for operation and safety precautions periodically.

Electrical Safety

e Any unauthorized personnel should not tamper with the main unit of the system.

e Do not service or maintain the system while it is in use with a patient.

e Do not position the system to make it difficult to disconnect the system from the mains supply.

e Do not use the system with flammable anaesthetics (category AP) or flammable anaesthetics with oxidants
(category APG).

e Do not use the system with other equipment such as an electric knife, high-frequency therapy equipment, or a
defibrillator. Otherwise, electrical shock may occur.

e Connect the protective earth conductor only before powering on the system. Disconnect the ground wire only
after powering off the system. Otherwise, electrical shock may occur.

e Connect the system to the other electrical equipment by using the potential-equalization lead wire before
connecting the power plug of the system to an electrical outlet.

e Do not place the multiple socket-outlet on the floor.

e The video printer should be connected to the specific interface by using the cable provided by the manufacturer.

Otherwise, electrical shock may occur.
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iiCAUTION )

Within the environment that is 1.8 meters (6 feet) around a patient, connect peripherals to the auxiliary power
outlet which is capable of isolation protection; or, power the peripherals by the auxiliary output cable or the
isolation transformer complied with EN/IEC 60601-1, or the power input of the same safety level.

Within the patient environment, when removing the covers or the connectors from the non-medical electrical
equipment without tools during maintenance, calibration or other operations, do not touch the parts of the non-
medical electrical equipment and the patient simultaneously.

Use only the probes provided by the manufacturer. Otherwise, the system will not perform, and an accident
such as a fire may result in the worst case.

Only the peripherals and accessories provided or recommended by the manufacturer can be used. Using other
devices or accessories may degrade the system performance and even cause electrical shock.

Do not pour any fluid onto the system surfaces, as fluid seepage into the electrical circuitry may cause excessive
electrical current leakage or system failure. If any water is spilled onto the system carelessly, stop using the
system and contact the local distributor immediately.

The AC power plug for the system is a three-prong grounded plug and should never be adapted to any two-
prong outlet or by using an adapter. Connect the AC power plug of the multiple socket-outlet to a hospital-grade
power outlet.

If the system is transported to the operating environment with a great temperature change, leave it for
approximately 4 hours before powering it on. Ensure that the temperature and humidity inside and around the
system are equivalent before an operation.

Only qualified physicians or sonographers can perform ultrasound scanning on human subjects for medical
diagnostic reasons.

Do not use the system around a strong electric field, a strong electromagnetic field, or the devices which
generate radio waves, such as a radio, cellular telephones, or transceivers. Using the system in an improper
environment may result in malfunction or damage.

Select the conformed multiple socket-outlet with protective grounding, and ensure that its maximum output
power exceeds the requirement of the system.

The multiple socket-outlet can only be used to provide power to the recommended peripherals of the system.
Do not connect other devices to the multiple socket-outlet. Otherwise, the rated output power of the multiple
socket-outlet may be exceeded, and it may result in failure.

Accessory equipment connected to the analog and digital interfaces must be certified according to the respective
EN/IEC standards (for example, EN/IEC 60950 for data processing equipment and EN/IEC 60601-1 for
medical equipment). Furthermore, all configurations shall comply with the system standards EN/IEC 60601-1.
Do not use an endocavitary probe on the body surface of a patient. Otherwise, the electromagnetic compatibility
of the probe may be degraded.

If the non-medical electrical equipment used with the system is supplied by a multiple socket-outlet with
separating transformer, connect the AC power plug of the multiple socket-outlet to a hospital-grade power
outlet. Consult a professional to ensure that the connection complies with the safety standards.

1.2.2 Mechanical Safety

WARNING @
[ ]

iiCAUTION [ ]

To avoid possible personnel injury and system damage, move the system slowly and carefully.
During the movement, the system could cause injury if the casters roll over feet or into shins. Exercise extreme
caution while moving the system for a long distance, and up or down the ramp.

Lock the foot brakes after arrival.

Do not place other objects on top of the control panel. Do not sit on the control panel or any other part of the
system.
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1.2.3

ifWARNING

itCAUTION

1.3

ifWARNING

Disconnect the foot switch and the power cable before moving the system.

Do not knock or shake the system.

Ensure that the casters are intact and can rotate well before moving the system.
Always use the handle to move the system.

Ensure that the foot brakes are released and all cables are away from the casters before moving the system.

Accessories Caring

Do not use the foot switch in the operating room.

Use the probe carefully. If any part of the transducer surface is scratched, stop using the probe immediately.
Otherwise, electrical shock may occur.

After disinfecting the accessories, wash out chemicals or discharge gases thoroughly from the accessories.
Residual chemicals or gases could result in damage to the accessories, and be harmful to human bodies.

Only trained physicians or sonographers under ultrasound guidance can handle the biopsy needle guides.
During the operation, the operator must observe proper needle insertion sequencing with the needle guide to
avoid undue discomforts, unnecessary risks or injuries to the patient.

Use the legally marketed probe sheath. Refer to package labeling to determine latex content. Natural rubber
latex may cause anaphylactic reactions in some individuals. Avoid contact with items containing natural rubber
latex. Refer to the FDA Medical Alert, March 29, 1991.

Use the legally marketed coupling gel in accordance with relevant local regulations. Read and understand all
precautions in the relevant manual of the coupling gel before use.

Prepare, use, store and dispose the cleaner, disinfectant and sterilant according to the instructions provided by

manufacturers.

Do not disconnect the probe during the real-time scan. Otherwise, it may damage the probe and the system.

Disconnect the probe from the system after freezing an image or powering off the system. Otherwise, the

system or the probe could be damaged.

Biohazard Considerations

To minimize the risk of cross-contamination or infectious diseases when performing a biopsy, the operator
should wear disposable gloves, protective clothing or protective goggles if it is needed. Follow the working
regulations strictly in case the skin contacts the samples.

Some disinfectants or sterilants are acid or alkaline. Use them with caution, and prevent hands or clothing
from coming into direct contact with them. Wash hands or eyes immediately in case of any contamination by
disinfectants.

Dispose of cleaners, disinfectants or solutions in accordance with local standards or regulations.

Acoustic Power Principle

Perform ultrasound procedures prudently under the guidance of the ALARA (as low as reasonably achievable)
principle. Only expose the patient to the lowest practical transmit power levels in the shortest possible period to
achieve a satisfactory diagnosis.

Freeze the image at any time if you are not operating the system for a long period of time.

Do not scan the same part of an patient continuously or expose the patient to prolonged scanning. Doing so may
harm the patient.

Do not expose the fetus to prolonged scanning in the Doppler mode.

Although the output power is automatically controlled for the selected applications, high TI values should be
kept to a minimum or avoided in obstetric applications.
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1.3.1

1.3.2

1.3.3

e You should be familiar with the performances and operations of the system, observe the ultrasound output
parameters on the screen at all times.

Biological Safety

Diagnostic ultrasound is recognized as being safe, but the possibility of biological effects exists when using it in
high exposure levels and long exposure times. Thus ultrasound should be used in a prudent manner to provide
medical benefit to the patient.

ALARA

It is required to practice ALARA when using ultrasound energy. Practicing ALARA ensures that the total energy
level is controlled below a low enough level at which bioeffects are not generated while diagnostic information is
being accumulated. The total energy is controlled by output intensity and total radiation time. The output intensity
necessary for examinations differs depending on the patient and the clinical case.

Not all examinations can be performed with an extremely low level of acoustic energy. Controlling the acoustic
level at an extremely low level leads to low-quality images or insufficient Doppler signals, adversely affecting the
reliability of the diagnosis. However, increasing the acoustic power more than necessary does not always contribute
to an increase in quality of information required for diagnosis, rather increasing the risk of generating bioeffects.

The operator must take responsibility for the safety of the patient and utilize the ultrasound deliberately. Deliberate
use of the ultrasound means that output power of the ultrasound must be selected based on ALARA. Additional
information regarding the concept of ALARA and the possible bioeffects of Ultrasound is available in a document
from the AIUM (American Institute of Ultrasound Medicine) title “Medical Ultrasound Safety”.

Mechanical and Thermal Indices

The display of the system consists of two parts: Thermal Index (TI) and Mechanical Index (MI).

MI/TI Explanation

In October 1987, the American Institute of Ultrasound in Medicine (AIUM) ratified a report prepared by its
Bioeffects Committee (Bioeffects Considerations for the Safety of Diagnostic Ultrasound, J Ultrasound Med.,Sept.
1988: Vol. 7, No. 9 Supplement), sometimes referred to as the StoweReport, which reviewed available data on
possible effects of ultrasound exposure. Another report “Bioeffects and Safety of Diagnostic Ultrasound” dated
January28, 1993, provides more current information.

e Mechanical Index (MI)

Mechanical bioeffects are threshold phenomena that occur when a certain level of output is exceeded. The
threshold level varies, however, with different types of tissue. The potential mechanical bioeffects varies with
peak pressure and ultrasound frequency. The MI accounts for these two factors. The higher the MI value,
the greater the likelihood of mechanical bioeffects occurring. There is no specific MI value that means that
a mechanical effect is actually occurring. The MI should be used as a guide for implementing the ALARA
principle.

e Thermal Index (TI)

The TI value informs the operator about the conditions that might lead to an increase in temperature on the
surface of the body, within the body tissue, or at the point of focus of the ultrasound beam on bone. That is, the
TI value informs the operator about the potential temperature rise in body tissue. It is an estimate of temperature
increase in body tissue with specific properties. The actual amount of any temperature rise is influenced by
factors such as tissue type, vascularity, mode of operation and others. The TI value should be used as a guide
for implementing the ALARA principle.

Depending on the examination and type of tissue involved, TI could be one of three types:

— Soft Tissue Thermal Index (TIS) is used when imaging soft tissue only, it provides an estimate of potential
temperature rise in soft tissue.

— Bone Thermal Index (TIB) is used when bone is near the focus of the image as in the third trimester, it
provides an estimate of potential temperature rise in the bone or adjacent soft tissue.
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— Cranial Bone Thermal Index (TIC) is used when bone is near the skin surface as in transcranial examination,
it provides an estimate of potential temperature rise in the bone or adjacent soft tissue.

] MI/TT Display

TI and MI values are displayed in real time on the screen. The operator should observe these index values during
examinations and ensure that exposure time and output values are maintained at the minimum amounts needed for
effective diagnosis.

The MI and TI precision is 0.1.

1.3.4 Transducer Surface Temperature Limits

For probes intended for internal applications, e.g. the endocavitary or transesophageal probes, the surface

temperature of the probe may change by adjusting system parameters.

The maximum surface temperature of the endocavitary probes is 43°C. To protect the patient against the harm of
excessive temperature, the probe stops working automatically when its temperature reaches the limit. The surface
temperature of the probe is displayed on the screen.

PAT: 37.0°C ——Patient Threshold Temperature

TIP: <28°C——Transducer Tip Temperature

1.3.5 Imaging Functions that Change Acoustic Output

The qualified operator may use the system controls to limit the ultrasound output and to adjust the quality of the
images. The operator should observe the acoustic output display for possible effects.

There are three categories of system controls relative to output. They are controls that have direct effect on the

output, controls that indirectly control output and controls that are receiver controls.

14 Safety Symbols

The following table is provided for your identification of important symbols located in labels on the system.

Symbol Meaning

Caution

Dangerous voltage

Pinch hazard

Risk of explosion if used in the presence of flammable anesthetics

PP

This product is provided with a CE marking in accordance with the regulations stated
c € 0197 in Council Directive 93/42/EEC.

Authorized representative in the European community
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Type BF applied part

Main switch OFF

Main switch ON

On/Standby switch

Foot switch connector

Protective earth (ground)

Equipotentiality

Alternating current

G BV e -op

Degree of IP protection

.E
=
=<
Y)

Non-ionizing electromagnetic radiation

N
~~
°
N
N2

Manufacturer

Date of manufacture

Follow instructions for use

Network port

USB port

Fragile

5o LE

IN
[N
[N

Keep dry

No stacking

mx <)
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Maximum stacking limit of packages

Maximum of two layers allowed for the monitor

Keep this way upward

Serial number

Rechargeable (for battery only)

This symbol indicates that waste electrical and electronic equipment must not be
disposed of as unsorted municipal waste and must be collected separately. Please

contact an authorized representative of the manufacturer for information concerning

|§ﬂ S =<

the decommissioning of your equipment.
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2 System Overview

This ultrasound system adopts advanced ultrasonic Doppler technologies.

To ensure the performance and availability of this ultrasound system, you should be thoroughly familiar with the

operations of system components, the control panel, the key panel and the basic screen.

2.1 System Configuration

The standard system configuration mainly consists of the following items:
e Main unit
e Probes

e Others: See the Packing List in the packaging box.

2.2 Physical Specifications

e System dimensions: approx. 726mm(W)x1389mm(H)*559mm(D)
e System weight: approx. 60kg

2.2.1 System Components

Figure 2-1 System Overview




2 System Overview

1 LCD Monitor 13 Pencil Probe Port

2 Touch Screen 14 Probe Holder

3 Coupling Gel Holder 15 Engineering USB Port
4 Control Panel 16 Cable Hanger

5 Front Panel 17 Speaker

6  Transducer Cable Hanger 18 Fan

7  Probe Port 19 Cable Hanger

8  Power Indicator 20 Dust Filter

9  Charging/Discharging Indicator 21 Peripheral Device Panel
10 Battery Capacity Indicator 22 DVD Drive (optional)
11 Caster 23 USB Port

12 Foot switch Port 24 On/Standby Button

2.2.2 Peripheral Device Panel

NS /

Figure 2-2 Peripheral Device Panel

1 VGA Video Output Used for connecting a video device to acquire VGA signals, such as
monitor or projector.

2 USB Port Used for connecting the USB devices.
3 Network Port Used for connecting the DICOM server or the network.
4 S-VIDEO Port Used for connecting a video device to acquire S-VIDEO signals, such as

monitor or projector.

5 Audio Signal Output Used for connecting an audio device.

6 Video Printer Port Used for connecting the video printer.

7 Mains Supply Switch Used for powering on or off the system.

8 Power Input Used for connecting the power cable.

9 Equipotential Terminal Used for equipotential connection, balancing the protective earth potentials

between the system and other electrical equipment.
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10

ECG Port (optional)

Used for connecting the ECG cable.

11

Video Output

Used for connecting a video device to acquire compound signals, such as
video printer.

2.2.3 Control Panel

©2000009 g

Power
<2>

<

<36> Depth

Figure 2-3 Control Panel

<1> Power Rotate it to adjust the ultrasound acoustic power.
<2> Probe Press it to select a probe and an icon for the corresponding exam type.
<3> End Exam Press it to end the exam for the current patient in the real time mode.
<4> Patient Press it to enter the New Patient screen.
<5> Review Press it to display the Patient Exam List screen.
Or, press it to enter the Review Image screen when creating a new patient exam.
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<6> Scale Knob Rotate it to adjust the image when activating the zoom feature.
<7> Zoom Press it to activate the zoom feature.
<8 3D/4D Press it to enter or exit the 3D/4D mode.
<9> Dual Press it to enter the dual split display.
Or, press it to activate the desired image in the dual split display.
<10> | Report Press it to enter the Report screen.
<l1> | P1 Press it to save images, cine or volume data. For details, refer to Section 4.1.4
Defined-Key Settings.
<12> | Print Press it to trigger the network printer if the network printer is successfully connected.
<13> | Video Print Press it to print the current screenshot if the video printer is successfully connected.
<14> | Save Press it to save cine in the frozen mode.
<15> | Clear Press it to remove all measurement results, annotations and body mark symbols from
the display.
<l6> | M Press it to enter the inactivated M mode.
Or, rotate it to adjust the gain value in the M mode.
<17> | CW Press it to enter the inactivated CW mode.
Or, rotate it to adjust the gain value in the CW mode.
<18> | PW Press it to enter the inactivated PW mode.
Or, rotate it to adjust the gain value in the PW mode.
<19> | CFM Press it to enter the CFM mode.
Or, rotate it to adjust the gain value in the CFM mode.
In 3D/4D mode, rotate it to move the 3D image horizontally.
<20> | B Press it to enter the B mode.
Or, rotate it to adjust the gain value in the B mode.
<21> | Confirm Key | Defined as the confirm key.
Press it to confirm the current operation.
<22> | Pointer Press it to activate the clipboard in the 2D (B/CFM/PDI/TDI)/M mode.
Or, press it to activate the cursor in the 3D/4D mode.
<23> | Annot Press it to annotate an image with typed words.
<24> | Update e Press it to enter the M/PW/CW mode in inactivated M/PW/CW mode.
e Press it to switch between measurement markers when performing the distance
or ellipse measurement.
e Press it to undo the trace when performing a trace measurement.
<25> | Calc Press to activate the application-specific measurement and calculation features.

12
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<26> | Caliper Press to activate the basic measurement and calculation features.
e Press it to perform the distance measurement in the 2D (B/CFM/PDI/TDI)/
M/3D/4D mode.
e Or, press it to activate the velocity measurement in the PW/CW mode.
<27> | Trackball Use it to move the cursor and adjust ROI.
<28> | -Audio+ Rotate it to adjust the volume.
<29> | TGC Use these sliders to adjust the TGC settings at different scan depth.
<30> | m-tunning Press it to optimize an image automatically.
<31> | Angle e Rotate it to adjust the flow direction in the PW/CW mode.
e Rotate it to adjust the angle of M line in the M mode.
e Rotate it to adjust the arrow direction if the arrow annotation feature is activated.
e Rotate it to adjust the probe direction if the body mark feature is activated.
e Rotate it to adjust the angle of hip joint when performing the pediatrics
measurement.
<32> | Arrow Press it to add arrows on an image.
<33> | Body Mark Press it to add body marks on an image.
<34> | Depth Rotate it to adjust the scan depth.
<35> | Save e In the real-time mode or frozen mode, press it to save an image.
e In the real-time contrast imaging mode, press it to set the start frame for a cine of
blood flow, and press it again to set the end frame.
<36> | Freeze Press it to freeze an image in the real time mode.

Or, press it again to restore the real time scan.

Basic User Manual
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2 System Overview

2.2.4 Basic Screen

‘Il 2| 3 4 5 6 7 8 9
| | | |
' ' ' MI0.2 'TIS0.7/12/03/2016'14:30:30 |
20121212234565- Patient L Operator
o | el 10
<:- 5
21— :
- EAV, 11
c Tip: 25¢ 12
20— -
14
L <>
T el 15
| |
19 18 17 16
Figure 2-4 Basic Screen
1 Logo 13 Depth Scale and Focal Position
2 Institution Name 14 Clipboard
3 Patient ID 15 Network Connection Status
4 Probe Model/Exam Type 16 Cine Loop Icon (in frozen mode)
5  Patient Name 17 Imagining Area
6  MI and TIS Indices 18 Cine Loop Status (in frozen mode)
7  System Date and Time 19 THI and PW/CW Status
8  Exam Type Icon 20 PW/CW/M Mode Imaging
9  Operator Information
10 Measurement Result Area 21 Color Flow Mode Imaging
11 Color Map (in Color/PDI mode) / Information
Grayscale Map (Right) 22 B-Mode Imaging Information

12 Temperature Display Area

2.2.5 Touch Screen

The touch screen above the control panel provides controls which can be used to select the probe model in
accordance with the exam type, annotate the image or perform the measurement. The touch screen contains several
types of controls, depending on the feature to be performed.

NOTE:

A same effort can be achieved by using controls on the touch screen or controls and knobs located on the
control panel and the key panel if they are of the same name. In such condition, only the system operated with
the touch screen is described in this manual.
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2 System Overview

fCAUTION To avoid damaging the touch screen,

Do not expose it in direct sunlight.

Tap it gently with fingers.

Do not operate it with a sharp or hard object.

Do not locate it in environmental temperature of sudden changes.

Do not locate it near static electricity or high voltage.

Keep the screen clean without any adhesive tapes.

Controls located on the touch screen are displayed as follows:

e

_/

3

Figure 2-5 Touch Screen

Touch Screen

The display varies with the feature to be performed.

Key-Panel Key

Press it to activate the key panel of the touch screen.

Or, press it again to return to the previously operating screen.

Image Optimization

Rotate the knob that is directly below the desired item to adjust the value

Knob when optimizing the image.
Generally, rotating it clockwise can enable the feature or increase the value of
the corresponding parameter; rotating it anticlockwise can disable the feature
or decrease the value of the corresponding parameter.

Setup Key Press it to enter the System Setting menu.

[ Application Mode Screen

The application mode screen (as shown below) is used to select the probe model or exam type.

The system enters the following screen by default once it is started up. Press the Probe key on the control panel to

return to the following screen when you enter other screens.
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2 System Overview

Figure 2-6 Application Mode Screen

] Imaging Mode Menu

The imaging mode menu (as shown below) is used to select the imaging mode, optimize the image or adjust
parameters. Select an exam type from the application mode screen to enter the following screen.

B | Imaging Mode
buttons
Pannoramic ‘ ECG ’ -\
@ Imaging Feature
buttons
Compound . o
p2 ’ ‘ Trapezoid ’ ‘ ﬂ ’ _|_D )
T ‘ =4 ] ol |
Frequency uScan Chroma DYN Focus Imaging Parameter
4 51 P |4 2 | IR | 1 > | 4 1 > | € » | buttons

Figure 2-7 Imaging Mode Menu

] Annotation/Body Mark Menu

The annotation/body mark menu is used to select an annotation or body mark. Press the Annot or Body Mark
button on the control panel to enter the corresponding screen. Take the body mark menu as an example, the screen
is shown as below.
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| Clear || Delete || Exit |

Figure 2-8 Body Mark Menu

] Measurement Menu

The measurement menu is used to select the measurement item to be performed.

Press the Caliper key on the control panel to enter the basic measurement menu. Or, press the Cale key on the
control panel to the application-specific measurement menu.

‘ Applicat ’ ‘ Exit ’
Lt Subclav A ‘ Lt CCA ’ ‘ Lt Bulb ’ ‘ Lt ICA ’ ‘ Lt ECA ’
Lt Vertebral

A
Vessel Diam Vessel Area ’ ‘ %Sten(D) ’ ‘ %Sten(A) ’ ‘ IMT Post ’
IMT Ant
Side Position
‘ Left ’ ‘ N Delete Last

Figure 2-9 Measurement Menu

] Key Panel of Touch Screen
The key panel of the touch screen (as shown below) is used to enter the text, such as the patient information. Press

on the control panel to enter the following screen.

Basic User Manual 17



2 System Overview
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Figure 2-10 Key Panel of Touch Screen
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3 Preparing the System

System preparation is necessary performed before using the system. The preparation includes but is not limited to

moving, positioning or adjusting the system, connecting the probe and the peripheral devices..

3.1 System Assembly

assembled before it is powered on.

ﬁWARN'NG Only service personnel authorized by the manufacturer can assemble the system. Ensure the system is firmly

Figure 3-1 System Assembly

1 M3x8 Screws 5 8 Main Unit
2 Control Panel Back Cover 6  Fixing Board
3 M4x10 Screws 7  Cable Trough
4 Monitor Arm 8 Fixing Bracket

Perform the following steps to assemble the system.

L.
2.
3.

Take out the back cover of the control panel by removing two M3x8 screws with a cross screwdriver.
Remove M4x10 screws from monitor arm by using a cross screwdriver.

Place the fixing board on the fixing bracket, and fix it by using three M4x10 screws.

Plug VGA signal cable and power supply cable into corresponding sockets on the fixing bracket.

Install the back cover of the control panel by fastening two M3x8 screws.
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3 Preparing the System

3.2 System Moving/Positioning

ﬁc‘“’m" Leave at least 20cm at the back and both sides of the system for ventilation. Otherwise, the temperature rise could

cause failures.

\ﬂ Unlock —-‘:'::.:i_:_.

@Lock
Brake

Perform the following steps to position the system.
1. Unlock the four foot brakes.
2. Move the system with the handle.

3. Lock the four foot brakes after placing it in the desired location.

33 Connecting and Powering the System
Two methods can be used to supply power for the system: mains supply and built-in rechargeable lithium battery.

When the adapter is connected to the mains supply, the battery is charged until it is full.

3.3.1 Using the Mains Supply

Two switches are provided for the system.

e The power switch located on the peripheral device panel is used to connect or disconnect the system with the

mains supply.

e The d) key on the side panel is used to start up or shut down the system.

e ® Ensure the system works with the required voltage before you connect it to the mains supply. For details, refer
A to Appendix A Specifications.

e Do not pull the power cable forcibly.

To connect the system:

1. Connect the power grounding cable to the grounding terminal.

2. Connect the power cable to the mains power socket on the peripheral device panel of the system.

3. Set the power switch on the peripheral device panel to the | position.
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3 Preparing the System

3.3.2 Using the Battery

\WARNING @
[

Do not disassemble or alter the battery. Otherwise, there is a danger of explosion.

Replace the battery with the same or the equivalent type.

Do not short-circuit the battery by directly connecting the system with metal objects.

If the battery emits an odor or heat, is deformed or discolored, or appears abnormal during use, charging or

storage, remove it and stop using it immediately. If you have any questions about the battery, please contact the
manufacturer.

Do not use a battery if it leaks. If your skin or clothing is stained with the fluid from the battery, thoroughly
wash the area immediately with clean water. If the fluid comes into contact with your eyes, immediately flush
your eyes with water and seek an oculist for help.

If the battery is found damaged, severely degraded or used for 3 years, dispose of it in accordance with the local

laws or regulations.

The battery is automatically charged when the system is connected to the mains supply through a power supply

cable.

If the system is disconnected from the mains supply, the system is automatically powered by the battery.

itCAUTION [ )

A fully charged battery can work continuously for more than one hour.

Two batteries are used for system power supply, they must satisfy the following specifications,
— Nominal voltage: 14.8V

— Battery capacity: 9.6Ah/142Wh

- Limited charging voltage: 16.8V

— Charging temperature range: 0°C~ 45°C

Discharging temperature range: -20°C~ 60°C

Use only the battery when there is an emergency or no reliable mains supply is available. You are always
recommended to use the AC supply instead of the battery to guarantee the battery life.

Charge the battery in an area with a temperature range from 0°C~ 45°C and discharge it in an area with a
temperature range from 0°C~ 60°C to maintain the lifespan of the battery.

Always charge the battery to full to maintain the lifespan of the battery.

When the battery capacity is low and the battery cannot be charged in time, you need to save all unsaved data
before the system automatically shuts down. Otherwise, you may lose useful information.

To avoid the battery damage causing the system damage, observe the following precautions:

— Do not immerse the battery in water or allow it to get wet.

— Do not discard the battery in a fire.

— Do not leave the battery in direct sunlight or expose it to temperature over 60°C (140 °F).

- Keep the battery away from fire and other heat sources during use and charge.

— Do not place the battery into a microwave oven or other pressure vessels.

— Do not pierce the battery with a sharp object, hit it, or step on it.

3.3.3 Indicators

The status of indicators is shown in Table 3-1.

Table 3-1 Indicator Descriptions

Status Indicator Mains Supply Battery Supply

Battery Charging Indicator

:c',’_ Yellow, charging Off

Green, fully charged
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3 Preparing the System

3.4

Status Indicator Mains Supply Battery Supply

Green Off
<«

Mains Supply Indicator

k] Off Green, full capacity
Battery Discharging Indicator

Yellow, low capacity

Blinking yellow, extremely low capacity, the system

automatically shuts down and the buzzer beeps.

Powering On/Off the System

fWARNING e Do not power off the system during a system upgrade or a data transmission.

e An extra 30-60 seconds are needed for powering on the system if it is powered off in an abnormal way
previously.

e If the system is configured with the uScan feature, do not connect the USB device to the system before system
startup.

e Wait approximately 20 seconds before powering on the system again after powering it off. Otherwise, a failure
may result.

e Do not unplug the system from the AC power outlet before the shutdown hint disappears. Otherwise, the data
may be lost or corrupted.

e To maintain the safety and functionality of the system, maintenance must be performed at least once every year.
For details, refer to 15 System Maintenance.

34.1 Powering On the System
1. Set the power switch on the rear panel to the | position.
2. Press the (') key on the side panel to power on the system.
All operating indicators illuminates, the initial screen and the application mode screen appear after the system
completes the initialization.
3.4.2 Powering Off the System
1. Press the (b key on the side panel to power off the system.
2. Set the power switch on the rear panel to the O position.
3.4.3 System Standby
If the system is idle for a set period, the screen saver will be activated. For details, refer to Section 4.1.1 General
Settings.
3.5 Adjusting the System
3.51 Adjusting the Monitor Arm
NOTE:
» Be careful with your fingers when adjusting the monitor arm.
» Lock four casters before you adjust the monitor arm.
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3 Preparing the System

10cm

e To adjust the monitor vertically, move the upper arm towards to or backwards from the lower arm.

e To adjust the monitor horizontally, swivel the upper arm left or right.
3.5.2 Adjusting the Display Monitor

n To swivel the LCD monitor

Grip the upper and lower sides of the monitor, tilt the monitor forward or backward.

Grip the left and right sides of the monitor, swivel the monitor left or right.

(s ST

Basic User Manual
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3 Preparing the System

3.6

itCAUTION

3.6.1

3.6.2
3.6.3

3.7

3.7.1

ifWARNING

To adjust the brightness and contrast

Adjusting the LCD monitor’s brightness and contrast is one of the most important factors for obtaining the
optimum image.

The proper setup displays a complete gray scale. The lowest level of black should just disappear into the
background and the highest white should be bright, but not saturated.

Use the buttons located on the bottom of the monitor to adjust the brightness and contrast settings of the monitor.

e Press Enter to enter the monitor menu.

e Press Enter, press — or to + highlight Auto Adjust, and press Enter to automatically optimize the monitor
settings.

e Press — to display the setting menu for Contrast. Pressing + can increase the value of the contrast; pressing —
can decrease the value.

e Press + to display the setting menu for Brightness. Pressing + can increase the value of the brightness;

pressing — can decrease the value.
Connecting the Probe

e Disconnect the probe from the system after freezing an image or powering the system off. Otherwise, the probe
of the system could be damaged.

e Do not pull the probe cable forcibly. Otherwise, the probe could be damaged.
Connecting the Probe

1. Rotate the locking lever 90° anticlockwise to the rr position, and then insert the probe connector into the
probe port firmly.

2. Rotate the locking lever 90°clockwise to lock it securely.

Connecting the Pencil Probe

Connect the pencil probe to the port located on the front panel of the system.

Disconnecting the Probe

Rotate the locking lever 90°anticlockwise to the horizontal position, and then pull the probe connector straight out
vertically.

Connecting the Peripheral Device

Connecting the Foot Switch

e To avoid damaging the foot switch, do not place the foot switch on the system.

e Use only the foot switch provided by the manufacturer. Otherwise, the system or the foot switch may

malfunction..

24
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3 Preparing the System

Connect the foot switch to the foot switch port of the system as the figure shows below.

/

Ultrasound system

Used for image

freezing
3.7.2 Connecting the Video Printer
VIDEO OUT VIDEO INPUT
© ©
PRINT REMOTE
G ©
Ultrasound system Video printer

Connect the video printer to the system by BNC cable and Remote Control cable provided by the manufacturer.
You can refer the installation method as the above figure shown. The video printer can work without any

configurations after a successful connection.
3.7.3 Connecting the Network Printer

] Printer Setup

1. Connect the printer to the system, and turn on the printer. The printer settings are displayed as below.

Vs

§
O OA

O O O d

\ [ x ]

2. Press OK on the control panel menu of the printer.

3. Press qor P to sclect Network Config, and then press OK to confirm.
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3.74

4.
S.
6.
7.

Press € or P> to select TCP IP Config, and then press OK to confirm.
Press € or P> to select Manual, and then press OK to confirm.
An IP address is displayed, change it to 192.168.254.103 by pressing € or P>, and then press OK.

If the IP address is correct, use Qor P> to select Yes, and then press OK.

If the IP address is incorrect, use € or P> to select No, and then press OK. Repeat step 6 to enter a correct
address.

After setting the IP address, set the subnet mask to 255.255.255.0 and the default gateway to
192.168.254.104 in the same way as described above.

Ultrasound System Setup

1.
2.
3.

Copy the driver file deskjet.ppd provided by the manufacturer into the directory of the USB drive.
Connect the drive to the system, and then start up the system.
Press the Setup key to enter the System Setting menu, and click Peripheral.

Tick Static IP and input the settings for IP Address, Netmask, Default Gateway and DICOM AE
Title.

NOTE:

IP address and Printer IP should be set in the same network segment.

Set Default Printer to Net Printer, and set the IP address of the printer.

Click Add Printer and reboot the system after the installation is complete.

Connecting the USB Printer

1.
2.
3.

e

Connect the USB printer to the system by using the USB cable.

Copy the driver file deskjet.ppd provided by the manufacturer into the directory of the USB drive.
Connect the USB drive to the system, and then start up the system.

Press the confirm key to enter the System Setting menu, and click Peripheral.

Set Default Printer to USB Printer, and Click Add Printer.

Reboot the system after the installation is completed.

26
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4 Customizing Your System

The System Setting menu allows you to specify general system settings, printing, measurement and calculation
settings. You can also define the annotation library and shortcut keys. All your customized settings can remain

even after rebooting the system.

After starting up the system, the LCD monitor displays the system desktop and the touch screen displays the application mode
screen as shown in Figure 6-1. Press the Setup key on the control panel to enter the System Setting menu.

To make settings in the System Setting menu,

e Select one tab, and press the confirm key on the control panel to enter a setting menu.

e Move the cursor on an item by using the trackball, and press the confirm key on the control panel to select one item.

e Move the cursor to a textbox beside an item and use the key panel to manually type the value.

e Select an option from each drop-down list.

e Select Save&Exit to save any changes and exit the System Setting menu.

e Select Exit to quit the System Setting menu.

4.1 General System Settings
You can make general system settings on the General, Display, Storage and KeyConfig tabs.

4.1.1 General Settings

System Setting

General General | Display | Storage |KeyConﬁg|

Peripheral Hospital Name |

Comment Freeze Response [Cre )
Bodymark Trackball Sensitivity ~ [3____|(*)
Measure Language&Time
Touch Screen Language [Engish ()
Report Time Zone [ (GMT+08:00) Beijing, Chongging, HongKong, Urumgi |u]
Time Setting

11/01/2015 16:00:00 Date Format | MM/DD/YYYY @
Load Default Date/Time Setting Time Format )

User Security

DICOM

About Monitor Type ™)
Caps Lock o0
Clear Annot On Unfreeze[ON__](+]
Guide Line Type [Guon 1)

Save&Exit Focal Auto E]

Exit

Figure 4-1 General Settings Menu - General Tab
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Hospital Name

Enter the institution’s name.

Freeze Response

Select the feature to be enabled after you select the Freeze key.

Trackball Adjust the sensitivity for the trackball movement. A greater value brings about a higher

Sensitivity sensitivity.

Language Choose a system language for the user interface, and reboot the system for it to take
effect.

Time Zone Set the local time zone.

Date Format Set the date format for the system.

Date/Time Setting

Set the system date and time.
Select this item to set the system date and time manually in the pop-up text box.
NOTE:

You should set the system date and time for your initial use of the system.

Time Format

Set the time format between 12 Hour and 24 Hour.

Monitor Type

Set the video type.

Caps Lock

Enable or disable the capital letter feature.

e Set it to ON, all the typed letters are capital. Pressing Shift + X can enter a lower-case
letter.

e Set it to OFF, all the typed letters are lowercase. Pressing Shift + X can enter a capital
letter.

Clear Annot On
Unfreeze

Enable or disable the annotation-cleared feature after you unfreeze the image in the
annotation editing mode.

e Sect it to ON, all annotations are cleared after you press the Freeze key in the
annotation editing mode.

e Set it to OFF, all annotations are not cleared.

Guide Line Type

Select a type for the biopsy guidelines.
e Set it to Gun, one biopsy guideline is displayed when performing the biopsy.

e Set it to Needle, two parallel biopsy guidelines are displayed when performing the
biopsy. These guidelines make up the guide zone within which is used to guide a safe
biopsy.

Focal Auto

Enable or disable the auto-focus feature.

e Set it to On, the focal depth varies with the depth in the B mode.
The focal depth varies with the ROI position in the CFM/PDI/TDI mode.

e Set it to Off, the system never adjusts the focal depth.
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4 Customizing Your System

4.1.2 Display Settings

System Setting

General General | Display | Storage |KeyConﬁg|
Peripheral

Comment Color of ROI E]
Bodymark Display Format E]
Measure Screen Saver E]
Touch Screen Screen Saver Delay(min)
Repor Annot Font Size E]

DiCOM

Load Default

User Security

About

| Save&Exit | Show Images In Gallery Show Gallery

| Exit |

Figure 4-2 General Settings Menu - Display Tab

Color of ROI Set the color for the interest region box.

Display Format Set the default display format for the M and PW/CW modes.

Screen Saver Enable or disable the screen saver feature.

Screen Saver Delay (min) Set the period to activate the screen saver.

Annot Font Size Set the font size of the annotations.

Show Images In Gallery View images and cines coming with the system or imported from external
storage devices.

] Show Images in Gallery
Perform the following steps to perform a demonstration.

1. Click Show Gallery to enter the Show Gallery screen, as shown in Figure 4-3.
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Show Gallery

Gallery

Config

Top
8]

Down

Bottom

Import
Delete
Load Default

Exit

gl

Figure 4-3 Show Gallery Screen

2. Load default demos or import demos stored in an external storage device.
— Select a demo and click Top, Up, Down or Bottom to arrange the order.

— Select a demo and click Delete to remove it from the gallery.

— Press the confirm key to pause or resume the demonstration.

— Press the Freeze key to stop the demonstration.

— Press the Up/Down/Left/Right arrow key to go to the previous or next demo.

3. Select a demo and press the confirm key on the control panel twice to start a demonstration.

4.1.3 Storage Settings
System Setting
General General Display | Storage |KeyConfig|
D | i Format TG
e 0
Bodymark DICOM Color Space [RGB |(7)
Store Frame Amount E
Touch Screen Print&Store Region B
Report Image Share Service E
[ Store To UsbDisk
DICOM
Load Default
User Security
About
Save&Exit
Figure 4-4 General Settings Menu - Storage Tab
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Clip Format Set the cine storage format.

Still Format Set the image storage format.

DICOM Color Space Set the type of color space of DICOM file. This feature is only available for
cine stored to DICOM storage server in JPEG format.

Store Frame Amount Set the maximum number of frames for cine.
Print&Store Region Set the area to be printed out.
Image Share Service Enable or disable the share feature.

e Set it to On, you can remotely access to a computer for shared files.

e Set it to Off, you disable the feature.

Store To UsbDisk Tick it, after you connect the USB drive to the system, saved image are synchronously
stored to the USB drive.

4.14 Defined-Key Settings

System Setting

General General | Display | Storage |KeyConﬂg|
Peripheral —[Save] — [P1] — [P2]
Comment —Save Image —Save || -Save
Bodymark O Print @® Image @ Image
[ Send to Usb O Cine O Cine
[ Dicom Send O Volume O Volume
Di Print
Touch Screen SD 'Cco_m min — Save Auto Response — | | — Save Auto Response —
Report [ Save tine O Print O Print
[ Send to Usb
DICOM ‘ [ Send to Usb [ Send to Usb
[ Dicom Send [ Dicom Send [ Dicom Send
Load Default — End Exam
User Security Status after end exam O Dicom Print [ Dicom Print
[ Active new patient [ O] | ]

About

— [3D4D]
Probe [VC6-2 -]
The default entry options:

Save&Exit o 3D

@® 4D

Exit

i

Figure 4-5 General Settings Menu - Key Configuration Tab

Image Tick it and press the P1 key to save the desired image.

Cine Tick it and press the P1 key to save the desired cine.

Volume Tick it and press the P1 key to save the desired volume data.

Print Tick it and press the Save or P1 key to save the desired image and print it out.
Send to USB Tick it and press the Save or P1 key to save the desired data to the USB drive.
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DICOM Send

Tick it and press the P1 key to send the desired data to the DICOM storage server.

You can select the specific DICOM storage server from the drop-down list when defining the
P1 key.

DICOM Print

Tick it and press the Save or P1 key to send the desired image to the DICOM storage server.

You can select the specific DICOM print server from the drop-down list when defining the
P1 key.

Activate new

Tick it and the New Patient screen will automatically appear after you end the exam by

patient pressing the End Exam key.
The default Set the default inactivated mode. After pressing the 3D/4D key, the system automatically
e defau
. enters the inactivated 3D or 4D mode when using the volume probe selected from the drop-
entry options

down list beside Probe.

4.2 Peripheral Device Settings
You can make local network settings, wireless network settings and printer settings on the Peripheral Device
Settings menu. The wired network will take priority when wired network and wireless network are available at the
same time.
System Setting
General — LocalNetwork[Enable |(¥ }——— — Wireless Network[Enable](~]
Easmm— O DHCP o Static IP Name [state  [Level
Mr.Wu Conn 2
Comment IP Address |:| °
Bodymark | | Netmask L. ]
Default Gateway [ . . . |
Advance
Touch Screen
Report DICOM AE Title
Mac Address 1
DICOM
— ot Ping IP Address | | [ Connect | [ Disconnect |
oa erau
- [ Refresh | [ Advance |
User Security
Speed 100M 3] | —Printer
PrinterDriver _m
Duplex Full Duplex | v] I W efaultPrinter ] (-]
5 0 = Video Invert E]
earcl €
' . ' 1| oefauit Printer ®
Save&Exit . .
Speed: 100Mb/s Duplex:Full Net Printer IP :l
Figure 4-6 Peripheral Device Settings Menu
] Local Network Settings
Address Mode Select an IP address mode.
IP Address Set the IP address of the system.
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4.3

NetMask Set the netmask address of the system.
Default Gateway Set the gateway address of the system.
Speed/Duplex Click Advance, Speed and Duplex textboxes are displayed on the menu.
You can adjust the settings of these items to change the speed and communication mode
of the local network.
Click Set to save the settings, and then you can click Search to view your settings.
DICOM AE Title Set the Application Entity (AE) title of the system.
Mac Address View the MAC address of the system.
Ping IP Addr. Type an IP address and click Ping to test the connection.

Wireless Settings

Wireless Network Enable or disable access to wireless network.

Name Displays the name of the wireless network.

State Displays the connection status of the wireless network.

Level Displays the signal strength of the wireless network.

Advance Click Advance to view the information of your current network, and make settings of

your local network.

Connect the wireless network as follows:

1. Click Refresh to display all wireless networks on the menu.

2. Select the desired wireless network and click Connect.

3. Input the password in the pop-up dialogue box if needed and click OK.

Printer Settings

Printer Driver

The default option is the most recently installed printer driver.

Video Invert

Color is inverted when printing the report.

Default Printer Set the type of the default printer.
Net Printer IP Set an IP address of the network printer.
Add Printer Click the button and follow the on-screen instructions to install a printer driver.

Defining Annotation Library

You can add, modify, delete or arrange the predefined annotation on the Annotation Settings menu.
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System Setting

| General || aBD | oB [GYN|vas[sreEAsTICARD | URO | smP | MsK |
Peripheral
L
Bodymark L-Lobe
RK 2
Hepatic A
Pancreas
R
R-Lobe
LK
. Head.Panc
DICOM Edit Comment ltem Spleen
Load Default | | |Liver
Caudate
User Security M.Hepat.V
Add to Lib Duct.Panc
Body.Panc
Save&Exit

Figure 4-7 Annotation Settings Menu

e Enter an annotation in the Edit Comment Item textbox, and then click Add to Lib to create a new
annotation in the library.

e Click on an annotation in the Selected list, and then click Delete to delete it from the library.
e Click on an annotation in the Selected list, and then click , , m or E to arrange its display.

4.4 Body Mark Settings

System Setting

J

Load Default

[l ] [ ] [= ] [=]

User Security

About

| General | Bodymark |

| Peripheral | Application| vAs |( 7]

| Comment | Available ————— — Selected

| Bodymark | Application@ ivé Q w
| Measure | X\Ti Q’ é u &
| Touch Screen | s )JA(
| Report | W w

[ Dpicom | t

| |

| |

| |

Save&Exit
Load Default

Figure 4-8 Body Mark Settings Menu
1. Select an exam type from the drop-down list beside Application.

2. Select a body mark library from the drop-down list beside Application of Available.
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3. Add desired body marks in the selected body mark library to the Selected list.
- Select a body mark and then click > to add it to the Selected list.
- Click >> to add all body marks in the selected body mark library to the Selected list.

Select a body mark in the Selected list and click < to remove it from the Selected list.

— Click << to remove all body marks from the Selected list.

4. Select a body mark in the Selected list and then click [ <= | [ <= | | = |or[ = |to arrange its display.

4.5 Measurement Settings

You can adjust measurement settings on the General, Application and List tabs.

4.5.1 General Measurement Settings

System Setting

General | [General [Application]  List |
Peripheral —General Result Position———————————
Comment BSA Eastern ) | |2D RightTop ()

Bodymark Cross Cursor Size  [Medium __|(v) Dual+Quad  [Right Bottom|(~¥)
Measure Measure Line Size ~ [Medium ] M RightTop_|(¥)
Touch Screen Dist. Dash Line Disp. [On_ J(*] | | poppler RightTop__|()
Report Vel. Cross Line Disp. B
DICOM Ellip. Cross Line Disp.@
Load Default Line ID Disp. SR £2)
User Security | | Keep Result Window of 1)
About Result Font Size [3

Save&Exit

Exit Load Default

Figure 4-9 Measurement Settings Menu - General Tab

] General Measurement Items

BSA In accordance with the setting of this item, the system calculates BSA value
automatically after you enter the height and weight of the patient on the Patient
Information screen.

Cross Cursor Size Set the size of the cross cursor.
Measure Line Size Set the thickness of the measurement line.
Dist. Dash Line Disp. Enable or disable the display of a dash line between two points when performing a

distance measurement.

Vel. Cross Line Disp. Enable or disable the display of a reticle between two points when performing a

velocity measurement.
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Ellip. Cross Line Disp. Enable or disable the display of dash lines for long and short axes when performing

a ellipse measurement.

Line ID Disp.

Enable or disable the display of line number when performing a measurement.

Keep Result Window

Enable or disable the display of the current result box when unfreezing the image.

Freeze on Measure

real-time mode.

Enable or disable the frozen feature after pressing the Calc or Caliper key in the

Result Font Size

Set the font size of the result box.

] Result Position

Set the position of the result box.

2D

Dual+Quad

M

Doppler

Choose from: Right Top, Right Bottom, Left Top or Left Bottom

4.5.2

Application Settings

System Setting

Save&Exit

General | General |Application| List |
Peripheral Application
Comment Auto/Man Trace— —Shortcut Key
PS Num 1
ED Num 2
IEII Num 3
. Num 4
DICOM TAmax Num 5
Load Default ;I'/?:nean Num 6
User Security HR Num 7
Num &
About Num 9
Num 0

|

Exit

Measurement Setting
CUA/AUA AUA [v]

Add 1 week to EDD
Show EDDonscreen [No [ ]
Growth Dev. Display

Equation

GA&Growth

Fetal Weight —————————
Estimation B
Age by EFW [Hadiock ][~
EFW GP/SD[Willams _____|(¥)

Unit e 1
CUA
[CUA BPD,HC,ACFL |(7] |

Load Default

n Auto/Man Trace

After selecting an exam type from the application drop-down list, set the measurement items of Auto/manual trace

Figure 4-10 Measurement Settings Menu - Formula Tab

in the spectral Doppler mode.
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] Shortcut Key

Select OB, GYN or Cardiac from the drop-down list beside Application, and then select a measurement item
from the drop-down list beside Num 0 to Num 9. After making these settings, you can perform the Obstetrics,
Gynecology or Cardiology measurement by using the defined shortcut key.

] Small Parts Measurement Settings

Select SMP from the drop-down list beside Application and set the coefficient of the thyroid volume formula.

[ Obstetrics Measurement Setting

Set the formula for obstetrics measurement.

CUA/AUA Set to display CUA or AUA on the measurement report.
CUA stands for Composite Ultrasound Age and AUA stands for Average Ultrasound
Age.

Add 1 week to EDD Enable to add one week to EDD.

Show EDD on screen Enable to display EDD in the measured result box.

Growth Dev. Display Set the display format of GA deviation in the measurement report and
growth graph.
Estimation Set the formula to estimate EFW.

If it is set to None, the system will not estimate fetal weight and no corresponding
value displays on the measurement report.

Age by EFW Set the formula to estimate GA by EFW.

If it is set to None, the system will not estimate GA by EFW and no corresponding
values are displayed on the measurement report.

EFW GP/SD Set the formula of the fetal growth curve.

If it is set to None, no values about the fetal growth curve are displayed on
the measurement report.

Unit Set the weight unit.

CUA Set the CUA formula.

If it is set to None, the system will not estimate CUA and no corresponding value
displays on the measurement report.

] Equation Setting
You can customize the formula for gestational age and growth curve.
Perform the following steps as follows:
1. Click New Table to bring up the New Table dialogue box.

2. Select New GA Table or New Growth Table and click the OK button. The screen shown in Figure 4-11 or
Figure 4-12 pops up.
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GA Table
Measurement|  |+v] Author [ ] Deviation[-25D/+2SD_|[v)
Meas -2SD Mean +2SD
Unit [ mm [~] wtd [~ ]w+d [+ Jw+d [~]
[Meas[mm] |-2SD[w+d] [Mean[w+d] ~ [+2SD[w+d] [a
1 B
2
3
4
5
6
7
8
9
10
1
12
13
14
15
16
17
18
19
v
[Save&Exit][  Exit |
Figure 4-11 GA Table
Growth Table
Measurement[ |v] Author [ | Deviatio{-2SD/+2SD | ¥
Meas -2SD Mean +2SD
Unit [ w+d [~] mm [~ ]mm [+ ]mm [+]
|Agefw+d] |-28D[mm] [Mean[mm] ~ [+2SD[mm] [a
1 B
2
3
4
5
6
7
8
9
10
1
12
13
14
15
16
17
18
19
v
[Save&Exit |[  Exit |

Figure 4-12 Growth Table

3. Select or input the Measurement, Author, Deviation and the corresponding Unit.

4. Enter the gestational weeks and the values of measurement items in the table.

5. Click the Save&Exit button to save the customized formula and exit.
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453 List Settings

System Setting

General | General |Application| List |
Peripheral Application[Abdomen | v}
Comment O Caliper ® Calc
Bodymark List
@B O Color oM O Doppler
Touch Screen Category  Collection Measurement
Report Default Liver Length
Port.V. Height
Dicom Gallbladder __ Width
Load Default Pancreas
|
User Security E%ﬁzg
Aorta
Bladder

- Measurement
Save&Exit ¥

| Add | | Delete | | Reorder

Load Default

Figure 4-13 Measurement Settings Menu - List Tab

You can add, delete or reorder the measurement collections and items in each imaging mode of the selected
application.

] To Add a Collection or Measurement

Perform the following steps as follows:

1. Select an exam type from the drop-down list beside Application.
Select the Caliper or Calc.

Select an imaging mode in the List frame and click Collection or Measurement.

R

Click Add to add the desired collection or measurement on the pop-up screen.

5. Click Close to complete.

] To Delete a Collection or Measurement
Perform the following steps as follows:
1. Select an exam type from the drop-down list beside Application.
2. Select the Caliper or Calc.

3. Select an imaging mode in the List frame and click the collection item or measurement item that you wish to
delete.

4. Click Delete.

] To Reorder the List of Collections or Measurements
Perform the following steps as follows:
1. Select an exam type from the drop-down list beside Application.

2. Select the Caliper or Calc.
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3. Select an imaging mode in the List frame and click the Collection or Measurement.

4. Click the Reorder and adjust the sequence of the collection or measurement on the pop-up screen.

4.6 Touch-Screen Settings
System Setting
General .| Items Config !
Peripheral Select Probe [z]
Comment
[ B | m [ cmm | P | Pw
Status
Measure |_c Active O Freeze | X
Special ltems
I&' [ 3D/4D ][ Contrast ][ Panoramid| Il [ ]
PlaneSwitch] =
DICOM Compound L/R 4B
Load Default [ ma ][ ] | [ UpDown J[_28 ]
User Security | Frequency |[ uScan ][ Chroma ][ DYN ][  Focus | I
About —Second Page
[ I Il Il Il Il ]
[ Biopsy J[ MwA ] <> [ & ]
[ I ] I I ]
[Bio.Cali. || ] [Rotation ] [ ][ ] L
| save&bxit || |[_Power% ] [ GrayMap ] [ SecWidth] [ LineDensity] [ Persist ] v
Figure 4-14 Measurement Settings Menu - Touch Screen Tab
You can add, modify, delete the parameter displayed on the first or second page of the touch screen after selecting
probe type, exam type or imaging mode.
4.6.1 Adding A Parameter
Click a blank box, and then click the desired parameter in the Special Items list to add it.
4.6.2 Modifying A Parameter
Click a parameter, and then click the desired parameter in the Special Items list to replace it.
4.6.3 Deleting A Parameter
Click a parameter, and then click ... in the Special Items list to delete the desired parameter.
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Report Settings
System Setting
rLogo
| General | 9
| Peripheral | Operation LOGO
| Comment |
170x60Pixel bmp
| Bodymark | x4
| Measure | riieront
| TouchScreen | | Title1[ @) Title 57
| Repot | | Tite2 [ Jm[+) Subtitle o[+
| DICOM | Tile3 [ ] Background Color [ I |
12

| Load Default | Context Text Color E
| User Security | ~Display Items For Report
| About | [ Patient Information

& Exam Information

& Measurements

1 Image Images 2x2 |(~)
| SavesExit | 1 Graphs Graphs 2x2 (7]

2 Comment
| Exit |

Figure 4-15 Report Settings Menu

Logo Connect the USB drive containing the report logo (170x60 pixels, bmp format) to the
system. Operation LOGO is highlighted after the USB drive is successfully detected
by the system.

Click Operation LOGO, and then click the desired logo in the pop-up dialogue box
to add the logo.
If there is more than one logo, you can click or to select the desired logo.

Title1/2/3 Input the title name in the textbox and then set the font size using the drop-down list.

Title Set the font size of the headline.

Subtitle Set the font size of the subtitle.

Context Set the text font size.

Background Color Set the background color of the measurement report.

Text Color Set the text color.

Display Items for
Report

Select items to be displayed on the measurement report. Patient and exam information
is displayed on the report by default. Other information can also be displayed on the
report after you tick Measurements, Image, Graphs or Comments.

After settings, you can click Preview to preview the report. Press the Freeze button on the control panel

to exit.
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4.8

4.8.1

Configuring DICOM

Storage Service Settings

You can connect the system to the DICOM storage server and adjust the relevant settings on the Storage Service
tab.

System Setting

| Store [C-Store |workiist | MPPS | Print | QRList |
Sonveo st [Bomsime ) [ pas ] [ oo ]
—DICOM Image Storage

Remote HostName | DicomStore |

IP Address [ 192.168.254.104 | [Ping ]
DICOM AE Title [ AE | [Echo |
Port Number

Connect Timeout(sec) Repeat Count
Dimse Timeout (sec) Acse Timeout (sec

User Security

About

Relate To CommitStore | StoreCommitment | v ]

|:| Send After Every Image Stored
[[] send At End of Exam

<

2D Compression  [None

2D JPEG Quality [None (

Exit
(
(

Save&Exit

Cine Compression |None

< «

<4

Cine Quality None

Figure 4-16 DICOM Settings Menu - Storage Service Tab

Service List Select the DICOM storage server.

e Select Append from the drop-down list beside Service List, input the relevant
parameters information and click Add to add a new server.

e Sclect any server from the drop-down list and click Delete to delete the server.

Remote Host Name Enter the name of the DICOM storage server.

IP Address Set the IP address of the DICOM storage server.

After the setting, click Ping to test the connection.
DICOM AE Title Set the Application Entity (AE) title of the DICOM storage server.
Port Number Set the port number of the DICOM storage server.

Connect Timeout(sec)

Set the time limit of network connection timeout.

Repeat Count

Set the number of repeated attempts for connecting to the DICOM storage server.

Dimse Timeout(sec)

Set the timeout time for sending the Dimse command.

Acse Timeout(sec)

Set the timeout time for sending the Acse command.

Relate to CommitStore

Select the desired DICOM commitment storage server to be associated with the
DICOM storage server.
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Send After Every Image
Stored

Tick this item and the system sends an image to the DICOM storage server every
time the image is saved.

Send At End of Exam

Tick this item and the system sends all saved images to the DICOM storage server
after the exam is completed.

2D Compression

Select the compression format of image stored to DICOM storage server.

2D JPEG Quality

Select the quality of image in JPEG format stored to DICOM storage server.

Cine Compression

Select the compression format of cine stored to DICOM storage server.

Cine JPEG Quality

Select the quality of cine in JPEG format stored to DICOM storage server.

Click Echo to verify the connection between the system and the server after you input the settings. A summary

displays if the connection is verified.

4.8.2 Commitment Settings

You can connect the system to the DICOM commitment storage server and adjust the relevant settings on the

Commitment Storage tab.

System Setting

| Store |C-Store |workist | MPPs | Print [QRList |

Save&Exit

Exit

Peripheral . .
Service List | StoreCommitment E] | Add | | Delete |
—DICOM Storage Commitment
Bodymark Remote HostName | StoreCommitment |
Measure
IP Address [ 192.168.254.104 | [Ping |
_ DICOM AE Title [ AE | [Echo |
Port Number 105
DICOM
Load Default Connect Timeout(sec) Repeat Count
User Security Dimse Timeout (sec) Acse Timeout (sec) 30 |
|:| Synchronously Receive N-EVENT-REPORT Message

Figure 4-17 DICOM Settings Menu - Commitment Storage Tab

Service List

Select the DICOM commitment storage server.

e Sclect Append from the drop-down list beside Service List, input the
relevant parameters information and click Add to add a new server.
e Seclect any server from the drop-down list and click Delete to delete the

SCrver.

Remote Host Name

Set the name of the DICOM commitment storage server.

Basic User Manual
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IP Address Enter the IP address of the DICOM commitment storage server.

After the setting, click Ping to test the connection.

DICOM AE Title Set the Application Entity (AE) title of the DICOM commitment storage
server.

Port Number Set the port number of the DICOM commitment storage server.

Connect Timeout(sec) Set the time limit for the network connection timeout.

Repeat Count Set the number of repeated attempts for connecting to the DICOM

commitment storage server.

Dimse Timeout(sec) Set the timeout time for sending the Dimse command.
Acse Timeout(sec) Set the timeout time for sending the Acse command.
Synchronously Receive Tick this item and the system receives the N-EVENT-REPORT messages

N-EVENT-REPORT Message | synchronously with the storage server.

Click Echo to verify the connection between the system and the server after you input the settings. A summary
displays if the connection is verified.

4.8.3 DICOM Worklist Settings

You can connect the system to the DICOM worklist server and adjust the relevant settings on the Worklist tab.

General | Store | C-Store |Work|ist | MPPS | Print |QR List |

Peripheral Service List [Workist ______|(~) | Add || Delete |

System Setting

— DICOM Worklist

Remote HostName [ Workiist |

IP Address [ 192.168.254.104 | [Ping |
DICOM AE Title [ AE | [Echo |
Port Number 105

Connect Timeout(sec) Repeat Count
Dimse Timeout (sec) Acse Timeout (sec)
Max. Result

| Save&Exit |

| Exit |

Figure 4-18 DICOM Settings Menu - Worklist Tab
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Service List Select the DICOM worklist server.

e Sclect Append from the drop-down list beside Service List, input the relevant
parameters information and click Add to add a new server.

e Seclect any server from the drop-down list and click Delete to delete the server.

Remote Host Name Enter the name of the DICOM worklist server.

IP Address Set the IP address of the DICOM worklist server.

After the setting, click Ping to test the connection.

DICOM AE Title Set the Application Entity (AE) title of the DICOM worklist server.

Port Number Set the port number of the DICOM worklist server.

Connect Timeout(sec) Set the time limit for the network connection timeout.

Repeat Count Set the number of repeated attempts for connecting to the DICOM worklist server.
Dimse Timeout(sec) Set the timeout time for sending the Dimse command.

Acse Timeout(sec) Set the timeout time for sending the Acse command.

Max. Result Set the maximum number of patient records that can be sent to the system.

Click Echo to verify the connection between the system and the server after you input the settings. A summary
displays if the connection is verified.

4.8.4 MPPS (Modality Performed Procedure Step) Settings

You can connect the system to the MPPS server and adjust the relevant settings on the MPPS tab.

System Setting

| General | [ store [c-store [workist | MPPS | Print [QRList |
| Peripheral | Service List [MPPS__ |(v) | Add | | Delete |
| Comment _| — DICOM MPPS
| Bogymark | Remote HostName [ MPPS |
| Measure | IP Address [192.168.254.104 | [Ping ]
| Touch Screen | .
DICOM AE Title [ AE | [Echo |
| Report |
Port Number 109
|  pcov |
| Load Default | Connect Timeout(sec) Repeat Count
| User Security | Dimse Timeout (sec) Acse Timeout (sec)
| About |
| Save&Exit |
| Exit |

Figure 4-19 DICOM Settings Menu - MPPS Tab
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Service List

Select the MPPS server.

e Sclect Append from the drop-down list beside Service List, input the relevant
parameters information and click Add to add a new server.

e Seclect any server from the drop-down list and click Delete to delete the server.

Remote Host Name

Enter the name of the MPPS server.

IP Address Set the IP address of the MPPS server.

After the setting, click Ping to test the connection.
DICOM AE Title Set the Application Entity (AE) title of the MPPS server.
Port Number Set the port number of the MPPS server.

Connect Timeout(sec)

Set the time limit for the network connection timeout.

Repeat Count

Set the number of repeated attempts for connecting to the MPPS server.

Dimse Timeout(sec)

Set the timeout time for sending the Dimse command.

Acse Timeout(sec)

Set the timeout time for sending the Acse command.

Click Echo to verify the connection between the system and the server after you input the settings. A summary

displays if the connection is verified.

4.8.5 Print Service Settings

You can connect the system to the print service server and adjust the relevant settings on the Print Service tab.
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System Setting

DICOM
Load Default

|  Genera | | store | c-store [workist | MPPS | Print | aRList |
perphersl | senvcotist  [bicomprit_J(7) [ ada | [ Dekte |
Comment
—DicomPrint
_ Remote HostName  [DicomPrint |
IP Address [192.168.254.104 | [Ping ]
DICOM AE Title [AE | [Echo ]|

Port Number 109

Connect Timeout(sec)

User Security
About

Save&Exit
Exit

—Properties

Format [3
Priority @
Medium [PAPER __ |(¥]
Orientation [3
Film Size M )
Film Destination E]
Magnification [3
Copies

Smoothing Type

Trim E]
Border [3
Empty Image [3
Color @
Min Density
Max Density 320
Configure Information |:|

Film Session Label

L1

Figure 4-20 DICOM Settings Menu - Print Service Tab

Service List

Select the DICOM print server.

e Select Append from the drop-down list beside Service List, input the relevant
parameters information and click Add to add a new server.

e Sclect any server from the drop-down list and click Delete to delete the server.

Remote Host Name

Enter the name of the DICOM print server.

IP Address Set the IP address of the DICOM print server.

After the setting, click Ping to test the connection.
DICOM AE Title Set the Application Entity (AE) title of the DICOM print server.
Port Number Set the port number of the DICOM print server.
Format Set the print format.
Trim Set to print or not to print a crop box around each image.
Priority Set the print job priority.
Border Set the color of the border to fill in the gap between the images.
Medium Select the print medium.
Empty Image Set the color of the empty images.
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Orientation Set the print orientation.

Color Set the color of the image.

Film Size Set the film size.

Min Density Set the minimum density level of the film.
Film Destination Set the film destination.

Choose from: MAGAZINE or PROCESSOR
e Sctit to MAGAZINE, the image will be stored in a film magazine.
e Setitto PROCESSOR, the image will be processed in a film processor.

Max Density Set the maximum density level of the film.

Magnification Set the method used for magnifying images during the print.
Configure Make special image quality settings.

Information

Copies Set the number of copies to print.

Film Session Label Enter a name to be applied on a group of the film labels.
Smoothing Type Set the value of magnification interpolation for the printer.

Click Echo to verify the connection between the system and the server after you input the settings. A summary
displays if the connection is verified.

4.8.6 QR List

You can connect the system to the QR service server and adjust the relevant settings on the QR List tab.

System Setting

[ General | [ Store [C-Store [Workist [ MPPS [ Print [ QRList |
Perbrersl | Servioo st [k |v) [ Asa | | Dolre]
Comment

—Dicom QR List
Bodymark
Remote HostName
Measure
Touch Screen IP Address [192.168.254.104 | [Ping |
Report DICOM AE Title [AE | [Echo ]
DICOM Port Number

Load Default

User Security

Connect Timeout(sec) Repeat Count
30|

Dimse Timeout(sec) Acse Timeout(sec) 30

About
Max.Result 100

Save&Exit

Exit

Figure 4-21 DICOM Settings Menu - QR List Tab
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Service List Select the QR server.

e Sclect Append from the drop-down list beside Service List, input the relevant
parameters information and click Add to add a new server.

e Sclect any server from the drop-down list and click Delete to delete the server.

Remote Host Name Enter the name of the QR server.

TP Address Set the IP address of the QR server.

After the setting, click Ping to test the connection.

DICOM AE Title Set the Application Entity (AE) title of the QR server.

Port Number Set the port number of the QR server.

Connect Timeout(sec) Set the time limit for the network connection timeout.

Repeat Count Set the number of repeated atempts for connecting to the QR server.
Dimse Timeout(sec) Set the timeout time for sending the Dimse command.

Acse Timeout(sec) Set the timeout time for sending the Acse command.

Max. Result Set the maximum number of patient records that can be sent to the system.

Click Echo to verify the connection between the system and the server after you input the settings. A summary

displays if the connection is verified.

4.9 Defining System Defaults

You can define your system defaults on the Loading Defaults Menu.

System Setting

Measure
Touch Screen
Report
DICOM
Load Default
User Security

About

Save&Exit

Exit

General
Peripheral Load | | New | Export/Import
Comment
Bodymark ot

i il

Figure 4-22 Loading Defaults Menu
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| To Load System Defaults
1. Click Load, select a setting name, and then a dialogue box appears.

2. Type Y on the control panel to confirm and begin loading;

Or, type N on the control panel to cancel loading;
Press the Delete key on the control panel to delete the system defaults.

3. Select OK to confirm it.

| To Create System Defaults

Click New, enter a setting name in the text box. The created setting name will be listed on the Loading Defaults
Menu.

| To Export or Import System Defaults

Click Export/Import to enter the following menu.

System Setting

General

Peripheral Load | | New | |Exporl/|mport

Comment

Bodymark Make sure USB drive in the USB slot

I

Touch Screen

| Copy user setting to USB |

Report [ Copy user preset to USB |

DICOM
Load Default

| Load USB user setting to system |

| Load USB user preset to system |

User Security | Export Log |

About

Caution: Copy USB to hard drive will replace all user setting

Save&Exit in the sytem including patient database, Please use it wisely

Exit

Ensure the USB drive is connected to the system before exporting or importing the system defaults.
e Click Copy user setting to USB to back up the system defaults to the USB drive.

e Click Copy user preset to USB to back up the customized system defaults to the USB drive.
e Click Load USB user setting to system to copy the system settings to the system.

e Click Load USB user preset to system to copy the customized system to the system.

e Click Export Log to export the log to the USB drive.

4.10  User Security

The user security settings can be used to protect patient data and the feature is disabled by default. If the feature is
enabled, user can log in the system by the following two ways.
e Account Login

Account login contains administrator account login and ordinary user account login. User can log in the system
by inputting user name and password. When you enter the system, the g icon pops up on the main screen.
Click the figj icon to lock the current user or switch to other users.
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e Emergency Login

User can log in the system through emergency mode without inputting user name or password. But user can not
access previous patient data in the system.

System Setting

| General | | User Settings AdministralorSettings|
Peripheral
Password
Comment
Bodymark
Measure

Touch Screen
Report
DICOM

Load Default

User Security

About

Save&Exit

Exit

Figure 4-23 User Safety Settings Menu - User Settings Tab

Ordinary user can modify password on User Settings tab.

4.10.1 Administrator Settings
When user first logs in the administrator settings screen, user name and password should be entered to make user

security settings.

NOTE:

» It's recommended to modify the password after the administrator logs in the system for the first time.
e User name is case-sensitive.
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System Setting

Save&Exit

Exit

| General | | User Settings Administrator Settings
Peripheral
Comment User authorization rAuto Log Off
© On © Off © On © off
Bodymark Wait:
Measure — User List - )
User NamelUser Type|Al | Add User | Data Security Log
o ©on  ©on
Delete User
[Epot ] [Gear
Modify Password
DICOM ~ Medium Output
Load Default © On © off
i
User Access Control
Access Al Dato

Figure 4-24 User Safety Settings Menu - Administrator Settings Tab

User authorization

User can enable or disable the user authorization function on Administrator
Settings tab.

When user authorization function is enabled, user should input the user name and
password on login screen.

Account management list

Add user: Click Add User, input the user name and set the password in the pop-up
dialog box.

NOTE:

» Only ordinary user account can be added.

» Password must contain 8 -16 characters, at least including two combinations
of number, letter or special character. Letters are case-sensitive.

Delete user: Click Delete User and delete the selected user according to the system
prompt.

Modify password: Click Modify Password and modify the selected password
according to the system prompt.

Import users: Click Import Users> Import to Medium on the pop-up dialog box,
and click Import.

NOTE:

Only account data exported from the system in the same series models
produced by the manufacturer can be imported.

Export users: Click Export Users > Export to Medium on the pop-up dialog box,
and click Export.
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Auto lock off User can enable or disable the auto logout function.

Set the wait time before the system log out automatically when the system is idle.

If the system is idle for a set period of wait time, the system will automatically lock
the current user and return to the login screen.

Data security log Data security log is used to record the operation performed by user, including
login, logout, patient data viewing, modification, export, and operation time, date

and user name, but no patient information will be recorded.

Only administrator can export data security log to an external storage device or
delete the data security log.

Medium export When user authorization function is enabled, administrator can enable or disable
the medium output feature.

NOTE:
When the user authorization function is disabled, the medium output is enabled
by default.

User access control User access control is used to set the access authorization for patient data.

e If All Data is selected, both administrator and ordinary user can access all
patient data.

e If Private Data is selected, administrator can access all patient data and
ordinary user can only access the patient data collected by the user itself.

4.11 Viewing System Information

Press the Setup key on the control panel and select About on the pop-up menu to enter the system information
menu.

4.11.1  General Information

You can view the current hardware version, the software version and the control number on the General tab. The
control number is a unique number for the system.

4.11.2  Acoustic Output

You can view the acoustic output data of probes in different modes on the Acoustic Output tab.
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System Setting

| General |Acoustic Output|

Peripheral
Comment Register Type
Bodymark |—|[L]
Measure Probe Type
Touch Screen I—I[L]
Exam Type

Report

picow | —n 1)

Load Default

User Security

About

Save&Exit

Exit

I Wi

Figure 4-25 About Menu - Acoustic Output Tab

4.11.3 Touch Screen Information

Hold & on the control panel to enter the following screen.

Touch Adjust

Version

Y
System Update

~—

Exit

Figure 4-26 Touch-Screen Information Screen

e Press the Freeze key on the control panel or tap Touch Adjust to calibrate the touch screen. For details, refer
to Section 4.12 Calibrating the Touch Screen.

e Tap Version to view the version information about the touch screen.

e If the USB drive written with the software of the touch screen, the USB icon is highlighted, and you can click
System Update to update the software.

4.12  Calibrating the Touch Screen

Perform the following steps to calibrate the touch screen
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1. Hold on the control panel.
2. Tap Touch Adjust to enter the Touch Adjust screen.

3. Tap the center of every pop-up €5 continuously to calibrate the touch screen.

Press the Freeze key on the control panel to exit at any time.

Basic User Manual
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S Preparing for an Exam

You can start an exam without entering any patient information. To avoid patient identification errors, you should

always verify the identification information with the patient.

5.1 Acquiring Patient Information

You can acquire the patient information in the following instructions:
e Create new patient information
e Retrieve archived patient information

e Receive patient information using the DICOM worklist

5.1.1 Beginning a New Patient

Press the Patient key on the control panel to display the Patient Information screen.

New Patient

rBase Information

PatientID | | weight [ Jkg [ ]ib
LastName | | M| | Height [ Jem [ |in
First Name | | BSA(m” 2 1w
poB [MMDD/YYYY JAge[ Jv[_Im[ b BP(mmHg) [ /[ JkPa)[_ [ |
Sex ) Comments

rExam Information

0B | 6YN |[cardiac Vascular [Urology | sMP | PED | Msk [Nerve | ortho | Other |

Description |:|
Chief Compliant |:|
Past History |:|
Referring.M.D |:| @
Performing.M.D |:| E]
Sonographer |:| @

Comments :

(Patient List ] WorkList J( ok ][ cancel ]

Figure 5-1 New Patient Screen

NOTE:

You can move the cursor by using the trackball, and then press the confirm key on the control panel to select
the desired item.

Perform the following steps to begin a new patient.

1. Enter relevant patient information
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Patient ID

Name

DOB

Age

Sex

Accession#

Weight and Height

BSA

BP

Comments

2. Select the exam type

Exam type

Description
Primary Indications

Secondary Indications

NOTE:

Enter the patient ID, special characters are prohibited to be entered.

The system will generate the patient ID automatically according to the current
system time if this item is left blank.

NOTE:
The patient ID is an important identification, once it is saved, you cannot modify
it.

Enter the First Name, M.I (middle name) or Last Name of the patient.

Enter manually the date of birth for the current patient. You can set Date Format
on the General Settings menu.

The patient’s age will be automatically calculated if you enter the information in the

DOB textbox.
Enter manually the gender for the current patient.

Enter manually the exam ID for the current patient, special characters are prohibited
to be entered.

Enter manually the weight and height for the current patient.

The system will automatically calculate the body surface area after you enter the
weight and height. You can select the calculation formula from the corresponding
drop-down list

Enter manually the blood pressure for the current patient.

Make comments for the current patient.

Select an exam type for the current patient, including Abdomen, Obstetrics,
Gynecology, Cardiology, Vascular, Urology, Small Parts, Pediatrics,
Musculoskeletal, Neurology, Orthopedics and others.

Enter manually the information related to the exam type.
Enter the related information manually.

Enter the related information manually.

You must enter the height and weight for the current patient when you select Cardiology as the exam type.
BSA will be automatically calculated in accordance with the BSA set on the General Settings menu.

You must enter LMP or EDD for the current patient when you select Obstetrics as the exam type. AUA will
be automatically calculated.

3. Enter the related operating information

Refering. M.D/Performing. M.D/ Enter manually the name.

Sonographer

Comment

Enter manually the notice or necessary information.
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4. Click OK to save the modifications.

If the last patient exam is not completed, the system will remind you to complete or discontinue the exam. For
details, refer to Section 5.3.2 Discontinuing an Exam.

5.1.2 Retrieving Archived Information
You can retrieve the archived information by choosing the Patient key > Patient List > Exam Review.

Press the Patient key on the control panel, and then select Patient List on the prompt menu.

Patient Exam List

Patient ID | | LastName | | Age | | ( Search )

Date (] [05/04/2014] To (] [05/05/2014]  First Name | | sex| W) [ Reset ]
Patient Review

Current Exam [Exam Type[Exam Date/Time |Description | Sonographer | Image Size[ Store State

: (] aBD 05/05/2014-16:04:03 0.00M
New Patient

DICOM Q/R

DICOM Queue

PPS Screen

Import Screen

Export Screen

3
°
o
=
m
b3
°
o
a

Exit

I

D:

[ Resume Exam ][New Exam][ Close Exam ][View Image][ Delete Exam ][ DICOM Send ][ DICOM Print ]

Figure 5-2 Exam Review Screen
Perform the following steps to retrieve information.

1. Search for the archived information

Enter the search requirements, such as Patient ID, First/Last Name, Sex, Exam Date/Time or Age, and then

click Search to search for the desired information.
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5.1.3

5.2

5.2.1

5.2.2

5.3

5.3.1

Patient Exam List

Patient ID | | LastName | | Age | | [ search ]
Date (] [05/04/2014 |To () [05/05/2014 |  FirstName | | sex | [w) [ Reset )
Current Exam Patient ID | Patient Name ‘Birth Date H Sex ‘ Exam Date/Time ‘ Image Size

- D 20140505 Mary Unknown 05/05/2014-16:04:03 40.82M
New Patient

DICOM Q/R

DICOM Queue

PPS Screen

Import Screen

Export Screen

Exit

I
]

3
C S
<]
=4
m
X
°
<)
a

[ View ] [New Exam ] ( Delete Patient |

2. Select the desired information

Move the cursor to the desired information, and press the confirm key on the control panel to select it.
3. Exam the desired patient

Click New Exam to start a new exam.

Using DICOM WorKklist

You can acquire the patient information using the DICOM worklist if the system is configured with the DICOM
module. For details, refer to Section 13.4 DICOM Worklist.

Pausing/Resuming an Exam

Pausing an Exam

1. Press the Patient key on the control panel to enter the New Patient screen, and then click Patient List >
Exam Review to enter the Exam Review screen.

2. Select the current exam, and then click Suspend Exam to pause the exam.

Resume an Exam

1. Press the Patient key on the control panel to enter the New Patient screen, and then click Patient List >
Patient Review to enter the Patient Review screen.

2. Select the desired patient information, and then click View to enter the Exam Review screen.

3. Select the desired exam, and then click Resume Exam to resume the exam.
Completing/Discontinuing an Exam

Completing an Exam
1. Press the End Exam key on the control panel.

A dialogue box pops up as follows:
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2. Click OK to end the exam.

5.3.2 Discontinuing an Exam

Do you wish to end the current exam?

OK | | Cancel

1. Press the Patient key on the control panel to enter the New Patient screen and then click Patient List to
enter the Patient Exam List screen.

2. Click New Patient to enter the New Patient screen. Input the new patient information and click OK.

A dialogue box pops up as follows:

PPS

D Assisted Acquisition Protocol Setting

Code |

Meaningl

Designatorl

Reason | Doctor cancelled procedure

|

|

|
82

[ Completed ] [ Discontinued]

If you tick Assisted Acquisition Protocol Setting, you can send the latest patient information to MPPS
after entering the relevant information to code, meaning and designator.

3. Select the reason from the corresponding drop-down list, and then click Discontinued.

Basic User Manual
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6 Acquiring Images

You can acquire images by optimizing the relevant parameters for clinical diagnosis.

6.1 Selecting a Probe and an Exam Type

Once the system is started up, the LCD monitor displays the background desktop, the touch screen displays the
available probes and the exam types (as shown in Figure 6-1). You can press the Probe key on the control panel to
return to the following mode when you enter other screens. The system automatically enters the basic screen after
you select the desired probe and exam type by tapping the touch screen.

NOTE:

Ensure the probe model and icon displayed on the application mode screen are consistent with the connected
probe. If a problem is found, check that the probe is connected to the system firmly. If the problem still exists,
please stop using the system immediately and contact the manufacturer.

XXX 7
,
v

Figure 6-1 Application Mode Screen
You can also make modifications in an exam type and save them as an application preset for future use. Moreover,
the layout of the application mode screen can be modified and factory defaults can be restored.
6.1.1 Customizing A Preset
1. Select the desired probe and exam type.
2. Select an imaging mode and optimize the image.

NOTE:
Parameter optimizing is only available for the current imaging mode.

3. Press the S key on the key panel to display the following dialogue box.
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Going to
User Pre-Set Menu
Are you sure(Y/N) ?

4. Press the Y key to enter the User preset screen.

Create preset

Presets display

Probe XXX

Exam Name | |

BxamType (<] Vasouar )2
Bxamicon (<] Cvasouar_|[¥)> ]

Create Exam | | Replace Exam

Figure 6-2 User Preset Menu

5. Enter the name of the application preset in the Exam Name textbox.
6. Select the department and exam type from the Exam Type and Exam Icon lists.

7. Click Create Exam to create the customized application preset.

If the name of the application preset exists, you can click Replace Exam to replace it.

6.1.2 To arrange the presets display
Click Presets display to arrange the presets display. The customized application presets, not the system
application presets, can be also deleted.
NOTE:
An exam type suffixed with (s) is a system application preset, suffixed with (u) is a customized application
preset.
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Create preset

Presets display

Preset Exam

Cardiology(s)
Liver(s)
Granial(s)
Difficult(s)
new(u)

Restore Factory Default |

-

Figure 6-3 Preset Display Menu

e Click one desired application preset, click |I| or to arrange the preset on the application mode screen.

e Click one desired application, click Delete > Yes to delete the application preset.

e Click Restore Factory Default > Yes in the pop-up dialogue box to restore factory defaults.

6.2 Acquiring B-Mode Images

B-mode imaging is intended to provide information of anatomical structure of soft tissue.

6.2.1 Entering B Mode

The system enters B mode by default after you select a probe model and an exam type.

You can press the B key on the control panel to enter the B mode from other imaging modes.

The basic screen in the B mode is displayed as follows:

B

FPS 47 @
D/IG 3/1

GN 255

I/P 3/30

PWR 70

FRQ 3-4.8

D 16.5cm

5 a °

o

Figure 6-4 B-Mode Imaging Screen

For details on operating the basic screen, refer to Section 2.2.4 Basic Screen.

6.2.2 Optimizing B-Mode Images

The touch screen displays all controls related to the B-mode imaging (as shown in the figure), you can use them to

optimize B-mode images.
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65



6 Acquiring Images

e

Pannoramic

ECG ’

Compound . jaY|a)

) ’ Trapezoid ’ ‘ ﬂ ’ oo
THI ‘ K ’ oo

Frequency uScan Chroma DYN Focus

4 51 P |4 2 > | « 1 > | < 1 > | < 4

Figure 6-5 B-Mode Imaging Parameters Menu

To optimize the image by using controls in the following instructions:

e Tap the left or right part of an item to adjust the parameter, the value displays at the bottom of the item. You
can tap @ on the touch screen to turn the current menu to the previous or the next page if it displays over one
page.

e Or, rotate the knob on the control panel that is directly below the selected item to adjust the value.

NOTE:

You can adjust all parameters in the real time B mode, but can only adjust Chroma and Gray Map in the

frozen B mode.

Gain

The B mode gain (2D gain) determines the amplifying factors for the received echoes and the brightness of the

ultrasound image. The echoes are amplified with the same gain value regardless of depth.

To adjust the gain:

e Rotate the B knob on the control panel clockwise to increase the value.

e Rotate the B knob on the control panel anticlockwise to decrease the value.

TGC

TGC (Time Gain Compensation) is used to adjust the gain that allows compensation for attenuation of the echoes
over time (depth). It is adjustable during the real time scan regardless of the imaging mode and display format.

TGC balances the image so that the density of echoes is the same throughout the image.
To adjust TGC:

e Move the desired slider to the left to decrease the value.

e Move the desired slider to the right to increase the value.

NOTE:

* Modifications of TGC values cannot be saved if you shift to use another imaging mode.

* The TGC curve is displayed in the top right corner of the imaging area when you adjust TGC values, and
the curve disappears if TGC values are not adjusted for more than 3 seconds.

LGC

LGC is used to adjust the brightness on the left or right part of the ultrasound image.
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To adjust LGC:

e Tap LGC L on the touch screen to change the gain on the left part of the ultrasound image.
e Tap LGC R on the touch screen to change the gain on the right part of the ultrasound image.

] Focal Position/Number/Span

The focal position/number/span is used to tighten up the beam for a specific area and the focus identified by a red
triangle is displayed on the right side of the image.

Focus optimizes the image by increasing the resolution for a specific area.

To adjust the focal position/number/span:

e Tap the left or right part of Focus on the touch screen to decrease or increase the depth of focal zone(s).
e Tap the left or right part of Focal Num on the touch screen to decrease or increase the number.

e Tap the left or right part of Focal Span on the touch screen to decrease or increase the value.

] Depth
Depth is used to adjust the distance over which the B-Mode image is anatomized.
To adjust the depth:

e Rotate the Depth knob on the control panel clockwise to increase the depth range of the 2D image and the size
of image is reduced to display the entire ultrasound image.
e Rotate the Depth knob on the control panel anticlockwise to decrease the depth range of the 2D image and the

ultrasound image is magnified.

NOTE:

» The frame rate varies with the depth.
» The range of the scanning depth varies with the probe. D (depth) is displayed in the 2D Image Info area

and is represented in unit of cm.
] Frequency

The probe is capable of generating a broadband signal with a certain start frequency and a certain bandwidth. A
higher frequency brings about higher resolution and lower penetration.

To adjust the frequency:

e Tap the left part of Frequency on the touch screen to decrease the value.

e Tap the right part of Frequency on the touch screen to increase the value.

] Chroma
Chroma is used to colorize the gray scale image to enhance the discrimination capability.
To adjust the chroma:

Tap the left or right part of Chroma on the touch screen to make a setting.

] Compound Imaging

Compound imaging is used to acquire a series of overlapping image frames from substantially differing spatial
directions and combining these images to reduce speckle and improve contrast resolution.

Tap Compound on the touch screen to enable or disable the compound imaging function.

] Line Density

Line density refers to the amount of ultrasound beam that makes up the image. Increasing the value of line density
improves the resolution and decreases frame rate. Therefore, you have to balance the frame rate and the image
quality when adjusting the line density.
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A higher line density is useful in obtaining a very high resolution, such as the thyroid or testicles. A lower line
density is useful when scanning fetal heart beat and adult cardiac applications.

To adjust the line density

e Tap the left part of Line Density on the touch screen to decrease the value.

e Tap the right part of Line Density on the touch screen to increase the value.

] Persistence

Persistence is used to average consecutive frames to provide a smoother appearance with less noise. Use lower

persistence values for fast-moving organs or tissues and higher persistence values for a smoother appearance.

To adjust the persistence:
o Tap the left part of Persist on the touch screen to decrease the value.

e Tap the right part of Persist on the touch screen to increase the value.

| Dynamic Range

Dynamic range increases the adjustable range of contrast by enhancing the intensities of parts in the grayscale. It

optimizes the ultrasound image texture.

To adjust the dynamic range:
e Tap the left part of DYN on the touch screen to decrease the value.
e Tap the right part of DYN on the touch screen to increase the value.

| Grayscale Curve

Grayscale curve optimizes the brightness of each pixel in accordance with the corresponding echo. To adjust the
grayscale curve:

e Tap the left part of Gray Map on the touch screen to decrease the value.
e Tap the right part of Gray Map on the touch screen to increase the value.

| Adaptive Image Fusion

Adaptive image fusion provides choices of optimization methods to improve image quality through boundary

enhancement, image smoothing and system optimization.

To adjust the adaptive image fusion:
e Tap the left part of AdaptFusion on the touch screen to decrease the value.
e Tap the right part of AdaptFusion on the touch screen to increase the value.

[ Sector Width/Angle

Sector width (for linear probes) or sector angle (for curved and phased array probes) is used to adjust the frame

rate. You can adjust the sector width or angle to get more information without moving the probe.
The region of interest of the object can be adjusted after you adjust the sector width or sector angle.
To adjust the sector width/angle:

Tap the left or right part of Sec. Width on the touch screen to change the sector width or angle.

[ Sector Position
Sector position is used to move or rotate the image.
To adjust the sector position:

Tap the left or right part of Sector Pos on the touch screen to move or rotate the image.
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[ Power

Power is used to select the amount of ultrasound acoustic power produced by the probe. The adjustment range
of the power is 1-100%, and £1% can be adjusted each time. The real time value of the power is displayed in the

imaging information area on the basic screen.

To adjust the power:

e Tap the left part of Power% on the touch screen to decrease the value.

e Tap the right part of Power% on the touch screen to increase the value.

NOTE:

Expose the patient to the lowest practical transmit power level for the shortest possible period of time to
achieve a satisfactory diagnosis.
] Tissue Acoustic Characteristics

Tissue acoustic characteristics refer to the speed of ultrasound passing through the tissue. Tissue acoustic
characteristics optimize the image used for measurements and calculations. The greater the tissue acoustic

characteristics the faster the ultrasound passes through the tissues.

To adjust tissue acoustic characteristics:

e Tap the left part of Tissue Acou on the touch screen to decrease the value.

e Tap the right part of Tissue Acou on the touch screen to increase the value.

] Image Rotation

You can rotate the image to get more information. Only transvaginal and transrectal exams are available for this
feature

To rotate the image:
Tap the left or right part of Rotation on the touch screen to rotate the image.

NOTE:
Take notice of the depth calibration displayed at the bottom of the basic screen when the image is rotated by

90° or 270°.

] pScan
uScan is used to improve the image quality.
To use puScan:

e Tap the left part of pScan on the touch screen to decrease the value.

e Tap the right part of pScan on the touch screen to increase the value.

NOTE:

Ensure the dongle is inserted before you enable the yScan feature.

] Trapezoidal Imaging

Trapezoidal imaging is used to enlarge the imaging area when performing a real time scan by using the linear

probes.

To use trapezoidal imaging:

e Tap Trapezoid on the touch screen to enable the feature.

e Or, tap Trapezoid again on the touch screen to disable the feature.

NOTE:

Only the linear probes are available for trapezoidal imaging.
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6.3

6.3.1

6.3.2

Steer

Steer can be adjusted to change the direction of the acoustic beam when performing a real time scan by using the
linear probes.

To adjust the steer:
Tap the left or right part of Steer on the touch screen to change the direction of the acoustic beam.

NOTE:

Only the linear probes are capable of using the steer.

Acquiring Color Flow Images

Color Flow imaging adds the color-coded qualitative information in the B-Mode image. Color Flow imaging is
helpful to see the flow, the relevant qualitative information and the flow velocity.

CFM Mode

CFM is a color flow imaging technology which adds the color-coded qualitative information concerning the relative

velocity and direction of fluid motion in the B-Mode image.
Perform the following steps to acquire CFM-mode images.
1. Optimize a B-mode image.

2. Press the CFM key on the control panel to enter the CFM mode.

B

FPS 47 —0 o
D/IG 31 @ -

GN 255 -

P 3/30 _

PWR 70 s

FRQ 3-4.8 -

D 16.5cm B I
C —_10 :
PRF 1.0 T s
WF 86 -

GN 255 -

CIP 150 ;/\ —1s

PWR 70

FRQ 22 Color Flow ROI 2D Imaging

Figure 6-6 CFM-Mode Imaging Screen

3. Adjust color flow ROI.
— Move the trackball to position color flow ROI.
— Press the confirm key on the control panel to adjust the size of color flow ROI.

— Press the confirm key again to reposition color flow ROI.
4. Optimize the CFM-mode image. For details, refer to Section 6.4.3 Optimizing M-Mode Images.

5. Press the CFM key again to exit the screen.

PDI Mode

PDI (Power Doppler Imaging) is a color flow imaging technology which adds the flow signal in the CFM-mode
image. PDI uses the number and amplitude of red blood cells going through in the flow to create the color-
coded imaging. A flow with slow velocity and small rate can be displayed in PDI. Therefore, a flow with a higher

sensitivity can be detected without overlaying any flows with high velocity.
The direction of flow, the flow velocity and flow properties cannot be reflected in the PDI-Mode image.

Perform the following steps to acquire PDI-mode images:
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1. Optimize a B-mode image.

2. Press the CFM key on the control panel, and then tap PDI on the touch screen to enter the PDI mode.

o

=)

a

Illlllllllll*lllll

PRF 1.0
WF 86

;/
GN 255

PWR 70 Color Flow ROl 2D Imaging

Figure 6-7 PDI-Mode Imaging Screen

3. Adjust color flow ROI.
— Move the trackball to position color flow ROI.
— Press the confirm key on the control panel to adjust the size of color flow ROI.

— Press the confirm key again to reposition color flow ROI.

4. Optimize the PDI-mode image. For details, refer to Section 6.3.4 Optimizing CFM/PDI/TDI Mode Images.

5. Tap PDI again to exit the screen.

6.3.3 TDI Mode

NOTE:

TDI imaging is only applied to cardiac applications by using the phased array probes.

TDI (Tissue Doppler Imaging) is a color flow imaging technique which detects the low frequency signal reflected
from the cardiac muscle. TDI provides the flow information of velocity and direction for cardiac movement.

TDI uses the low velocity and the high amplitude adjusted from the wall filter to create a color-coded tissue

imaging.
Perform the following steps to acquire TDI-mode images.
1. Optimize a B-mode image.

2. Press the CFM key on the control panel, and then tap TDI on the touch screen to enter the TDI mode.

: ®
FPS 47

DIG 3/

GN 255

P 3/30

PWR 70

FRQ 3-4.8

D 16.5cm

PRF 1.0
WF 86
GN 255
CIP 1/50 [
PWR 70
FRQ 22

Illlllllllllllllll

Color Flow ROI 2D Imaging

Figure 6-8 TDI-Mode Imaging Screen
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3. Adjust color flow ROI.
— Move the trackball to position color flow ROL.
— Press the confirm key on the control panel to adjust the size of color flow ROI.

— Press the confirm key again to reposition color flow ROI.
4. Optimize the TDI-mode image. For details, refer to Section 6.3.4 Optimizing CFM/PDI/TDI Mode Images.

5. Tap TDI again to exit the screen.

6.3.4 Optimizing CFM/PDI/TDI Mode Images
The touch screen displays all controls related to the CFM/PDI/TDI-mode imaging (as shown in the figure), you can
use them to optimize CFM/PDI/TDI-mode images.
CFM
‘ PDI ’ ‘ TDI ’ ‘ Pannoramic
ﬂ [aYla)
ol
‘ Invert ’ ‘ Dual Live ’ ‘ B ’ D|D
Frequency Steer C Map WF PRF
4 51 P |4 <> p |4 1 > | 4 185 p»p |4 30 P>
Figure 6-9 Color Flow-Mode Imaging Parameters Menu
To optimize an image by using controls in the following instructions:
e Tap the left or right part of an item to adjust the parameter, the value displays at the bottom of the item. You can
tap @ on the touch screen to turn the current menu to the previous or the next page if it displays over one page.
e Or, rotate the knob on the control panel that is directly below the selected item to adjust the value.
NOTE:
You can adjust all parameters in a real time CFM/PDI/TDI mode, but can only adjust Baseline, Chroma and
B Reject in the frozen CFM/PDI/TDI mode.
| Gain
Color flow gain optimizes the color flow continuity with less noise interference.
To adjust the gain:
e Rotate the CFM knob on the control panel clockwise to increase the value.
e Rotate the CFM knob on the control panel anticlockwise to decrease the value.
| Frequency
Frequency optimizes the penetrability and the sensitivity of the color flow.
To adjust the frequency:
e Tap the left part of Frequency on the touch screen to decrease the value.
e Tap the right part of Frequency on the touch screen to increase the value.
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] Wall Filter
Wall filter is used to filter the low frequency noise from tissues, such as the vascular wall.
To adjust the wall filter:

e Tap the left part of WF on the touch screen to decrease the value.

e Tap the right part of WF on the touch screen to increase the value.

] Pulse Repetition Frequency
Pulse repetition frequency is used to adjust the velocity scale.
To adjust the pulse repetition frequency:

e Tap the left part of PRF on the touch screen to decrease the value.
e Tap the right part of PRF on the touch screen to increase the value.

] Line Density

Line density refers to the amount of ultrasound beam that makes up the image. Increasing the value of line density
improves the resolution and decreases frame rate. Therefore, you have to balance the frame rate and the image
quality when adjusting the line density.

A lower line density is useful in fetal heart beat, adult cardiac applications and in clinical radiology applications. A
higher line density is useful in obtaining a very high resolution, such as for the thyroid or testicles.

To adjust the line density:

e Tap the left part of Line Density on the touch screen to decrease the value.

e Tap the right part of Line Density on the touch screen to increase the value.

n Baseline

Baseline represents the position of zero velocity or frequency. The velocity range in one direction can be increased
or decreased by adjusting the baseline.

Baseline is used to eliminate the alias in the color flow imaging, and display higher velocities without reversal of

colors.

To adjust the baseline:

e Tap the left part of Baselines to move the baseline towards the positive direction.

e Tap the right part of Baseline to move the baseline towards the negative direction.

] Color Map
Color map is used to select the method for the color-coding of blood flows.
To adjust the color map:
Tap the left or right part of C Map on the touch screen to make the setting.

NOTE:
When C Map/DPDI is set to 4 or above in the PDI mode, the system automatically enters the DPDI mode

and DPDI appears. At this time, you can view the flow direction and velocity.
[ Persistence

Persistence is used to average consecutive frames to provide a smoother appearance with less noise. Use lower
persistence values for fast-moving organs or tissues and higher persistence values for a smoother appearance.

To adjust the persistence:

e Tap the left part of Persist on the touch screen to decrease the value.

e Tap the right part of Persist on the touch screen to increase the value.
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Sector Width/Angle

Sector width (for linear probes) or sector angle (for curved and phased array probes) is used to adjust the frame
rate. You can adjust the sector width or angle to get more information without moving the probe.

The region of interest of the object can be adjusted after you adjust the sector width or sector angle.
To adjust the sector width/angle:

Tap the left or right part of Sec. Width on the touch screen to change the sector width or angle.

Sector Position
Sector position is used to move or rotate the image.
To adjust the sector position:

Tap the left or right part of Sector Pos on the touch screen to move or rotate the image.

Power

Power is used to select the amount of ultrasound acoustic power produced by the probe. The adjustment range of
the power is 0-100%, and £10% can be adjusted each time. The real time value of the power is displayed in the

imaging information area of the basic screen.

To adjust the power:
e Tap the left part of Power% on the touch screen to decrease the value.

e Tap the right part of Power% on the touch screen to increase the value.

NOTE:
Expose the patient to the lowest practical transmit power level for the shortest possible time to achieve a

satisfactory diagnosis.
B Reject

B Reject is used to set the display priorities of the color and 2D grayscale pixels. A larger B Reject value suppresses
more grayscale pixels.

To adjust B Reject:
e Tap the left part of B Reject on the touch screen to decrease the value.
e Tap the right part of B Reject on the touch screen to increase the value.

Steer
Steer is used to adjust the angle of CF ROI when performing a real time scan by using the linear probes.

To adjust the steer:

e Tap the left part of Steer on the touch screen to rotate the angle clockwise.

e Tap the right part of Steer on the touch screen to rotate the angle anticlockwise.

NOTE:

Only the linear probes are available when adjusting steer.

Flow Invert

Flow invert is used to view blood flow from a different perspective.

When Invert is set to OFF, red pixels represent flow to the probe; blue pixels represent flow away from the
probe.

When Invert is set to ON, blue pixels represent flow to the probe; red pixels represent flow away from the probe.

To enable or disable the flow invert:
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e Tap Invert on the touch screen to enable the feature.

e Or, tap Invert again on the touch screen to disable the feature.

NOTE:
The color flow and the color map are also inverted when reversing the flow.

6.4 Acquiring M-Mode Images

M mode is generally used with 2D imaging, and is helpful for cardiac applications. In the M mode, you can
position the M-line in the 2D image on the anatomy of interest, and then learn about the tissue motion along that
line in M-mode trace. In M-mode, y-axis is used to display the position or depth of the tissue, and x-axis is the
time scale.

6.4.1 M Mode

The M-line can be only positioned 90° within the ultrasound beam. Therefore, the M mode is used to view motion

patterns for regular objects.
Perform the following steps to acquire M-mode images.
1. Optimize a B-mode image.

2. Press the M key on the control panel to enter the inactivated B+M mode.

o

®

M-line

|||||A|||||

o

Figure 6-10 Inactivated B+M-Mode Imaging Screen
3. Adjust the M line by using the trackball.

4. Press the Update key on the control panel to activate the M mode.

The B-mode image with a M line is displayed at the upper part of the screen and the M-mode image is
displayed at the lower part of the screen after being activated, as shown in Figure 6-11.
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Figure 6-11 M-Mode Imaging Screen
- X-axis is the time scale.

— Y-axis is the depth scale.

NOTE:
Once the M mode is activated, you can move the trackball to stop the M trace and adjust the M line. The
system continues tracing if the trackball is idle for more than 0.5s.

5. Optimize M-mode image. For details, refer to Section 6.4.3 Optimizing M-Mode Images.

6. Press the M key again to exit the screen.

6.4.2 Anatomical M-Mode

Anatomical M-mode is used for fetal cardiac applications. Anatomical M-mode can be used with phased array
probes when performing cardiac exams or convex probes when performing abdominal exams. In the anatomical
M-mode, the M-mode cursor can be positioned perpendicular to the anatomical structure and be adjusted 360° even

when viewing motion patterns for irregular objects. It is used to study the ventricular function of the heart.
Perform the following steps to acquire anatomical M-mode images.

1. Enter the inactivated B+M mode, tap Steer M on the touch screen to set the number of M lines.

Multiple M-lines display after selecting the desired number as the following figure shows.

o

M-line

|||||l|||||
| .

2D Imaging

o

Figure 6-12 Inactivated Anatomical M-Mode Imaging Screen
2. Adjust the position and the angle of M line.

— Press the confirm key on the control panel to select the desired M line.
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— Position the desired M-line by using the trackball.
- Rotate the Angle knob on the control panel to adjust the angle of M line.

3. Press the Update key on the control panel to activate the anatomical M-mode.

NOTE:

Once the anatomical M-mode is activated, you can move the trackball to stop the M trace and adjust the M
line. The system continues tracing if the trackball is idle for more than 0.5s.

4. Optimize anatomical M-mode images. For details, refer to Section 6.4.3 Optimizing M-Mode Images.

5. Press the M key again to exit the screen.

6.4.3 Optimizing M-Mode Images

The touch screen displays all controls related to the M-mode imaging (as shown in the figure), you can use them to

m

optimize M-mode images.

ECG

Video Invert

Power% M Process Chroma Display Speed
4 100 P |4 Peak P | 4 1 > | 4 VI2 »| 4 4 >

Figure 6-13 M-Mode Imaging Parameters Menu

To optimize an image by using controls in the following instructions:
e Tap the left or right part of an item to adjust the parameter, the value displays at the bottom of the item. You can
tap @ on the touch screen to turn the current menu to the previous or the next page if it displays over one page.

e Or, rotate the knob on the control panel that is directly below the selected item to adjust the value.

NOTE:

All parameters can be adjusted in a real time B mode, Chroma and Display Format can also be adjusted
in the frozen mode.

[ ] Gain
M gain controls the overall brightness of the M trace.
To adjust the gain:

e Rotate the M knob on the control panel clockwise to increase the value.

e Rotate the M knob on the control panel anticlockwise to decrease the value.

] M Process
M process is used to set the processing method for the M trace display.

To set M process:
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6.5

6.5.1

Tap the left or right part of M Process to adjust the setting.

Sweep Speed
Sweep speed is used to set the sweep speed of the M trace. A faster speed is more suitable to view the motion.
To adjust the sweep speed:

e Tap the left part of Speed to decrease the value.
e Tap the right part of Speed to increase the value.

Chroma
Chroma is used to colorize the gray scale image to enhance the discrimination capability.
To adjust the chroma:

Tap the left or right part of Chroma on the touch screen to adjust the setting.

Display Format
Display format is used to view the image better.
To set the display format:

Tap the left or right part of Display on the touch screen to adjust the setting.

Power

Power is used to select the amount of ultrasound acoustic power produced by the probe. The adjustment range of
the power is 30%-100%, and +10% can be adjusted each time. The real time value of the power is displayed in the

imaging information area on the basic screen.

To adjust the power:
e Tap the left part of Power%o on the touch screen to decrease the value.

e Tap the right part of Power% on the touch screen to increase the value.

NOTE:
Expose the patient to the lowest practical transmit power level for the shortest possible time to achieve a

satisfactory diagnosis.

Video Invert

Video invert is used to invert the M trace display related to brightness.
To enable or disable the video invert:

e Tap Video Invert on the touch screen to enable the feature.

e Or, tap Video Invert again on the touch screen to disable the feature.

Acquiring Spectral Doppler Images

Spectral Doppler imaging is intended to provide measurement data concerning the velocity, the direction, and the
category of the arterial or vein flow. It contributes a more accurate qualitative analysis than the color flow imaging.

Spectral Doppler includes Pulsed Wave Doppler (PW) mode and Continuous Wave Doppler (CW) mode.

PW Mode

Pulsed Wave Doppler (PW) is a Doppler mode that measures velocity in a PW sample volume and displays
that information in a spectral trace with audio output. PW includes conventional PW and High Pulse Repetition
Frequency (HPRF). PW Doppler can be combined with the B mode for rapidly selecting the anatomical site for PW
Doppler examination. The site where PW Doppler data is derived appears graphically on the B-Mode image.
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Perform the following steps to acquire PW-mode images
1. Optimize a B-mode image.

2. Press the PW key on the control panel to enter the inactivated B+PW mode 1.

o

®

Spectral Doppler Line

Flow Cursor

IIII¢IIII

Sample Volum Gate

2D Imaging

Figure 6-14 Inactivated B+PW Mode 1 Imaging Screen
— The spectral Doppler line and the sample volume gate are used to locate the qualitative analysis on the
image.
- The flow cursor needs to be adjusted parallel to the flow when measuring the velocity.
3. Adjust the position and angle of the spectral Doppler line.

— Position the sample volume gate on the spectral Doppler line by moving the trackball upwards or

downwards.
- Adjust the angle of the spectral Doppler line by moving the trackball to the left or the right.
4. Adjust the sample volume gate.
— Adjust the size of the sample volume gate by using the trackball.
— Rotate the Angle knob on the control panel to adjust the angle of the flow cursor.
5. Press the Update key on the control panel to activate the PW mode.

The PW spectrum is displayed at the lower part of the screen after being activated, as shown in Figure 6-15.

o

®

Flow Cursor /

Sample Volume Gate //

2D Imaging

Spectral Doppler Line

A

3

— 50
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Y-axis:
Frequency

X-axis: Time

Figure 6-15 PW-Mode Imaging Screen
— X-axis is the time scale.
— Y-axis is Doppler frequency scale, including positive and negative indicators.
Rotate the Audio knob on the control panel to adjust the audio volume.

NOTE:

Once the PW-mode is activated, you can move the trackball to stop the Doppler trace and adjust the
sample volume gate. The system continues tracing if the trackball is idle for more than 0.5s.
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6. Optimize the PW-mode image. For details, refer to Section 6.5.3 Optimizing Spectral Doppler Images.

If needed, press the Update key on the control panel to enter the inactivated B+PW mode 2, the following

screen appears.

o

®

IIII*IIIIl

Y-axis: _

Frequency

X-axis: Time

Figure 6-16 Inactivated B+PW Mode 2 Imaging Screen

You can also adjust the position and angle of spectral Doppler line, the size of sample volume gate, and the

direction of the flow cursor.

7. Press the PW key again to exit the screen.

6.5.2 CW Mode

Continuous Wave Doppler (CW) uses continuously transmitted and received ultrasound energy to generate a
spectral display. CW Doppler is used to measure a high velocity, the highest velocity at a specific site, but no

aliasing is created.

Perform the following steps to acquire CW-mode images.

1. Optimize a B-mode image.

2. Press the CW key on the control panel to enter the inactivated B+CW mode 1.

o

Spectral Doppler Line
Flow Cursor

Sample Volume Gate

Illlgllll

2D Imaging

Figure 6-17 Inactivated B+CW-Mode 1 Imaging Screen

— The spectral Doppler line and the sample volume gate are used to locate the qualitative analysis on the

image.

— The flow cursor needs to be adjusted parallel to the flow when measuring the velocity.

3. Adjust the position and angle of the spectral Doppler line.

- Position the sample volume gate on the spectral Doppler line by moving the trackball upwards or

downwards.
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— Adjust the angle of the spectral Doppler line by moving the trackball to the left or the right.
4. Rotate the Angle knob on the control panel to adjust the angle of the flow cursor.

5. Press the Update key on the control panel to activate the CW mode.

The CW spectrum is displayed at the lower part of the screen after being activated, as shown in Figure 6-18.

o

®
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Y-axis: __ _
Frequency -

- — -50
|_IIIIIIII|IIII|IIII|IIII

X-axis: Time

Figure 6-18 CW-Mode Imaging Screen
— X-axis is the time scale.
- Y-axis is Doppler frequency scale, including positive and negative indicators.
Rotate the Audio knob on the control panel to adjust the audio volume.
NOTE:

Once the CW-mode is activated, you can move the trackball to stop the Doppler trace and adjust the
sample volume gate. The system continues tracing if the trackball is idle for more than 0.5s.

6. Optimize the CW-mode image. For details, refer to Section 6.5.3 Optimizing Spectral Doppler Images.

If needed, press the Update key on the control panel to enter the inactivated B+CW mode 2, the following
screen appears.

o
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Figure 6-19 Inactivated B+CW Mode 2 Imaging Screen

You can also adjust the position and angle of spectral Doppler line, and the direction of the flow cursor.
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6.5.3

7. Press the CW key again to exit the screen.

Optimizing Spectral Doppler Images

The touch screen displays all controls related to the PW/CW-mode imaging (as shown in the figure), you can use

m

them to optimize PW/CW-mode images.

ECG
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Invert Angle Correct
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Figure 6-20 Spectral Doppler Mode Imaging Parameters Menu

To optimize an image by using controls in the following instructions:

e Tap the left or right part of an item to adjust the parameter, the value displays at the bottom of the item. You
can tap @ on the touch screen to turn the current menu to the previous or the next page if it displays over one
page.

e Or, rotate the knob on the control panel that is directly below the selected item to adjust the value.

NOTE:

You can adjust all parameters in the real time PW/CW mode, but can only adjust Baseline, Chroma and

Display Format in the frozen PW/CW mode.

Gain

PW/CW gain is used to adjust the gain of the spectrum map. Increasing the gain will brighten the image, allowing

you to see more received signals with less noise.

To adjust the gain:
e Rotate the PW or CW knob on the control panel clockwise to increase the value.

e Rotate the PW or CW knob on the control panel anticlockwise to decrease the value.

Pulse Repetition Frequency

Pulse repetition frequency is used to adjust the velocity scale, filter the unnecessary low frequency signal or the
disturbance made by non-flow movements, such as breath, heart beat or sweeps of the probe.

The range of PRF value varies with the probe model and the exam type.

To adjust the pulse repetition frequency:
e Tap the left part of PRF on the touch screen to decrease the value.

e Tap the right part of PRF on the touch screen to increase the value.
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NOTE:

The value of wall filter is also changed when adjusting PRF.

] High Pulse Repetition Frequency

Once HPRF is enabled, besides the original sample volume gate, one or more sample volume gates appear at
shallower positions on the 2D image. The unnecessary low frequency signal or the disturbances made by non-flow
movements, such as breath, heart beat or sweeps of the probe will be filtered.

To enable the High Pulse Repetition Frequency:
Tap the right part of PRF to increase the value continuously, HPRF is automatically enabled when a certain value

is reached.

NOTE:
The linear probes are not available for HPRF.

] Baseline

Baseline represents the position of zero velocity or frequency. The velocity range in one direction can be increased
or decreased by adjusting the baseline.

Baseline is used to unwraps the alias during color flow imaging, and display higher velocities without reversal of

colors.

To adjust the baseline:

e Tap the left part of Baseline to move the baseline towards the positive direction, and the velocity range in the
color map varies with the adjustment.

e Tap the right part of Baseline to move the baseline towards the negative direction, and the velocity range in
the color map varies with the adjustment.

[ ] Wall Filter
Wall filter is used to filter the low frequency noise from tissues, such as the vascular wall.
To adjust the wall filter:

e Tap the left part of WF on the touch screen to decrease the value.

e Tap the right part of WF on the touch screen to increase the value.

] Frequency
The probe is capable of generating a broadband signal with a certain frequency and bandwidth. The frequency
optimizes the edges when scanning deeper locations with Doppler imaging.
To adjust the frequency:

e Tap the left part of Frequency on the touch screen to decrease the value.

e Tap the right part of Frequency on the touch screen to increase the value.

] Sweep Speed
Sweep speed is used to set the sweep speed of the Doppler trace. The refresh speeds of the time scale and the
frequency scale vary with the sweep speed.
To adjust the sweep speed:

e Tap the left part of Speed to decrease the value.
e Tap the right part of Speed to increase the value.
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Power

Power is used to select the amount of ultrasound acoustic power produced by the probe. The adjustment range of
the power is 30%-100%, and +10% can be adjusted each time. The real time value of the power is displayed in the

image parameter area on the basic screen.

To adjust the power:

e Tap the left part of Power%o on the touch screen to decrease the value.

e Tap the right part of Power% on the touch screen to increase the value.

NOTE:

Expose the patient to the lowest practical transmit power level for the shortest possible time to achieve a
satisfactory diagnosis.

Chroma

Chroma is used to colorize the gray scale image to enhance the discrimination capability.

To adjust the chroma:

Tap the left or right part of Chroma on the touch screen to choose a color scheme.

Dynamic Range

Dynamic range increases the adjustable range of contrast by enhancing the intensities of parts in the grayscale. It is

useful for optimizing the ultrasound image texture.

To adjust the dynamic range:
e Tap the left part of DYN on the touch screen to decrease the value.
e Tap the right part of DYN on the touch screen to increase the value.

Display Format
Display format is used to view the image better.
To set the display format:

Tap the left or right part of Display on the touch screen to adjust the setting.

Flow Invert
Flow invert is used to view the flow velocity from a different perspective.
To enable or disable the flow invert:

e Tap Invert on the touch screen to enable the feature, and INVERT appears on the top right corner of the
image.

e Or, tap Invert again on the touch screen to disable the feature, and INVERT disappears from the display.

Video Invert
Video invert is used to view the background of the spectral display from a different perspective.
To enable or disable the flow invert:

e Tap Video Invert on the touch screen to enable the feature, and a brighter background appears.

e Or, tap Video Invert again on the touch screen to disable the feature, and a darker background appears.

Angle Correction
Angle correction is used to adjust the angle of the flow cursor in the PW mode.
To adjust the angle:

e Rotate the Angle knob on the control panel to adjust the angle.

84

Basic User Manual



6 Acquiring Images

6.6

6.6.1

e Or, tap the left or right part of AngleCorrect on the touch screen to adjust the angle.

NOTE:
You only need to set it when performing measurements related to velocity.

Simult

Simult is used to synchronously display two real time scans in the 2D and the PW modes.

To enable or disable the feature:

Tap Simult in the activated PW mode or in the inactivated B+PW mode 2, the two real time scans in the 2D and

the PW modes are displayed.

NOTE:
Simult is only available in the PW mode.

Acquiring Triplex-Mode Images
The triplex mode is overlapped by three different imaging modes, and can be applied to view the image. The triplex

mode includes B+CFM/TDI+M, B+CFM/PDI/TDI+PW and B+CFM/PDI+CW.

B+CFM/TDI +M

NOTE:

Only the phased array probes are available for B+CFM/TDI+M.
Perform the following steps to acquire the image.

1. Optimize a CFM/TDI mode image.

2. Press the M key on the control panel to enter the inactivated B+CFM/TDI+M mode.

=]
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/

Color Flow ROI/—

M-line

|IIII*IIII|

2D Imaging

o

Figure 6-21 Inactivated B+CFM/TDI +M-Mode Imaging Screen

3. Adjust the M line by using the trackball.

4. Press the Update key on the control panel to activate the M mode.

The basic screen displays the following after being activated.
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Figure 6-22 B+CFM/TDI +M-Mode Imaging Screen
5. Optimize the M-mode image. For details, refer to Section 6.4.3 Optimizing M-Mode Images.

6. Press the M key again to exit the screen.

6.6.2 B+CFM/PDI/TDI +PW
Perform the following steps to acquire the image.
1. Optimize a CFM/PDI/TDI-mode image.

2. Press the PW key on the control panel to enter the inactivated B+CFM/PDI/TDI+PW mode 1.

o

Spectral Doppler Line

Flow Cursor
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Figure 6-23 Inactivated B+CFM/PDI/TDI+PW-Mode 1 Imaging Screen

3. Adjust the position and angle of the spectral Doppler line.
- Position the sample volume gate on the spectral Doppler line by moving the trackball upwards or
downwards.
- Adjust the angle of the spectral Doppler line by moving the trackball to the left or the right.
4. Adjust the sample volume gate.
- Press the confirm key on the control panel to adjust the size of the sample volume gate.

- Rotate the Angle knob on the control panel to adjust the angle of the flow cursor.

5. Press the Update key on the control panel to activate the PW mode.

The PW spectrum is displayed at the lower part of the screen after being activated, as shown Figure 6-24.
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Figure 6-24 B+CFM/PDI/TDI+PW-Mode Imaging Screen

Rotate the Audio knob on the control panel to adjust the audio volume.

NOTE:

Once the PW-mode is activated, you can move the trackball to stop the Doppler trace and adjust the
sample volume gate. The system continues tracing if the trackball is idle for more than 0.5s.

6. Optimize the PW-mode image. For details, refer to Section 6.5.3 Optimizing Spectral Doppler Images.

If needed, press the Update key on the control panel to enter the inactivated CFM/PDI/TDI+PW mode 2, the

following screen appears.
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Figure 6-25 Inactivated CFM/PDI/TDI+PW Mode 2 Imaging Screen

You can also adjust the position and angle of spectral Doppler line, the size of the sample volume gate, and the

direction of the flow cursor.

7. Press the PW key again to exit the screen.

6.6.3 B+CFM/PDI+CW

For details, refer to Section 6.6.2 B+CFM/PDI/TDI +PW.
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"7 Elastography Imaging

As an adjunct technique for clinical practice, the elastography determines if an area of tissue is hard or soft when
compared with its surroundings. Furthermore, it provides an elastography image to discover tumors (stiffer than
the surrounding tissue). The elastography image displays a range of map shades from the softest tissue in the

image to the stiffest in a given field of view.

Elastography is used in ultrasound diagnosis for small parts applications, such as breast and thyroid examinations.

NOTE:
The following description uses small parts examination performed with the L741 probe as an example.

7.1 Acquiring Elastography Images
Perform the following steps to acquire the elastography image.

1. Select L741 and Small Parts as the desired probe and exam type, the system automatically enters the real-time

B mode.
2. Acquire a high quality B-mode image.

3. Tap Elasto on the touch screen to enter the elastography imaging.
As Figure 7-1 shows, the elastography image is displayed on the left and a real-time B-mode image is displayed
on the right.
Tap {3 on the touch screen to enter the single or dual split screen display.

FPS 47 HO) S soft
D/IG 31
GN 255 .
WP 330 - Strain Map
PWR 70
FRQ 3-4.8
Elastography D 165cm hard
image in ROI
B-Mode Image
-
s
+or—— - - - - — - — — — — -
+o.5:- _____________
0.0 FW _ ———— 1 Strain Curve
05p—————— — — — — — — -
oL — — — — — — — — — — — — -

Figure 7-1 Elastography Imaging Screen

Elastography map provides color information for tissue stiffness.

- B-mode image is compared with the elastography image for a real-time assessment.

Strain curve displays the compressing frequency and its corresponding displacement. X axis is the frame
number, Y axis is the displacement of the corresponding frame.

The Elastography image in the ROI is translucent and overlapped on the B-mode image.
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7.2

4. Hold the probe perpendicular to the target lesion, and compress it regularly.

Operation Concerns:
- Ensure the compression is applied perpendicularly, and all parts of the target lesion are compressed

uniformly.

— Ensure the compression is a dynamic intermittent force, i.e. alternate tension with relaxation, which could
keep the distorted tissue back to normal status. If the distorted tissue is not relaxed, the tissue cannot be
distorted and the elastography imaging cannot be performed.

— The compressing frequency is recommended to be 1.5-3 times per second. Lift the probe up after each
pressure, and ensure the probe is not away from the target lesion.

— The absolute value of positive and negative maximums on strain curves should be 0.5-1. If the absolute

value is below 0.5 or over 1, the compression is too hard or too low for correct elastography results.
5. Adjust the elastography ROI.

To acquire accurate tissue stiffness information, you are recommended to adjust the elastography ROI to two
times of the target lesion

— Move the trackball to position elastography ROL
— Press the confirm key on the control panel to adjust the size of elastography ROI.
— Press the confirm key to reposition elastography ROI.

6. Optimize the elastography image. For details, refer to Section 7.2 Optimizing Elastography Images.

7. Tap Elasto again to exit the screen.

Optimizing Elastography Images

The touch screen displays all controls related to the elastography imaging (as shown in the figure), you can use
them to optimize elastography images.

A

L8 ok ]

Frequency Strain Proce. Strain Map L Contrast Transparency
480114 » | 4 4 > | 4 5 > | 4 062 p |4 034 »

Figure 7-2 Elastography Imaging Parameters Menu

You can tap @ on the touch screen to turn the current menu to the previous or the next page if it displays over one
page.

To optimize the image by using controls in the following instructions:

e Tap the left or right part of an item to adjust the parameter, the value displays at the bottom of the item.

e Or, rotate the knob on the control panel that is directly below the selected item to adjust the value.
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7.2.1

7.2.2

7.2.3

7.2.4

7.2.5

7.2.6

NOTE:
All parameters can only be adjusted in real-time elastography imaging.

Strain Map

Strains map allows you to select and apply a color map to the elastography or B-mode image on the left or right
during the elastography imaging. The image will be displayed with the use of 256-color mapping for each pixel
according to the degree of strain using a scale from red (highest strain, softest), green (average strain, intermediate),
to blue (no strain, hardest).

To adjust the strain map:
e Tap the left or right part of Strain Map L to choose the color scheme for the elastography image.
e Tap the left part of Strain Map R to remove from or choose the color scheme for the B-mode image.

e Tap the right part of Strain Map R to apply or choose the color scheme for the B-mode image.

Strain Process

Strain process is used to set relative parameters of the elastography algorithm, the elastography image varies with
this setting.

To adjust the strain process:

e Tap the left part of Strain Proce. on the touch screen to decrease the value.
e Tap the right part of Strain Proce. on the touch screen to increase the value.

Transparency
Transparency allows you to bring out the tissue behind the color data.

To adjust the transparency:

e Tap the left part of Transparency on the touch screen to decrease the value.

e Tap the right part of Transparency on the touch screen to increase the value.

Contrast
Contrast enhances the color contrast for more accurate tissue stiffness information.

To adjust the contrast:

e Tap the left part of Contrast on the touch screen to decrease the value.

e Tap the right part of Contrast on the touch screen to increase the value.

Persistence

Persistence is used to average consecutive frames to provide a smoother appearance with less noise. Use lower

persistence values for fast-moving organs or tissues and higher persistence values for a smoother appearance.

To adjust the persistence:
e Tap the left part of Persist on the touch screen to decrease the value.

e Tap the right part of Persist on the touch screen to increase the value.

Frequency

The transducer is capable of generating a broadband signal with a certain start frequency and a certain bandwidth.
A higher frequency brings about higher resolution and lower penetration.
To adjust the frequency:

e Tap the left part of Frequency on the touch screen to decrease the value.

e Tap the right part of Frequency on the touch screen to increase the value.
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7.3 Working with Elastography Images

You can work with the elastography images by using the features in the frozen mode, such as cine review,
annotations, data storage or measurement. For details, refer to Section 11.4 Using Cine, Section 11.5 Annotations
and Body Marks, 12 Managing Images/Data and the relevant sections in the advanced user manual.
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8 Contrast Imaging

Contrast imaging is used in conjunction with ultrasound contrast agents to increase the acoustic impedance
difference between blood flow and tissue, improve 2D imaging resolution for myocardial, liver, kidney and
cephalic applications and enhance Doppler signals for blood flow. Contrast imaging helps in observing normal and

abnormal tissue and blood flow.

NOTE:
Contrast imaging is only available performed with linear or curved probes.

warninG Contrast imaging is only used in conjunction with commercial contrast agents legally approved by laws and local
regulations. Do not use the contrast agent not got any legal permits or official registrations. The manufacturer

would not guarantee the safety and reliability for any contrast agents.

The following description uses a liver examination performed with the C353 probe as an example.

8.1 Entering Contrast Imaging

Perform the following steps to enter the contrast imaging.

1. Select C353 and Abdomen as the desired probe and exam type, the system automatically enters the real-time B

mode.
2. Position the target tissue in the B+Color mode, and observe the blood flow.

3. Return to the B mode, tap Contrast on the touch screen to enter the contrast imaging.

As Figure 8-1 shows, a real-time contrast image is displayed on the left and a B-mode in real-time mode is
displayed on the right.
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Figure 8-1 Contrast Imaging Screen
- Tap Single View to enter the single display.
— Tap Dual View to enter the dual split display.

- Tap Exit to exit the imaging screen.
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8.2

8.2.1

8.2.2

8.2.3

Optimizing Contrast Images

The touch screen displays all controls related to the contrast imaging (as shown in the figure), you can use them to

optimize contrast images.

|Contrast | |Tissue |

9

Timer2 Single View

Ti 1
‘ o ’ ‘ Flash ’ ‘ K ’ Dual View
Frequency Flash Power Flash Time DYN Focus
3.4-5.0 50 1.0s 220

Figure 8-2 Contrast Imaging Parameters Menu

You can tap @ on the touch screen to turn the current menu to the previous or the next page if it displays over one
page.
You can also tap Contrast or Tissue to make settings of the relevant tab.

To optimize the image by using controls in the following instructions:
e Tap the left or right part of an item to adjust the parameter, the value displays at the bottom of the item.

e Or, rotate the knob on the control panel that is directly below the selected item to adjust the value.

NOTE:

All parameters can only be adjusted in a real-time contrast imaging, but F By F, Cine Speed, Chroma and
Gray Map can also be adjusted in the frozen mode. Only settings of Gain, Flash Power and Flash Time
are detailed in this section, for settings of other parameters, refer to 6.2.2 Optimizing B-Mode Images.

Gain

Contrast imaging gain determines the amplifying factors for the received echoes and the brightness of the
ultrasound image. The echoes are amplified with the same gain value regardless of depth.

To adjust the gain:

e Rotate the CFM knob to adjust the gain of contrast image.
e Rotate the B knob to adjust the gain of THI image.

Flash Power

Flash power allows you to select the maximum transmit power level produced by the transducer in the contrast
imaging.

To adjust the flash power:

Tap the left or right part of Flash Power to make the setting.

Flash Time

Flash time allows you to set the transmit duration of high-voltage pulse.
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8.3

8.4

To adjust the time:

Tap the left or right part of Flash Time to make the setting.

Acquiring Contrast Images
Perform the following steps to acquire contrast images.

1. Inject contrast agents, and tap Timer1 or Timer2 on the touch screen to start timing.
Once the timer is started, Timer displays on the screen and the system starts timing for contrast agent duration.

— Press the Save key on the control panel to set the start frame for cine review. Press the Save

(18)) key again to set the end frame of cine. The corresponding thumbnails for the stored cine appears in the
clipboard.

— Press the Freeze key on the control panel to freeze the image. Freezing time is displayed on the screen, and
the timer continues timing. Press the Freeze key again to return to the real-time mode.

— Tap Timer1 or Timer2 again to exit.
2. Observe and record circulation and perfusion of the target tissue.

If the second perfusion is needed, tap Flash on the touch screen to enter the flash contrast imaging and destruct
microbubbles. Tap Flash repeatedly to destruct the residual microbubbles. After the destruction, inject contrast
agents and observe the perfusion of the target tissue.

3. Press the Freeze key to freeze the image.

Working with Contrast Images

You can work with the contrast images by using the features in the frozen mode, such as cine review, annotations,
data storage or measurement. For details, refer to Section 11.4 Using Cine, Section 11.5 Annotations and Body
Marks, 12 Managing Images/Data and the relevant sections in the advanced user manual.

You can also get more information about blood flow characteristics through observing TIC curves. TIC curve
indicates the contrast agent intensity variation with duration. To make a TIC analysis, you should position ROI (8
at most), and then make a detailed analysis of the contrast agent intensity variation with duration.

Perform the following steps to make a TIC analysis.
1. Tap TIC in the frozen mode to enter the TIC analysis screen.
2. Position one or more ROI on the contrast image.
- Tap Ellipse on the touch screen, position a ROI by performing an ellipse measurement.

— Tap Trace on the touch screen, position a ROI by performing an auto-trace measurement.

Once you position a ROI, the corresponding TIC curve is displayed on the bottom, colors of TIC curve and ROI
are consistent.

As Figure 8-3 shows, all relevant parameters are displayed on the top right part of the screen.
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— X axis is the contrast agent duration, represents in s.
— Y axis represents the contrast agent intensity, represents in dB.

You can press the Clear key on the control panel to delete all ROIs and TIC curves.

Figure 8-3 TIC Analysis Screen

3. Analyze TIC curves for more information about circulation and perfusion.

Use the trackball to observe contrast images frame by frame, the indication line on the corresponding TIC

varies with the frame.

4. Tap EXit on the touch screen to return to the contrast imaging screen.
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3D imaging allows you to see width, height and depth of the anatomical structure. 3D imaging can be performed

by all probes, but the quality of the images is closely related to 2D imaging.

3D imaging mainly applies to obstetric exams, and can be used to see the three dimensional volume image of the

internal organs or a fetus.

9.1 Acquiring 3D Images
The following description uses 3D imaging performed with the VC6-2 probe as an example.
Perform the following steps to acquire 3D images.

1. Enter the patient information, select the VC6-2 probe and an exam type (such as the obstetric exam used
throughout this chapter) to enter the B mode.

Optimize imaging parameters in the B mode.

Apply adequate gel on the patient.

Bl e

Acquire a B-mode image of high quality.
5. Tap 3D/4D on the touch screen to enter the inactivated 4D mode.

NOTE:

= When using a volume probe, you can set the default inactivated 3D or 4D mode. For details, refer to
Section 4.1.4 Defined-Key Settings.

* When using a non-volume probe, you should press the Freeze key and tap FreeHand 3D to enter the
inactivated 3D mode.

6. Tap the 3D tab to enter the inactivated 3D mode.

The 2D imaging with ROI and sample line is displayed in the inactivated 3D mode, only the data in ROI is
acquired for 3D imaging.

FPS 47

D/G 31 )

GN 255 /2D Imaging
/P 3/30

PWR 70 ROI

FRQ 3-4.8

D  16.5cm Anchor
Angle 4

Status Icon

e
Y] &

Figure 9-1 Inactivated 3D Imaging Screen
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Adjust ROI and sample line.

You can press the confirm key to select the desired status icon.
- If B is highlighted, use the trackball to position the ROI.

- If || is highlighted, use the trackball to resize the ROI.

- If E is highlighted, adjust the sample line by positioning the anchor with the trackball.
Set the user mode, focus position, image quality and sweep angle.

- Tap an item under User Mode to select a user mode.

— Tap the Left/Right part of Sweep Angle to adjust the sweep angle of probe.

— Tap the left or right part of Focus to decrease or increase the depth of focal zone.

— Tap the left or right part of Image Quality to adjust quality of images.

Display the 3D imaging in the following instructions.

- Tap (3, (D or BB, tap Start or press the Freeze key to display the 3D imaging in a full, dual or quad
display. The system automatically enters the 3D imaging in a quad display by default.

— Tap 1, 2 or 4 on the key panel of the touch screen to display the 3D imaging in a full, dual or quad display.

The imaging area of the screen is divided into 3 reference images and a 3D image by default.

1 1

View A

FPS 47
D/IG 31
GN 255
1P 3/30
PWR 70
FRQ 3-4.8 |
D 16.5cm

View B

Angle 55 T
Map 4
Quality H
Surface

View C 3D Image

fa[=]&

Figure 9-2 3D Imaging Screen

As the above figure shows,

View A on the top left shows the image on the X-axis.
View B on the top right shows the image on the Y-axis.
View C on the bottom left shows the image on the Z-axis.

The image on the bottom right shows the 3D image.

As Figure 9-3 shows, the touch screen displays all controls related to the 3D imaging.
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9.2

9.2.1
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Figure 9-3 3D Imaging Parameters Menu

e Tap PP or €« to turn the current menu to the previous or the next page.

e Tap VolPre or press the Freeze key to return to the inactivated 3D mode.

e Tap Exit on the 3D/4D tab to return to the real-time B mode. Tap Exit on other tabs to switch to the 3D/4D tab.

Working with 3D Images

You can review, optimize or save 3D images.

You can also tap Edit ROI on the touch screen to freeze three reference images, and then use the trackball to view

the 3D image for better observation; tap Edit ROI again to unfreeze three reference images.

Adjusting ROI

You can crop the 3D image by adjusting the ROI on the reference images.
Perform the following steps to adjust ROI.

1. Tap 3D/4D > A, B or C to select the desired reference image.

2. Adjust images inside the ROI on the reference image.
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9.2.2

9.2.3

9.2.4

Anchor

ROI —
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View C 3D Image
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Figure 9-4 Cropping Review Screen

You can press the confirm key to select the desired status icon.

o If B is highlighted, use the trackball to position the ROI.

o If | is highlighted, use the trackball to resize the ROL

o If E is highlighted, adjust the sample line by positioning the anchor with the trackball.

Only images inside the ROI are generated to a 3D image, and the real-time 3D image is also displayed when
cropping reviews.

Setting Display Format

To setting the display format in the following instructions.

e Tap 3D/4D, tap (J, (IJ or E3 to enter the full, dual or quad split screen display mode.

e Tap 1, 2 or 4 on the key panel of the touch screen to enter the full, dual or quad split screen display mode.

Using Auto Face

Fetal face can be automatically recognized by using the auto face feature even if fetal hands, placenta, umbilical
cord or other uterus adnexa block your view.

In the frozen mode, tap Auto Face to clear obstacles. Tap Auto Face again to restore the original image.

Setting Render Mode

Tap 3D/4D > an item under Render Mode to select a render mode.

e Surface displays gray values of the surface structures. It is suitable for observing the contour (eyes, ears, nose,
lip) of fetus.

e Grad. Light displays the surface structures in a strengthen light intensity. It is suitable for observing the
contour (eyes, ears, nose, lip) of fetus.

o Skeleton displays the highest intensity of echo along the ultrasound beam. It is suitable for observing the
spinal column and skeleton of the fetus.
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e Transp. Min displays the minimum gray value within ROL It is suitable for observing dark areas (vessels,
cysts).
e X-Ray displays all gray values within ROL. It is suitable for observing tissue or tissue mass.

e S-Depth displays color signals of the echoes along the ultrasound beam. It is suitable for observing the contour
(eyes, ears, nose, lip) of fetus.

e S-Live displays sides of the surface structures in a strengthen light intensity. The icon appears at the lower-
right corner of the screen when S-Live mode is selected. It is suitable for observing 3D surface.
9.2.5 Cropping Reviews

You can crop 3D image by tracing its border, adjusting a box or using the eraser.

] Cropping Reviews with Trace
You can crop 3D image by tracing its border to remove areas outside the area of interest. This feature is suitable for
cropping irregular reviews.

Perform the following steps to crop a review.

1. Tap Edit > @ or £5 to enable the feature.
- Tap @g to remove all data inside the traced area from the image.
- Tap %% to remove all data outside the traced area from the image.

2. Move the cursor on the image by using the trackball, press the confirm key on the control panel, and then trace
the border of the object.

3. Press the confirm key to acquire the desired image.

In the following figure, @g is enabled.

NOTE:

«  Tapping can restore the review.
+  Taping can undo the last cut.
«  Taping [ @] can redo the last cut.

] Cropping Reviews by the Box

You can crop 3D image by adjusting a box on the 3D image to remove irrelevant areas from interest area. This

feature is suitable for cropping regular reviews.
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Perform the following steps to crop a review.

1. Tap Edit> Z, or % to enable the feature.
— Tap | Z. to remove all data outside from the image.
— Tap [ to remove all data inside from the image.
2. Move the cursor to the image by using the trackball, press the confirm key on the control panel, and then trace

the border of the object.

3. Press the confirm key to acquire the desired image.

NOTE:

+  Tapping can restore the review.
+  Taping can undo the last cut.
+  Taping [ @] can redo the last cut.

| Cropping Reviews by the Eraser
You can crop 3D image by using the eraser to remove irrelevant areas from interest area. This feature is suitable for
cropping irregular reviews.
Perform the following steps to crop a review.
1. Tap Edit > & (big eraser) or £ (small eraser) to enable the feature.
2. Move the cursor on the image by using the trackball, press the confirm key on the control panel, and then use
the eraser to remove irrelevant areas.
3. Press the confirm key to acquire the desired image.
NOTE:
» Tapping can restore the review.
* Taping can undo the last cut.
«  Taping [ @] can redo the last cut.
9.2.6 Moving/Rotating/Magnifying Images
[ To Select an Image
Tap 3D/4D > A, B, C or 3D to select the desired image.
] To Move Images
Tap View, tap the left/right part of Move L/R to move images left/right.
Tap View, tap the left/right part of Move U/D to move images up/down.
Rotate the CFM knob on the control panel to move images Left/Right.
] To Rotate Images
e Tap 3D/4D or Edit and then tap Rotate to rotate images by using the trackball.
e Tap 3D/4D > 0°/45°/90°/180°/270°/360° to set the rotation angle, all images are automatically rotated from
the original position to the position of 1/2 preset angle, and then rotated in a reversed way in turns.
e Tap View > Top, Bottom, Left, Right, Front or Back to rotate all images.
e Tap View, tap the left/right part of Rotate X, Rotate Y or Rotate Z to manually rotate all images along x, y
or Z axis.
e Rotate the M/CW/PW knob to manually rotate all images along x, y or z axis.
e Tap View > 0°/90°/180°/270° to rotate all images in a preset angle.
e Tap 3D/4D > 3D to rotate the 3D image by using the trackball.
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] To Zoom Out/In All Images

Press the Zoom key on the control panel to zoom in or zoom out the image by rotating the Depth knob.
Meanwhile, a size multiplier is displayed in the information area of the basic screen.

] To Inverse Images

Tap 3D/4D > Inversion to inverse the gray values of anechoic structures on 3D image.
9.2.7 Optimizing 3D Image

] To Choose the Color
e Tap 3D/4D, tap the left/right part of 3D Chroma to choose the color scheme for the 3D image.
e Tap 3D/4D, tap the left/right part of B Chroma to choose the color scheme for reference images.
e Tap M-Slice, tap the left/right part of B Chroma to choose the color scheme for slices

The grayscale or color map on the top right of the imaging area varies with this setting.

] To Set the Contrast and Transparency
e Tap 3D/4D, tap the left/right part of Contrast to set the contrast of the 3D image.
e Tap 3D/4D, tap the left/right part of Transparency to set the transparency of the 3D image.

] To Set Threshold, Smoothness and Brightness
e Tap 3D/4D, tap the Left/Right part of Threshold to set the threshold value of the 3D image.
e Tap 3D/4D, tap the Left/Right part of Smoothness to set the smoothness of the 3D image.
e Tap 3D/4D, tap the Left/Right part of Brightness to set the brightness of the 3D image.

] To Adjust the Light Position

e In S-Live mode, tap Edit Light on the touch screen, locate the light position using the trackball, then press the
confirm button on the control panel.

e You can also tap the Left/Right part of Light Pos. to set the light position. The light icon at the lower-right of
the screen will change accordingly, and the shined area of 3D image will be brightened.
9.2.8 Observing Reference Image by the Plane
You can observe reviews by using the plane.
Perform the following steps to observe a review.

1. Tap C-Plane to enable this feature.
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9.2.9

2. Tap A, B or C to select the desired reference image, and then tap , , or E to select the
display formate.

3. Move the cursor on the desired reference image by using the trackball, and observe reference images on the

screen.

Observing Reviews by the Slice

You can observe reviews by using two or more slices. For example, each layer of an irregular tumor can be

observed by applying this feature.
Perform the following steps to observe a review.
1. Tap M-Slice > A, B, C or 3D to select the desired image.
After the selection, the desired image on the corresponding axis is displayed on the screen.
2. Tap 1*2,2%2,3%3, 3*4, 4*4 or 5*5 to set the slice number.

In the following figure, 9-slice imaging on the X axis is taken as an example.
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9.2.10

9.2.11
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Figure 9-5 Multi-Slice Imaging Screen
Nine slices and the corresponding number are displayed on the slice imaging. The middle full line is the central
slice in the current slice axis, and it is numbered as 0.

Except for the central slice, the other eight slices are indicated by the number at the top left corner of the slice and
are displayed on the screen. Tap the Left/Right part of Display to move all the slices in the slice area left or right.
Move the cursor on the one slice by using the trackball to select it.

To adjust the slice position/slice distance/slice number,

e Tap the Left/Right part of Adjust Pos. to fine-tune the selected slice position.
e Tap the Left/Right part of Distance to adjust the distance among the slices. The span and content vary with this
setting.

e Tap the Left/Right part of Slice Num to decrease or increase the number of slices.

After adjusting, the slice position, slice distance, the slice number, and the corresponding image of the slice will

change accordingly.

Setting the Scan Mode
Set Scan Mode in accordance with your preference.

Tap Linear or Sector to set the sweep mode.

NOTE:

This setting is only effective when entering 3D imaging from a frozen B mode image.

Adjusting ZAngle/ZScale
The image may be distorted if you perform the scan too quickly by using the probe. To acquire a vivid image, you
can adjust the value of ZAngle/ZScale before the scan.

e If Scan Mode is set to Sector, you can adjust the sweep angle when performing the scan by the probe.
Tapping the left/right part of ZAngle can adjust the angle.

e If Scan Mode is set to Linear, you can adjust the sweep span when performing the scan by the probe.
Tapping the left/right part of ZScale can adjust the scale.

NOTE:
This setting is only effective when entering 3D imaging from a frozen B mode image.
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9.2.12

9.2.13

9.2.14

Restoring the Image

Tap 3D/4D > Reset to restore the relevant settings.

Customizing Presets

You can modify parameters, adjust sample volume or ROI in the 3D mode and save them as the application preset
for future use. Moreover, the customized layout of the application mode screen can be modified and restored to

factory defaults.

NOTE:
Only the volume probes are capable of this feature.

For details, refer to Section 6.1 Selecting a Probe and an Exam Type.

The application presets can be displayed as options of the User Mode item in the inactivated 3D mode.

Performing Follicle Auto-Measurement

Tap AVC Follicle > Left Ovary/Right Ovary to automactically measure the number and the volume of follicles,
and the position of follicles is displayed on three reference images and 3D image.
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4D imaging enables the display of real time 3D anatomical structures.

4D imaging can only be performed by compatible volume probes. 4D imaging adds the dimension of “movement”

to a 3D image by providing continuous, real-time displays of internal organs or fetus. 3D imaging provides single

frame images, while 4D imaging provides continuous, high volume acquisition of 3D images.

The following description uses the fetal imaging as an example, the other imaging options are as the same.

10.1

10.1.1

Acquiring 4D Images

The following description uses 4D imaging performed with the VC6-2 probe as an example.

Entering the Real-Time 4D Imaging

Perform the following steps as follows.

L.

Enter the patient information, select the VC6-2 probe and an exam type (such as the obstetric exam used

throughout this chapter) to enter the B mode.

Optimize imaging parameters in the B mode.

Apply adequate gel on the patient.

Acquire a high quality B-mode image.

Tap 3D/4D on the touch screen to enter the inactivated 4D mode by default.

NOTE:

When using a volume probe, you can set the default inactivated 3D or 4D mode. For details, refer to

Section 4.1.4 Defined-Key Settings.

The 2D imaging with a ROI and a sample line is displayed in the inactivated 4D mode, only the data in the ROI

is acquired for 4D imaging.

FPS
D/G
GN
P
PWR
FRQ
D

Angle

47

31
255
3/30
70
3-4.8
16.5cm

4

/2D Imaging

ROI

Anchor

Status Icon

e
B

Figure 10-1 Inactivated 4D Imaging Screen
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6. Adjust the ROI and sample line.

You can press the confirm key to select the desired status icon.
- If B is highlighted, use the trackball to position the ROI.

- If | is highlighted, use the trackball to resize the ROI.
- If E is highlighted, adjust the sample line by positioning the anchor with the trackball.
7. Set the stability, user mode, focus position, image quality and sweep angle.

- Tap an item under User Mode to select a user mode.

Tap the Left/Right part of Sweep Angle to adjust the sweep angle of probe.

Tap the left or right part of Focus to decrease or increase the depth of focal zone.

Tap the left or right part of Image Quality to adjust quality of images.

Select the left or right part of Stability to enable or disable the image quality feature.
For other parameters, refer to Section 9.2 Working with 3D Images.
8. Display the 3D imaging in the following instructions.

- Tap (OJ, () or A8, tap Start or press the Freeze key to display the 4D imaging in a full, dual or quad
display. The system automatically enters the 4D imaging in a quad display by default.

- Tap 1, 2 or 4 on the key panel of the touch screen to display the 4D imaging in a full, dual or quad display.

The imaging area of the screen is divided into 3 reference images and a dynamic 3D image by default.
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Figure 10-2 4D Imaging Screen

As the above figure shows,

e View A on the top left shows the image on the X-axis.

e View B on the top right shows the image on the Y-axis.

e View C on the bottom left shows the image on the Z-axis.

e The image on the bottom right shows the dynamic 3D image.

As Figure 10-3 shows, the touch screen displays all controls related to the 3D imaging.
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Figure 10-3 4D Imaging Parameters Menu

e Tap PP or €« turn the current menu to the previous or the next page.
e Tap VolPre or press the Freeze key to return to the inactivated 4D mode.
e Tap Exit on the 3D/4D tab to return to the real-time B mode. Tap Exit on other tabs to switch to the 3D/4D tab.

Acquiring Dynamic 3D Image

You can acquire a dynamic 3D image of high quality by applying the features described in Section 9.2 Working
with 3D Images. You can also tap Edit ROI on the touch screen to freeze three reference images, and then use the
trackball to view the 3D image for better observation; tap Edit ROI again to unfreeze three reference images.

Press the Freeze key on the control panel to display the progress bar of cine review. Tap Auto Play to play the
cine review. Tap it again to stop the cine review.

Working with 4D Images

You can review, optimize or save 4D images in the frozen mode. For details, refer to Section 9.2 Working with 3D

Images.
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11 Working with Images

You can work with the acquired images by using the features provided by the system, such as the split screen

display, panoramic display and annotations.

11.1  Imaging Features

11.1.1 Imaging Reverse
Tap ¥ on the touch screen to reverse the real time scan left or right.

Tap E£ on the touch screen to reverse the real time scan up or down.

11.1.2  Split Screen Display
You can position two or four images side by side on the screen to compare the images by using the split screen
display.
] Dual-Split Screen Display
1. Press the B, CFM, M, PW or CW key on the control panel to select an imaging mode for a real time scan.

2. Press the Dual key on the control panel or tap on the touch screen to enter the dual split Screen display.

The image is duplicated into two parts with a frozen image on the left and a real time scan on the right. The
real time scan in B-mode is taken as an example in the following figure.

o

o

S

@

Figure 11-1 Real Time B+Frozen B

— Press the Dual key or tap DID to freeze the real time scan and unfreeze the other image.
— Press the CFM, M, PW or CW key to select an imaging mode for the real time scan.
— Tap Dual Live to display two real time scans if one of the two images is a color-mode image.

The image is duplicated into two parts with two real time scans.

111



11 Working with Images
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Figure 11-2 Real Time CFM + Real Time B
[ Quad-Split Screen Display
1. Press the B, CFM, M, PW or CW key on the control panel to select an imaging mode for a real time scan.

2. Tap gﬁ on the touch screen to enter the quad split screen display.
The B-mode image is taken as an example in the following figure.
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Figure 11-3 Quad-Split Screen Display
- Tap g% to freeze the current image and unfreeze the following clockwise image.
— Press the CFM, M, PW or CW key to select an imaging mode for the real time scan.

— Press the B key to exit the quad split screen display.
11.1.3 m-Tuning
m-Tuning optimizes the image quality.
To enable m-Tuning:

Press the m-Tuning key on the control panel to optimize image quality.

11.1.4 Harmonic Imaging

Tissue Harmonic Imaging (THI) uses the harmonic frequencies generated by tissue. The fundamental transmit
frequency results in a harmonic frequency echo. The harmonic frequency received from the tissue is a multiple
of the fundamental transmit frequency. The fundamental and any accompanying artifacts are missing from the
harmonic frequency that the system receives. The artifact reduction, and the concomitant reduction in haze and
clutter, increases contrast resolution and improves border delineation. THI is useful in difficult-to-image patients.

In real time scan of B mode, tap THI on the touch screen to enable the THI mode, and THI or PHI appears at
the lower left corner of the screen. Optimize the image the same way you did in the B mode.
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11.1.5

Tap THI again to exit the imaging, and THI disappears from the screen.

NOTE

* The system automatically optimizes certain parameters (B-mode gain, frequency and frame rate) upon
enabling THI.

* Compared to the B-mode imaging, THI improves image resolution but decreases the frame rate. Therefore,
you should make an optimal balance when choosing an imaging mode.

« THIis only available with compatible probes.

Panoramic Imaging

Panoramic imaging is an imaging process that produces a panoramic image by using certain probes. The panoramic
image provides sequentially and individually aligned 2D images on a static image. The 2D images are real-time,
showing their anatomical context of an adjacent structure. Panoramic imaging allows you to display, view and

measure a new stitched image constantly.

NOTE:

» Panoramic imaging is only available performed with linear or curved probes.

* Apply an adequate amount of coupling gel along the intended path of the scan.

* Do not shake, rotate or tilt the probe during the scan.

» Ensure the probe remains to be in contact with the skin perpendicularly during the scan.

» Do not change the scan direction or move the probe backwards and forwards.

* When the scan depth increases, generally it is generally required to decrease the scan speed.

Real-Time Panoramic Imaging

Perform the following steps to apply panoramic imaging.

1. Optimize the B-mode image.

2. Tap Panoramic+ on the touch screen to enter the inactivated Panoramic Imaging mode.
You can press the Freeze key on the control panel to exit and return to the B mode.

3. Press the Update key on the control panel to enter the real-time panoramic imaging.

4. Perform the scan.

A real-time stitched image is generated, on which a probe speed box and a hint are displayed. A blue speed box
indicates a slower scanning speed, a green speed box indicates a normal scanning speed and a red speed box
indicates a faster scanning speed.

5. Press the Freeze key to display the panorama.

B
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Figure 11-4 Real-Time Panoramic Imaging Screen
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You can press the Freeze key again to return to the inactivated mode.
6. Work with the image.
- Magnify the Image

Tap ZOOM on the touch screen to enable the Picture-In-Picture feature, and a thumbnail is displayed in the
lower left corner of the screen.

Use the trackball to position the interest area, and tap the left or right part of ZOOM to zoom in or out the
image.

- Tap Rotate on the touch screen to rotate the image.

- Tap Overview on the touch screen to restore the image to the default setting.

— Make measurements, annotations and body marks.

7. Tap Exit on the touch screen to exit panoramic imaging.

| Frozen Panoramic Imaging

NOTE:
Ensure you disable the compound imaging feature before you apply the frozen panoramic image.

1. Optimize the B-mode image, and press the Freeze key on the control panel to freeze the image.

2. Tap Panoramic+ on the touch screen, and the initialization message appears on the screen.

B

FPS 47

D/IG 31

GN 255 [CLR]: Cancel
P 3/30
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Figure 11-5 Frozen Panoramic Imaging Screen

Pressing the Clear key on the control panel can abort the initialization.
3. Work with the image.
— Magnify the Image

Tap ZOOM on the touch screen to enable the Picture-In-Picture feature, and a thumbnail is displayed in the
lower left corner of the screen.

Use the trackball to position the interest area, and tap the left or right part of ZOOM to zoom in or out the
image.

- Tap Rotate on the touch screen to rotate the image.

- Tap Overview on the touch screen to restore the image to the default setting.

- Make measurements, annotations and body marks.

4. Press the Freeze key twice or tap Exit on the touch screen to exit panoramic imaging.

11.2  Magnifying an Image

You can magnify an interest region on the imaging area.
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NOTE:

The image can also be magnified in the frozen mode.
To magnify an image:

1. Press the Zoom key on the control panel to enable this feature.

A size multiplier is displayed in the information area of the basic screen, a thumbnail is displayed in the lower
left corner of the basic screen, and the magnified image is displayed on the imaging area of the basic screen.

2. Position the ROI by using the trackball.

3. Rotate the Depth knob on the control panel to magnify the image in certain times.

11.3  Freezing an Image

Press the Freeze key on the control panel to capture an image in a real time scan or dual/quad split screen display
and the feature to be applied is also activated. For this setting, refer to Section 4.1.1 General Settings.

You can select any desired image mode, magnify the image, perform measurements, add annotations and body

marks and adjust imaging parameters in the frozen mode.

11.4  Using Cine

The cine review is available by pressing the Freeze key on the control panel and the [[¢[] icon appears on the
screen.

0 249 498
T T ] T T 1
L

You can play back the cine by tapping Auto Play on the touch screen or review the cine by using the trackball.
Moreover, the cine can also be cut for your actual use.

11.4.1 Reviewing Cine

] To View Cine Manually

You can review the cine frame by frame by using the trackball or tapping F By F on the touch screen in the frozen
B mode. Each image is identified by a number which indicates its position in the cine.

NOTE:

* You can adjust the parameter settings when review cine.

*  You can tap To First or To Last on the touch screen to review the first or last frame.
] To Review Cine Automatically

In the frozen mode, tap Auto Play to play the cine review automatically. Tap Auto Play again to stop the cine

review.

Or, tap the left or right part of Cine Speed to adjust the review speed during the cine review.

114.2  Cutting Cine
To cut the cine:
1. Use the trackball to move the cursor to the start frame, and then press the Update key on the control panel.
2. Move the cursor to the end frame, and then press the Update key.

3. Press the Save ({&1]]) key on the control panel to save the cut cine.
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11.5

11.5.1

11.5.2

Annotations and Body Marks

The annotation feature allows you to type or add an annotation from the predefined annotation library. You can
annotate the cine, real-time image or frozen image. Arrows and body marks are also provided to annotate the
image.

NOTE:

You should define an annotation library before applying this feature. For details, refer to Section 4.3 Defining
Annotation Library.

Annotating an Image

Annotating an image with Typed Words
Perform the following steps:
1. Press the Annot key on the control panel.

The cursor becomes | on the screen and the predefined words appears on the touch screen.

2. Move the cursor to the desired place by using the trackball and tap the predefined word on the touch screen to
add it to the image.

— Move the cursor to the desired place and input an annotation manually by using the key panel.

— Move the cursor to an annotation and press the confirm key. Then move the annotation to the desired
position by using the trackball and press the confirm key.

— Move the cursor onto an annotation to edit it by using the key panel.

3. Repeat the above steps to add more annotations if necessary.

4. Press the Annot key again or tap Exit on the touch screen to exit.

Annotating an Image with Arrows
Perform the following steps:
1. Press the Arrow key on the control panel, and the cursor becomes an arrow.

2. Position the arrow to the desired place by using the trackball, and press the confirm key to add it on the image.

If necessary, rotate the Angle knob to adjust the arrow angle.

3. Repeat the above steps to add more arrows if needed.

Setting an Initial Position for an Annotation
Perform the following steps.
1. Press the Annot key on the control panel and the cursor becomes | on the screen.

2. Move the cursor to the desired position by using the trackball and tap Set Home to set the initial position for an
annotation.

After the settings,

e if a text annotation is being edited, tap Home to move the cursor to the initial position.

e if a text annotation is being moved, tap Home to move the text annotation to the initial position.

e when entering the text or arrow annotation screen next time, the cursor appears in the initial position set this

time.

Body Mark
Perform the following steps.

1. Press the Body Mark key on the control panel.
The first body mark of the desired exam type is added to the image by default.
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11.5.3

11.6

ifWARNING

11.6.1

2. Tap a body mark on the touch screen to add it to the image.

3. Position the probe marker to the desired place by using the trackball.
If necessary, rotate the Angle knob on the control panel to adjust the angle.

4. Press the confirm key to add it to the image.
Deleting Annotations and Body Marks

To Delete Annotations

Perform the following steps.

1. Press the Annot key on the control panel to enter the text annotation screen.
2. Move the cursor onto the annotation and then tap Delete on the touch screen.

NOTE:

You can enable the annotation-cleared feature. For details, refer to Section 4.1.1 General Settings.

To Delete Body Marks
Perform the following steps.
1. Press the Body Mark key to enter the body mark editing mode.

2. Tap Delete on the touch screen.

To Delete All Annotations and Body Marks

You can press the Clear key on the control panel to delete all annotations and body marks from the image. You can
also tap Clear on the touch screen to delete them from the image when they are being edited. Perform this deletion

with caution.

Using ECG

Using an optional ECG module (Type BF), 3-channel ECG signals are provided in cardiac applications. During
an cardiac application, you can configure the ECG-control so that the ECG trace is displayed at the bottom of the

screen.

The ECG cable includes three color-coded ECG electrode connectors, i.e., LL (left leg, red), LA (left arm, black)
and RA (right arm, white).
The ECG module provided by this ultrasound system is for collecting and displaying 3-lead ECG trace.

e This ECG module is not suitable for intracardiac use or direct cardiac contact.

e This ECG module provides 3-channel ECG signals and cannot be used for diagnosis and monitoring.

e To avoid electrical shock, ensure the ECG cable is intact and be correctly connected.

e Conductive parts of electrodes and connectors for ECG should not come into contact with other conductive
parts including earth/grounding.

e Power off the system if the patient is found to use a pacemaker or implantable cardioverter-defibrillators,
because the system may interfere with these devices.

Basic Procedures of ECG Operation
Perform the following steps:

1. Power off the system and connect the ECG cable to the specific port of the system.

2. Power on the system and attach the ECG electrodes on the patient’s body (as shown in the following figure).
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IEC Standard AHA Standard

Figure 11-6 Electrode Placement

3. Make the relevant settings of the ECG module. For details, refer to Section 11.6.2 Optimizing Parameters.

4. Freeze the images and review them. For details, refer to Section 11.6.3 Reviewing ECG.

5. Exit the ECG mode, and remove ECG electrodes from the patient.

11.6.2  Optimizing Parameters

Tap ECG on the touch screen to display the submenu of the ECG module. Or, tap ECG again to hide it.

ECG ON/OFF Display or hide the ECG waveform.

ECG Gain Set the amplitude of the ECG waveform.

ECG Position Set the vertical position of the ECG waveform.

ECG Invert Enable or disable the waveform inversion function.

R-Trigger Enable or disable the R-trigger function.
When enabled, the R-Trigger menu pops up, the menu contains Trigger Delay, Frame
Count, and Frame Int.
NOTE:
In order to enable the R-trigger function, you should disable the compounding imaging
function first.

Trigger Delay Delay of trigger after the 2D refresh.

Frame Count

Image frames transferred per second.

Frame Int.

Interval between 2D image refresh.

11.6.3 Reviewing ECG

Press the Freeze key on the control panel to freeze an image and the ECG waveform is frozen at the same time.

The ECG waveform is the reference for time.
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12 Managing Images/Data

Images in this ultrasound system include frame images and cine, you can save or review them after the acquisition.

Meanwhile, images can be also backed up to a USB drive or a DVD for future review if it is needed.

12.1

12.1.1

12.1.2

12.2

12.2.1

Storing an Image

NOTE:

» Keys can be defined on the General Settings menu - Key Configuration tab. For details, refer to 4.1.4
Defined-Key Settings.

+ All data is saved to the system by default. If a USB drive is connected and Store to UsbDisk is ticked
on the General Settings menu - Key Configuration tab, the saved data will be synchronously stored to the
USB drive.

Storing 2D Image

Press the Save ([8]) key on the control panel in the real time or frozen mode to save the current image. Press the
Save || key on the control panel in the frozen mode to save the current cine.

The system beeps if the image is saved successfully. Meanwhile, the corresponding thumbnails for the stored image
or cine also appears in the clipboard.

Storing 3D/4D Image
1. Press the Save ([&]) key on the control panel in the 3D/4D mode.

2. Select Image in the pop-up dialogue box to save the current image.
Or, select Volume in the pop-up dialogue box to save the volume data.

In the 4D mode, you can also select Cine in the pop-up dialogue box to save the current cine.

The system beeps if the image is saved successfully. Meanwhile, the corresponding thumbnails for the stored
image, cine or volume data also appears in the clipboard.

Viewing an Image

You can view the images for the current or a previously examined patient by using the clipboard or the Review

screen.
Viewing a Current Image

To View an Image by Using the Clipboard
1. Press the Pointer key on the control panel in the real time or the frozen mode.

2. Select the image in the clipboard by using the trackball, and then press the confirm key to view the image/cine.
- Click [BY to select all images.
Click 4 or P> to go to the previous or the next page.

Click [Bf to export images to the USB drive or DICOM.
Click '@‘ to delete the desired image/cine.

You can also amplify the image or review the cine and perform a measurement.
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12.2.2

To View an Image on the View Image Screen

1. Press the Review key on the control panel to enter the View Image screen.

The following screen is displayed with images and cine thumbnails.

View Image

Patient ID: 345 Patient Name: Mary Exam|:| E]

Files Number: 19

[xs v

All Select

Delete
Review
DICOM Send
DICOM Print

Print

[-04292014204714_ 9 e, 04292014204716_10 v 1=—04292014205735_11

If the patient has had more than one exam, you can select the desired exam from the Exam drop-down list.

2. Move the trackball to the thumbnails and select the confirm key to choose one image.
3. View the image.
- Double-click the confirm key to view an image.

You can press the Freeze key at any time to return to the View Image screen.
- Click Review to view the image.

Retrieving an Image
Perform the following steps.
1. Choose the Patient key > Patient List > Patient Review to enter the Patient Review screen.

2. Select the desired patient, and then click View to enter the Exam Review screen.

3. Select the desired exam, and click View Image to retrieve the image.

12.3  Sharing Data

You can remote access to the data stored in the system through a computer.
Perform the following steps.
1. Connect the computer to the system.
2. Set Image Share Service to On on the General Settings menu - Storage tab.
3. Type the IP address in the search box of the computer and press Enter.
4. Type the user name and password in the pop-up dialogue box.
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12.4  Backing up Data

warnine @ All data is saved to the system by default. To avoid data loss due to unexpected system breakdown or software
update, you are highly recommended to back up data backup.

e Complete all exams before backing up the data.

12.4.1 Backing up Data to a USB drive
Perform the following steps.
1. Connect a USB drive to the system.
2. Choose the Patient key > Patient List > Patient Review to enter the Patient Review screen.
3. Select USB from the Import/Export drop-down list.

4. Click Export Screen and then select the exported image format.

If you select PC image format, you can also select the exported image or cine format.
5. Select the desired patient.
6. Click Patient Export to back up all data relevant to the patient.

If only images are needed to be exported, you can export them on the View Image screen.

12.4.2  Backing up Data to DVD

You can use a DVD with the system. DVD (DVD-R/RW, DVD+R/RW, not less than 4.7GB capacity or more)
manufactured by SONY is recommended.

Perform the following steps.
1. Place an empty DVD in the CD-ROM drive.

NOTE:
Please make sure the DVD is facing upward in the CD-ROM drive.

2. Choose the Patient key > Patient List > Patient Review to enter the Patient Review screen.
3. Select DVD from the Import/Export drop-down list.

4. Click Export Screen, and then select the exported path.

5. Select the desired patient.

6. Click Patient Export to back up all data relevant to the patient.
DVD ejects after a successful data backup export prompt is displayed.
7. Take out the DVD from the CD-ROM drive and close the tray.

If only images are needed to be exported, you can export them on the View Image screen.

12.5 Importing Data to the System

NOTE:

* Only data generated by this ultrasound system can be imported.

* Ensure the current exam is completed before you import data. Otherwise, you may have a failure data
import.

Perform the following steps.

1. Connect the USB drive to the system.
Or, place an empty DVD in the CD-ROM drive.

2. Choose the Patient key > Patient List > Patient Review to enter the Patient Review screen.
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3. Select the imported device from the Import/Export drop-down list.
4. Click Export Screen and then select the imported patient information.

5. Click Patient Import to import the desired data.
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13 Working with DICOM

DICOM (Digital Imaging and Communications in Medicine) is a standard created by National Electrical
Manufacturers Association (ACR-NEMA) to regulate the distribution and viewing of medical images such as
ultrasound images and cine.

If the system is configurated with the DICOM module, you can:

e  Search the archived patient information set on the DICOM server, and copy the patient information to the system so that
the correct patient can be examined.

e  Send stored images or data on the system to the DICOM server.

e  Print images on a DICOM printer.
DICOM service of the system consists of DICOM storage, DICOM print, DICOM worklist, MPPS and storage

commitment.

If you need DICOM 3.0 Compatibility Declaration, please contact the manufacturer.

13.1  Verifying Connectivity
Perform the following steps.
1. Connect the system to the local DICOM network server by using a network cable.

2. Edit the relative settings for the local network and DICOM server. For details, refer to Section 4.2 Peripheral
Device Settings and 4.8 Configuring DICOM.

3. If'the verification is successful, you can use the DICOM services.

NOTE:

Ensure the system is connected to the server before using the DICOM service. Otherwise, the service cannot
be used.

13.2 DICOM Storage

DICOM Storage is used to send patient data to the DICOM storage server for storage.

13.2.1 Storing the Current Image

1. Connect a USB drive to the system.

2. Define the Save ([8]) key or the P1 key as Dicom Send on the General Settings menu - Key Configuration
tab.

3. Press the Save ([8]) key or the P1 key in the real-time or frozen mode to send the current image to the
DICOM storage server.

If the transmission fails, a prompt displays on the bottom right of the screen.

13.2.2  Storing Patient Data

1. Choose the Patient key > Patient List > Patient Review to enter the Patient Review screen.

2. Select the desired patient, and then click View to enter the Exam Review screen.
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13.3

13.3.1

13.3.2

13.4

3. Select the desired exam.
4. Click DICOM Send to send the patient information and the relevant images to DICOM storage server.

If you only want to send images, press the Review key on the control panel to enter the View Image screen,
select the desired images, and then click DICOM Send.

If you want to check the status of items sent to the DICOM storage server, choose the Patient key > Patient List
>DICOM Queue.

DICOM Print

DICOM Print is used to send images to the DICOM print server for printing.

You should properly connect the system to the print server and edit the relevant settings. For details, refer to 4.8.5

Print Service Settings.

Print the Current Image

1. Define the Save (|&]) key or the P1 key as DICOM Print on the General Settings menu - Key Configuration
tab.

2. Press the Save () key or the P1 key in the real-time or frozen mode to send the current image to the
DICOM printer server.

Print Patient Data

1. Choose the Patient key > Patient List > Patient Review to enter the Patient Review screen.

2. Select the desired patient, and then click View to enter the Exam Review screen.

3. Select the desired exam.

4. Click DICOM Print to send the patient information and the relevant images to DICOM print server.

If you only want to send images, press the Review key on the control panel to enter the View Image screen,
select the desired images and then click DICOM Send.

If you want to check the status of items sent to the DIOCM print server, choose the Patient key > Patient List >
DICOM Queue.

DICOM Worklist

The DICOM Worklist is used to search the archived patient information on the DICOM server, and copy the patient

information to the system so that the correct patient can be examined.

Press the Patient key on the control panel to enter the New Patient screen and then click WorkList to enter
the WorkList screen.
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WorkList
PatientName [ | Patient ID | | [ Search]
Accession# [ | Requested Procedure ID| | [ Reset |

Date (/][05/04/2016 | To (\][os/08/2016 |~ Only US

Worklist Information
Patient ID{ Patient Name{ Birth Date{ Sex { Description{ Requested Procedure Ili Accessiom# Date/Time

(Group Case] [ Select ][ Cancel |

Figure 13-1 WorkList Screen
Perform the following steps.

1. Search for the patient information

Enter the search requirements, such as Patient Name, Patient ID, Accession#, Exam Date/Time or Requested
Procedure ID, and then click Search to search for the desired information.

Clicking Reset can clear all the search information.
Clicking Date/Time can display the patient data by order of oldest or newest input date/time.

2. Start an exam

a. Select the desired patient.

b. Click Select to start an exam. If the desired patient has taken more than one exam, click Group Case to
start the exam.

3. Enter patient information.

13.5 MPPS
MPPS is used to send exam status information to the MPPS server, which facilitates the other systems to obtain the
exam progress in time.

The status information is described as below:
e When the exam is started, the system sends the status information “In Process” to the MPPS server.

e When the exam is completed by pressing the End Exam key on the control panel, the system sends the status
information “Complete” or “Discontinue” to the MPPS server.

If you want to check the status of items sent to the MMPS server, choose the Patient key > Patient List >
DICOM Queue.

You can manually add MPPS to check the processing status of the discontinued exam or other order operations.

NOTE:
MPPS can only be added when you perform the scan or other order operations.

Perform the following steps.
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13.6

1. Choose the Patient key > Patient List > Patient Review to enter the Patient Review screen.

2. Click PPS Screen to enter the PPS screen.

PPS Screen

Information

Patient ID |Patient Name | Birth Date‘ Sex ‘Description Date/Time | State
20140505 Mary Unknown IN PROGRESS

Scheduled Procedure Step Information
Code | Description| Meaning

[ Append][ Exit ]

Figure 13-2 PPS Screen

The PPS screen displays MPPS information about the current patient. If the patient information is acquired
from the DICOM WorkList, the PPS screen will also display the relevant acquisition protocol.

3. Click Append to display the following dialogue box.

PPS
DAssisted Acquisition Protocol Setting
Code | |
Meaning | |
Designalorl |
Reason | Doctor cancelled procedure |E]
[ Completed ] [ Discontinued ]

4. Click Assisted Acquisition Protocol Setting, and then enter the relevant information to code, meaning and
designator.

5. Click Completed to end the order operation.

Or, you can also click Discontinued if needed.

Storage Commitment

Storage commitment is used to confirm whether the images or structured reports are successfully stored to the
DICOM storage server.

If you want to check the status of items sent to the DICOM storage server, choose the Patient key > Patient List
> DICOM Queue.

126

Basic User Manual



13 Working with DICOM

13.7 DICOM Queue

The DICOM Log is used to check the sending status of DICOM storage, DICOM print, MPPS and Storage

Commitment.

Choose the Patient key > Patient List > DICOM Queue to enter the DICOM Queue screen.

DICOM Queue
PatientiDl |  Patient Name] | [ Search ]
Date(") [12/04/2016) To(_) [i2/04/2016] ~ Type [ |(W)
DICOM Queue Information
Type ‘ Patient ID‘ Patient Namé Server‘ Start Time‘ Size‘ Run State‘ Status‘ Details
D MPPS 20140505 Mary AE 12/05/2016-16:04:03 OM  Finish Fail Association Request Failed
[ Refresh ][ All Select ][Resend FaiI] [ Resend ][ Delete ][ Exit ]

Figure 13-3 DICOM Queue Screen

Perform the following steps.

1. Search for the patient information
Enter the search requirements, such as Patient Name, Patient ID, Type or Exam Date/Time, and then click
Search to search for the desired information.
2. Check the sending status
You can check the sending status by viewing Run State, Status or Details.
3. Deal with the failure sending information
— Select the desired patient information and click Refresh to refresh the patient information. If it does not
work, you can click Resend to resend the information.
- Click All Select > Resend Fail to resend all information.

— Select the desired patient information and click Delete to delete the information.

13.8  Query/Retrieve List

The Query/Retrieve List is used to retrieve patient information from the query server. User can import the

retrieved patient exam information to the system and view it.

Press the Patient key on the control panel to enter New Patient list. Click Patient List to enter Patient List screen
and click DICOM Q/R to enter Query/Retrieve List screen.
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Query/Retrieve List

PatientIDl__ |LastName [ | FirstName | | (Query Patients)
Date Range (] [12/04/2016] ... (] [12/04/2016] Accession#[ _______](_JonlyUS
—Patient List [Query Exams ]
‘ Patient ID [Patient Name[ DOB [ Exam List [ Sex [ Last Exam ‘
—Exam List
No. Patient ID | Accession# | Image Size Img Exam Time ‘

Exam Typ
0/0P
[

Figure 13-4 Query/Retrieve List

Perform the following steps.

1.

Retrieve patient information.

Select the desired query condition, such as Patient ID, and enter the related information. Click Search, and
patient information will be displayed on the Query/Retrieve list.

Click Reset to delete the entered query condition.

Click Date/Time, the system will arrange the patient information in chronological order of exams.

Import patient information.

Select the desired patient information on the Query/Retrieve List and click Retrieve to import the patient
information to the system. If the information is imported successfully, user can view the patient information on
the Patient List screen.
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You should become thoroughly familiar with the operations of the probe and biopsy bracket before using them. To

ensure the performance of the probe and the biopsy bracket, you should periodically check, clean, disinfect and

maintain them.

NOTE:

A general instruction for the probe and the biopsy bracket is provided in this manual. For details, refer to the relevant

manuals.

14.1

14.1.1

Probe

This ultrasound system supports a wide range of probes which make the system remarkably versatile.

The schematic diagrams of probes are as follows.

Transducer

Orientation mark

Handle
Junction line

Handle Junction line

Transducer

Body surface probe Endocavitary probe

I

Intraoperative probe

Available Probes

The available probes are listed as follows.

C322, C344, C353, C354, C542, Col11, Co13, L741, L742, L752, 2P1, 5P1, | Body surface
10L1, VC6-2, CWD2.0, CWD5.0, PWD2.0, 3C-A, 4P-A, 3P-A, 7P-B, 18L-
A, 6CT-A, 12LT-A, 6CI-A, 12LI-A, 9L-A, 13L-A, 3C-B, 4P-B, 12P-B

6V1, 6V3, 6V7, 6VIA, 6V2A, EC9-5, BCL10-5, BCC9-5, MPTEE, MPTEE | Intracavitary
mini, 12C-ER, 6V-A, 8V-A

1012, 10L-1, LAP7 Intraoperative
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14.1.2

ifWARNING

itCAUTION

Probe Usage

Use only the probes provided by the manufacturer. Otherwise, the system may not perform and an accident
such as a fire may result.

Use the probe carefully. If any part of the probe surface is scratched, immediately stop using the probe.
Otherwise, electrical shock may occur.

A legally marketed probe sheath is required for intracavitary operations. If lubricant is used, it must be water-
soluble. Do not apply coupling gel directly on the patient’s skin. Please dispose of the sheath in accordance
with local laws and regulations.

Use a sterile probe sheath and sterile coupling gel when performing an intraoperative, trans-vaginal, trans-rectal
or trans-esophageal (Cardiac) exam. If lubrication is insufficient because of age and personal reason during the
exam, you need to apply a sufficient amount of sterile coupling gel on the surface of the sheath.

To avoid contamination, please use the coupling gel and probe sheath before performing an exam.

Use legally marketed coupling gel in accordance with the relevant local regulations. Read and understand all
precautions in the relevant manual of the coupling gel before use. For recommended coupling gels, please refer
to Appendix D.1 Coupling Gel.

Latex or natural rubber contained inside medical equipments or accessories can cause severe anaphylactic
reactions in some individuals. It’s suggested by the FDA that the operator should identify latex-sensitive
patients and be prepared to treat anaphylactic reactions promptly.

After being contaminated by pathogenic bacterium that is hard to kill, such as cryptosporidium or prion virus,
the probe and its accessories should be destroyed by melting or burning when necessary because they cannot be
completely disinfected or sterilized.

Avoid immersing the transducer surface in the coupling gel for a long period of time. Otherwise, damage to the
probe may occur.

Avoid any fluid flowing into the probe or probe connector when cleaning, disinfecting or sterilizing the probe
and probe cable.

Special Concerns before Probe Usage

Inspect the probe before each use. If the following damage is found, stop using the probe immediately.

Cracks on the probe handle (user section).

Cracks on the transducer surface (applied section).

Scratches on the transducer surface (acoustic window surface).
Swell of the acoustic window material.

Cracks or wear on the probe cable.

Cracks on the probe connector or any other kinds of visible damage.

Deformed pins or broken pins exist inside the probe connectors.

Body Surface Probe Usages

1.
2.
3.

Wear medical sterile gloves.
Orient the probe.

Perform a scan.

Endocavitary Probe Usages

1.
2.

Wear medical sterile gloves.

Wear the probe sheaths
a. Remove the packaging and unfold the probe sheath.
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b. Apply an appropriate amount of coupling gel to the inside of the sheath and onto the face of the probe.

c. Hold the probe and unroll the sheath onto the probe.
d. Pull the probe sheath tightly over the face of the probe to remove wrinkles.
e. Secure the sheath to the probe with the adhesive tapes or elastic bands.

3. Orient the probe
Check the probe orientation mark before the scan.

4. Perform a scan.

] Intraoperative Probe Usages
1. Wear medical sterile gloves.

2. Ensure the bending section of intraoperative probe is release and can be bent freely.

a. Rotate two angulation knobs to adjust the probe distal end to the desired angle.
b. Lock the angulation knobs if they are adjusted properly.

3. Perform a scan.
14.1.3  Cleaning the Probe

warnine @ - To avoid electrical shock, disconnect the probe from the system before cleaning.
e To avoid potential disease transmission, you should wear sterile medical gloves and protective goggles while
cleaning.

cauTion @ Do not use cleaner that contains sodium sulfate and/or sodium hypochlorite to clean the probe. Otherwise, the

probe may be damaged.

e To avoid probe damages, do not bump the probe on hard surfaces.

e Use only the cleaner recommended by the manufacturer to clean the probe. Otherwise, the probe may be
damaged.

You should clean the probe before and after each use. Probe cleaning is an essential step of the disinfection and

sterilization.

Perform the following steps to clean the probe.

1. Remove the coupling gel from the probe surface after exam.

2. Disconnect the probe from the system and remove the probe sheath and biopsy bracket from the probe.
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14.1.4

ifWARNING

ifCAUTION

. Use a lint-free soft cloth dampened with mild soapy water or the recommended cleaner (see Appendix D.2

Cleaner) to wipe the probe.

If there are dried stains on the surface or in the grooves of the probe, remove them by a brush dampened with
an enzymatic clearer.

. Rinse the surfaces of the probe with the fresh running water to completely remove any residual cleaner.

. Dry the probe with a lint-free soft dry cloth.

Disinfecting and Sterilizing the Probe

There is a cleared list of sterilants and high-level disinfectants for use in processing reusable medical and dental
devices on the FDA website. That list can be consulted to find agents that may be useful for probe disinfection.
Please refer to the following URL for FDA-Cleared Sterilants and High Level Disinfectants: http://www.fda.
gov/MedicalDevices/DeviceRegulationandGuidance/ReprocessingofSingle-UseDevices/ucm133514.htm.

Use the liquid disinfectant/sterilant that meets the local laws and regulations or the recommended disinfectant/
sterilant.

The probe sheath may be damaged during exam and contamination risk level caused by the damaged sheath is
difficult to estimate. Therefore, probe sheath cannot change the level of disinfection for a probe. Please clean
and sterilize (or high level disinfect) the entracavitary probe and clean and sterilze the probe for biopsy and
coming into contact blood after exam.

Do not use an expired disinfectant/sterilant.

Store the probe in a sterile environment, and review its expiration date before use.

If you use the recommended disinfectant/sterilant, ensure the requirements for the disinfection level and probe
soaking period are met. Otherwise, the probe could be damaged and your warranty may be void. If you have
further use or needs for the probe, ensure the level of the make-up disinfectant/sterilant and the probe soaking
period are suitable for the intended clinical application.

Do not use the following methods to sterilize the probe.

- Autoclave

— Ultraviolet sterilizer

- Gamma ray sterilizer

— Ethylene oxide gas

- Ethylene oxide

— Thermal disinfection/sterilization. Temperature higher than 66°C (150°F) will damage the probe.
Do not allow any disinfectant/sterilant to be air-dried on the probe.

| Disinfection Levels
To choose an appropriate disinfectant, you first must determine the required level of disinfection, based on the
probe applications.
Classification Definition Level of Disinfection Application
Critical A device that enters normally sterile | Sterilization Intraoperative,
tissue or the vascular system. biopsy use or blood
contacting probe
Semi-critical A device that comes into contact with | High Endocavitary probe
intact mucous membranes and does
not ordinarily penetrate sterile tissue.
Noncritical Devices that do not ordinarily touch | Medium or low Body surface probe
the patient or touch only intact skin.
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] Immersion Requirements

Do not immerse the probe beyond its junction line.

] To Disinfect the Body Surface Probe
You should disinfect the surface probe after each use.
Perform the following steps:

1. Clean the probe.
For details, refer to Section 14.1.3 Cleaning the Probe.

2. Perform the medium-level disinfection to the surface probe as shown in Table 14-1 until the recommended
disinfection period expires.
Or select a recommended disinfectant (see Appendix D.3 Disinfectant) to disinfect the probe by following the
instruction provided by disinfectant’s manufacturer.
3. Rinse the probe with the fresh running water to remove the residual disinfectant completely.
4. Dry the probe with a lint-free soft dry cloth.
Table 14-1 Recommended Method for Medium-level Disinfection
70% Isopropyl | All Isopropyl alcohol 70% Spray/Wipe | <10 minutes
alcohol
T-spray 11 Pharm. Inc. Quat. Ammonia / Spray/Wipe | <10 minutes
T-spray Pharm. Inc. Quat. Ammonia / Spray/Wipe | <10 minutes

[ To Disinfect the Endocavitary Probe
You should disinfect the endocavitary probe before and after each use.
Perform the following steps:
1. Clean the probe.
For details, refer to Section 14.1.3 Cleaning the Probe.

2. Perform the high-level disinfection to the endocavitary probe as shown in Table 14-2 until the recommended
soaking period expires.

Or select the recommended disinfectant (see Appendix D.3 Disinfectant) to disinfect the probe by following the
instruction provided by disinfectant’s manufacturer.

3. Rinse the probe with the running sterile water to remove the residual disinfectant completely.
4. Dry the probe with a lint-free soft dry cloth.
Table 14-2 Recommended Method for High-level Disinfection
Cidex™ Activated J&J Glutaraldehyde 2.4% Soak 45-50
Dialdehyde Solution minutes
Resert XL HLD STERIS H,0, 2.0% Soak 8 minutes
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] To Sterilize the Probe
You should sterilize the intraoperative, biopsy use or blood contacting probe after each use.
Perform the following steps:

1. Clean the probe.
For details, refer to Section 14.1.3 Cleaning the Probe.
2. Sterilize the probe as shown in Table 14-3 until the recommended soaking period expires.

Or select the recommended disinfectant (see Appendix D.3 Disinfectant) to sterilize the probe by following the
instruction provided by disinfectant’s manufacturer.

3. Rinse the probe with the running sterile water to remove the residual sterilant completely.

4. Dry the probe with a lint-free soft dry cloth.

Table 14-3 Recommended Method for Sterilization

Cidex™ Activated | J&J Glutaraldehyde | 2.4% Soak 10 hours

Dialdehyde
Solution

14.1.5 Disinfecting and Sterilizing the Probe Cable

warninG To avoid potential disease transmission, you should wear sterile medical gloves and protective goggles during
disinfection or serialization.

cAution Do not immerse the probe cable in alcohol or isopropyl alcohol at any concentration for a long period of time.
Avoid any contact with iodine or phenols. Otherwise, it will accelerate the aging of the cable and decrease the
service time of the probe, or even result in cable damages.

] Disinfection

Perform the following steps to disinfect the probe cable.

1. Use a lint-free soft cloth dampened with mild soapy water to wipe the probe cable.
Rinse the cable with fresh running water to completely remove the residual cleaner.

Perform the medium-level disinfection to the probe cable as shown in Table14-4.

Bl

Rinse the surfaces of the probe cable with fresh running water to completely remove the residual disinfectant.

5. Dry the probe cable with a lint-free soft dry cloth.

Table 14-4 Recommended Method for Medium-level Disinfection

T-spray 11 Pharm. Inc. Quat.Ammonia / Spray/Wipe <10 minutes

T-spray Pharm. Inc. Quat.Ammonia / Spray/Wipe <10 minutes
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] Sterilization

If the probe cable contacts with any blood or body fluid you should sterilize it. For details, refer to the information

about probe sterilization.

14.1.6  Storage and Transportation

You should store or transport the probe in accordance with Appendix A Specifications.

] To Store the Probe

Follow the following items to store the probe.

Store the probe in a probe holder or specific package when not in use.
Ensure the probe holder is clean before storing it.

To avoid contaminating the package, disinfect or sterilize the probe before storing it or store it in a disposable
probe package.

Do not expose it to direct sunlight or sudden environmental temperature changes.
Store the probe alone to avoid any impact on the probe head.

Carefully wind the probe cable.

Dry the probe before storing it.

] To Transport the Probe

Perform the following steps to transport the probe.

1.
2.
3.
4,

Clean and disinfect the probe before transportation.
Place the probe fully into the carrying case and carefully wind the cable.
Close the cover of the carrying case.

Pack the carrying case with sponge and place it in a carton.

14.2  Biopsy

i fWARNING [ )

Only use the biopsy bracket in conjunction with the probe provided by the manufacturer. Otherwise, the system
and probe may be damaged, an accident such as a fire may result in the worst case.

Only trained physicians or sonographers under ultrasound guidance can handle the biopsy needle guides.
During operation, the operator must observe the proper needle insertion sequencing with the needle guide in
order to avoid undue discomfort and unnecessary risk and injury to the patient.

The biopsy guidelines that display on the monitor are intended as a reference. It is the operator’s responsibility
to verify the correct positioning of the needle during a biopsy.

Do not use a needle guide if the path of the needle is not accurately indicated by the on-screen guidelines. The
path of the needle must be displayed within the guidelines. Contact the manufacturer or the local distributer if
the needle path is not accurately indicated.

Do not freeze an image when performing a biopsy.

To avoid hurting the patient accidentally, the operator should be highly focused during a biopsy.

You should activate the biopsy guidelines before performing a biopsy.

The biopsy needle is disposable.

To avoid infection, disinfect the probe and cover it with the probe sheath when performing a biopsy.

To avoid possible personnel injury, the operator should perform the biopsy using an appropriate biopsy bracket.
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14.2.1 Available Biopsy Brackets

NGBC322 C322 14G, 16G, 18G, 20G, 22G Body surface
NGBC344 C344 14G, 16G, 18G, 20G, 22G Body surface
NGBC353 C353 14G, 16G, 18G, 20G, 22G Body surface
NGBC354 C354 14G, 16G, 18G, 20G, 22G Body surface
NGBC611 Ccoll 14G, 16G, 18G, 20G, 22G Body surface
NGBC613 Col13 14G, 16G, 18G, 20G, 22G Body surface
NGBL741 L741 14G, 16G, 18G, 20G, 22G Body surface
NGBL742 L742 14G, 16G, 18G, 20G, 22G Body surface
NGBL752 L752 14G, 16G, 18G, 20G, 22G Body surface
NGB2P1 2P1 14G, 16G, 18G, 20G, 22G Body surface
NGB3C-A 3C-A 14G, 16G, 18G, 20G, 22G Body surface
NGB4P-A 4P-A 14G, 16G, 18G, 20G, 22G Body surface
NGB3P-A 3P-A 14G, 16G, 18G, 20G, 22G Body surface
NGBISL-A 18L-A 14G, 16G, 18G, 20G, 22G Body surface
NGBIL-A 9L-A 14G, 16G, 18G, 20G, 22G Body surface
NGBI13L-A 13L-A 14G, 16G, 18G, 20G, 22G Body surface
NGB3C-B 3C-B 14G, 16G, 18G, 20G, 22G Body surface
NGB4P-B 4P-B 14G, 16G, 18G, 20G, 22G Body surface
NGB8V-A 8V-A 16G, 18G, 20G, 22G Intracavity
NGB6V-A 6V-A 16G, 18G, 20G, 22G Intracavity
NGBEC9-5 EC9-5 16G, 18G, 20G, 22G Intracavity
NGBBCL10-5 BCL10-5 14G, 16G, 18G, 20G, 22G Intracavity
NGBBCC9-5 BCC9-5 16G, 18G, 20G, 22G Intracavity
NGB6V1 6V1 16G, 18G, 20G, 22G Intracavity
NGB6V3 6V3 16G, 18G, 20G, 22G Intracavity
NGB6V7 6V7 16G, 18G, 20G, 22G Intracavity
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14.2.2  Assembling the Biopsy Bracket

] To Assemble the Surface Biopsy Bracket

Tube Holder Biopsy Guide Tube
) V
Fixing Bracket
Handle
\

A
A Locking Screw

Perform the following steps.

1.

Check and ensure that there is no damage, deformation, malfunction, loose or missing parts on the biopsy

bracket before assembly.
Wear sterile gloves.

Unfold the probe sheath and apply an appropriate amount of coupling gel to the inside of the sheath and onto
the face of the probe.

Hold the probe and unroll the sheath onto the probe. Pull the probe sheath tightly over the face of the probe to

remove any wrinkles.

Align the biopsy bracket with the orientation mark of the probe.

Orientation -
mark

6. Attach the biopsy bracket to the probe and fasten the biopsy bracket with the locking screw.
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7. Press the handle and insert the biopsy bracket tube into the biopsy bracket.

e

8. Insert the biopsy needle into the guide tube and make sure that the biopsy bracket is firmly attached to the

/

probe.

9. Unfold another probe sheath, and apply an appropriate amount of coupling gel to the inside of the sheath.
10. Hold the probe attached with the biopsy bracket and unroll the sheath onto both the probe and attached biopsy
bracket.

] To Assemble the Endocavitary Biopsy Bracket

Top Housing

-
|
|

~
Inner Part Guide Tube “
Perform the following steps.

1. Check and ensure that there is no damage, deformation, malfunction, loose or missing parts on the biopsy
bracket before assembly.

2. Wear sterile gloves.
3. Unfold the probe sheath, and apply an appropriate amount of coupling gel into the sheath.

4. Hold the probe and unroll the sheath onto it. Pull the probe sheath tightly over the face of the probe to remove
any wrinkles.

5. Assemble the metal top housing and the biopsy bracket. Slide the inner part into the top housing and push
forward until it clicks.
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6. Align the tip of the biopsy bracket with the left and right grooves on the head of the probe.

7. Hold the tip of the bracket and the head of the probe, and push the other end of the bracket towards the probe to

attach it on the probe.

8. Insert the biopsy needle into the guide tube.
9. Check if the bracket has been firmly attached to the probe. If it is loose, reattach the biopsy bracket.
10. Unfold another probe sheath, and apply an appropriate amount of coupling gel into the sheath.

11. Hold the probe attached with the biopsy bracket, and unroll the sheath onto the probe and attached biopsy
bracket.

14.2.3  Preparing for a Biopsy

warnine Before and after using a rectal or transvaginal probe to perform a biopsy, you should clean and sterilize the probe
and all the biopsy accessories. Otherwise, it may cause a infection risk to the next patient who uses the probe and

accessories.

You should prepare the following items before performing the biopsy.
e New, straight, biopsy needle

e Sterilized container of sterile and degassed water

e Probe attached with biopsy needle

e Activated biopsy guidelines

e Sterile probe sheath

14.2.4  Verifying the Biopsy Bracket

NOTE:

Ensure the biopsy bracket is properly attached to the compatible probe before the verification.
Perform the following steps:

1. Tap Biopsy on the touch screen to in a real time scan of B-mode.

Immerse the probe head into the degassed water.

Insert the biopsy needle into the maximum depth of the water.

LD

Verify that the path of the needle displays according to the guidelines shown on the image screen. After
verification, the needle guide is ready for use.
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14.2.5 Performing a Biopsy

NOTE:

Ensure the biopsy bracket is properly attached to the compatible probe and be verified before you perform a
biopsy.

Perform the following steps:

1. Choose Setup > General > General, set Guide Line Type to Gun or Needle.

2. In the real-time B mode, tap Biopsy to enable the biopsy feature.

For C322, C353, 3P1 or L742 probe, you can preset the biopsy angle.

3. Perform a scan to locate the target.

4. Perform the puncture by sliding the needle through the groove in the guide until the needle, as shown on the

display, intercepts the target.

You can tap Biopsy Cali. to adjust the biopsy guideline.

Biopsy
Cali.

‘ Save ’ ‘ Load Default

Angle Select Angle Offset

< Min > |« 154 > <« 414 >

On this menu,

For C322, C353, 3P1 or L742 probe, tap the left or right part of Angle Select to adjust the angle of the
biopsy guideline freely.

Tap the left or right part of Offset or Angle to adjust the position or angle of the biopsy guideline gradually.
Tap User Mode > Yes to adjust the position and angle of the biopsy guideline freely.

Tap Save to save settings of the biopsy guideline.

Tap Load Default to restore defaults.

5. Adjust the brightness of the biopsy needle on the image.

For linear probes, you can tap Vis-Needle to enhance the brightness for the biopsy needle.
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Biopsy Needle

__ Biopsy Enhanced
Ultrasound Image !

Region Line

— Tap SteerAngle to adjust the angle of the biopsy enhanced region line. The more closely to 90° of angle a,
the stronger brightness of the biopsy needle.

— Tap Dual Live to enter the dual split display for better observation.

6. Gently remove the probe from the patient after completing the biopsy.
14.2.6  Cleaning the Biopsy Bracket

fWARNING e Clean the biopsy bracket after each use.

e Wear medical sterile gloves and protective goggle during the cleaning.

Perform the following steps:

1. Disconnect the probe from the system, and remove the biopsy bracket and biopsy guide tube from the probe.
2. Brush and rinse the bracket with an enzymatic cleaner to remove any residue.

3. Dry the bracket with a lint-free soft dry cloth.
14.2.7  Sterilizing the Biopsy Bracket

warnine @ Disinfect the biopsy bracket after each use.
A e Use the liquid sterilant that meets with local laws and regulations.
e If you use the recommended sterilant, ensure the requirements for the sterilant level and probe soaking period
are met. Otherwise, the biopsy bracket could be damaged and your warranty might be void. If you have further
use or needs for the probe, ensure the level of the make-up sterilant and the biopsy bracket soaking period are

suitable for the intended clinical application.
e Store the biopsy bracket in a sterile environment and review its expiration date before use.
e Do not sterilize the biopsy bracket with any ethylene oxide.

e Do not allow any sterilant to be air-dried on the biopsy bracket.
Perform the following steps:

1. Clean the biopsy bracket.
For details, refer to Section 14.2.6 Cleaning the Biopsy Bracket.

2. Sterilize the biopsy bracket as shown in Table 14-5 until the recommended soaking period expires.
3. Rinse the bracket with the running sterile water to remove the residual sterilant completely.

4. Dry the bracket with a lint-free soft dry cloth.
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Table 14-5 Recommended Method for Sterilization

Cidex™ Activated | J&J Glutaraldehyde | 2.4% Soak 10 hours

Dialdehyde
Solution

14.2.8  Storage

Ensure the biopsy bracket is cleaned, sterilized and completely dried before storing it. Store the biopsy bracket in a
sterile environment and keep it away from the environment of sudden temperature changes or direct sunlight.
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To maintain the safety and functionality of the system, periodically perform the maintenance for the system and

accessories.

fWARNING e To avoid electrical shock and damage to the system, power off and unplug the system from the AC power outlet

before cleaning.

e To maintain the safety and functionality of the system, maintenance must be performed at least once every year.
Electrical safety tests must also be performed at regular intervals as specified by local safety regulations.

15.1 Cleaning the System

15.1.1 To Clean the System Surface
1. Power off and unplug the system from the AC power outlet.
2. Dampen a lint-free soft cloth with 75% ethanol.

3. Use this lint-free soft cloth to clean the surfaces of the monitor screen, the touch screen, the control panel, the
keyboard and the main unit. Take special care and avoid to scratch the screens.

4. Use a cotton swab to remove solids from between keys and controls.
5. In case of blood or any infectious fluids or materials, use a lint-free soft cloth dampened with 70% isopropyl

alcohol.

15.1.2 To Clean the Dust Filter

The dust filter must be cleaned at least every 3 months for ventilation.
1. Power off and unplug the system from the AC power outlet.
2. Pinch the dust filter with fingers as the figure shown above.

3. Rinse the taken out sponge with refresh running water, and use a brush to rinse the dust filter with refresh
running water.

4. Place the sponge and dust filter back to the system after a thorough airing.

15.1.3 To Clean the Trackball
1. Power off and unplug the ultrasound system from the AC power outlet.

2. Press the bulges in the fixing ring by both hands.
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15 System Maintenance

15.2

15.2.3.2

15.3

3. Turn the fixing ring anticlockwise until the ring lifts.

4. Take out the dust ring, the fixing ring and the ball (careful not to drop the ball) from the control panel.
5. Use a lint-free soft cloth dampened with 75% ethanol to clean the dust ring, the fixing ring and the ball.
6. Use a cotton swab dampened with 75% ethanol to remove stains from the surrounding area and edge.

7. Place the ball, the fixing ring and the dust ring back to the control panel, and turn the fixing ring clockwise to
install the trackball.

Maintenance Checks

To maintain the safety and functionality of the system, the following maintenance checks must be performed by
service personnel at least once every year.

Electric Safety

e Integrity of power cable

e Protective conductor resistance
e Ground line leakage current

e Enclosure leakage current

e Patient leakage current

e Patient auxiliary leakage current

Mechanical Safety
e Appearance of the system enclosure

e Appearance of the control panel and the key panel

NOTE:

The surfaces of the control panel or the key panel may be abrasive because of the split liquid or other
cleaning sprays. Check the potential problems carefully when performing maintenance checks.

e Control of foot brake

e Connectivity of interfaces

Image Recording
e Images in each mode

e Image recording using the standard probe

Troubleshooting
Q1: Cannot start the system.

Al: Check whether the system is plugged in, the main power switch is located to | position and the fuse is intact.
If the fuse is blown, replace it as described in Section 15.4 Replacing the Fuse.

Q2: No images are displayed on the LCD monitor.
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15 System Maintenance

15.4

ifWARNING

15.5

15.6

A2: Check whether the power supply cable and video cable are securely connected.
Q3: The LCD monitor displays abnormal.

A3: Check whether you select the appropriate probe and a compatible exam type, or optimize imaging parameters
correctly. For details, refer to Chapter 6 Acquiring Images.

Q4: The measurement cannot be performed after pressing the Cale key on the control panel.

A4: Ensure you pressing the Cale key in the frozen mode.

If any of the above problems still exist, please contact the Customer Service Department of the manufacturer for

help.

Replacing the Fuse

Power off the system and disconnect the power cable from the socket before replacing the fuse.

Two fuses with specifications of SOCT-T3.15AH 250V are provided by the
manufacturer. You can also purchase the fuse with the same specifications for
the fuse replacement.

You can replace the fuse under the instructions of the service personnel if the
fuse is blown.

If the fuse is blown again after a replacement, please stop using the system

immediately and contact customer service.

Equipment Disposal

You should dispose of the main unit, the probe, the biopsy bracket and other accessories in accordance with local
laws and regulations.

For the detailed disposal information, consult the manufacturer or the local distributor. The manufacturer is not

responsible for any system content or accessories that have been discarded improperly.

Customer Service

Only the service personnel of or authorized by the manufacturer can service the system. Any feedback or inquires
concerning our product or services should be directed to the following address.

Contact Address: 2F, 12th Building, Shenzhen Software Park Phase II, Keji Middle 2nd Road, Nanshan District,
Shenzhen, 518057, Guangdong, China

Tel: +86-755-26722890

E-mail: service@sonoscape.net
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Appendix A Specifications

Comply with EN 60601-1 (IEC 60601-1), Medical electrical equipment Part 1: General requirements for
basic safety and essential performance, Class I, BF, continuous operation
EN 60601-2-37 (IEC 60601-2-37), Medical Electrical Equipment Part 2-37: Particular
Requirements for the Basic Safety and Essential Performance of Ultrasonic Medical
Diagnostic and Monitoring Equipment
EN 60601-1-2 (IEC 60601-1-2), Medical electrical equipment- Part 1-2: General
requirements for basic safety and essential performance - Collateral standard:
Electromagnetic compatibility - Requirements and tests
Classifications Type of protection against
. Class I
electrical shock
Degree of protection .
. . Type-BF applied part
against electrical shock
Installation Type Mobile equipment
System is IPX0
Degrees of protection against | Probe (from the acoustic window to the junction line) is
harmful liquid IPX7
Foot switch is IPX4
. The equipment is not suitable for use in the presence of a
According to the degree of . . ) . .
o flammable anesthetic mixture with air, oxygen or nitrous
safety of application .
oxide.
Environmental Operations Storage and Transportation
Requirement Ambient Temperature 10°C~40°C -20°C~+55°C
30%~75% 20%~90%
Relative Humidity ) )
(no condensation) (no condensation)
Atmospheric Pressure 700hPa~1060hPa 700hPa~1060hPa
Power Supply 100-240V~, 2.7-1.1A, 50/60Hz
Fuse Type: 50CT
Breaking capacity: 1500 amperes at 250V AC
Blowing time rating: 30 minutes (Max.)
Current rating: 3.15A
Applied Parts Probes, ECG electrodes
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B.1

B.2

Appendix B EMC Guidance and
Manufacturer’s Declaration

Electromagnetic Emissions

The equipment is intended for use in the electromagnetic environment specified below. The customer or the user of
the EQUIPMENT should assure that it is used in such an environment.

RF emissions The equipment uses RF energy only for its internal function.

CISPR 11 Group 1 Therefore, its RF emissions are very low and are not likely to cause
any interference in nearby electronic equipment.

RF emissions Class B The equipment is suitable for use in all establishments, including

CISPR 11 domestic establishments and those directly connected to the public
low-voltage power supply network that supplies buildings used for

Harmonic emissions Class A domestic purposes.

IEC 61000-3-2

Voltage fluctuations/ | Complies

flicker emissions

IEC 61000-3-3

Electromagnetic Immunity

The equipment is intended for use in the electromagnetic environment specified below. The customer or the user of

the equipment should assure that it is used in such an environment.

Electrostatic
discharge (ESD)

IEC 61000-4-2

+6 kV Contact
+8 kV Air

+6 kV Contact
+8 kV Air

Floors should be wood, concrete or
ceramic tile. If floors are covered
with synthetic material, the relative
humidity should be at least 30%.

Electrical fast
transient/burst

IEC 61000-4-4

+2 kV for power
supply lines;
+1 kV for input/output

lines

+2 kV for power
supply lines;
+1 kV for input/output

lines

Mains power quality should be that
of a typical commercial or hospital

environment.

Surge
IEC 61000-4-5

+1 kV line to line

+2 kV line to earth

+1 kV line to line

+2 kV line to earth

Mains power quality should be that
of a typical commercial or hospital

environment.
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Appendix B EMC Guidance and Manufacturer’s Declaration

Voltage dips | <5% U; <5 % Uy Mains power quality should be
and Short (>95 % dip in Uy) for (>95 % dip in Uy) for that of a typical commercial or
interruptions 0.5 period 0.5 period hospital.environment.. If the u.ser of
IEC 61000-4-11 40% U, 40 % U, the equvlpment fequlres contml.led
operation during power mains
(60 % dip in Uy) for 5 (60 % dip in Ur) for interruptions, it is recommended for
periods 5 periods the equipment to be powered from an
70 % U, 70 % Uy uninterruptible power supply.
(30 % dip in Uy) for 25 | (30 % dip in Uy) for
periods 25 periods
<5 % Ur <5%U,
(>95 % dip in Uy) for (>95 % dip in Uy) for
250 periods 250 periods
Power frequency | 3 A/m 3 A/m Power frequency magnetic fields

(50/60Hz)

magnetic field
IEC 61000-4-8

should be at levels characteristic of a
typical location in a typical commercial
or hospital environment.

NOTE: Uis the a.c. mains voltage prior to application of the test level.
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Appendix B EMC Guidance and Manufacturer’s Declaration

The equipment is intended for use in the electromagnetic environment specified below. The customer or the user of
the equipment should assure that it is used in such an environment.

Conducted RF 3Vrms 1 Vrms Portable and mobile RF communications
IEC 61000-4-6 150kHz-80 MHz equipment should be used no closer to any part
of the EQUIPMENT, including cables, than the
recommended separation distance calculated from
61000-4-3 80 MHz-2.5GHz the equation applicable to the frequency of the
transmitter.

Radiated RF IEC | 3V/m 3 Vrms

Recommended separation distance:

d=35,p

d=1.2,/p 80MHz-800 MHz

d=23 J; 80 MHz-2.5GHz

Where P is the maximum output power rating of the
transmitter in watts (W) according to the transmitter
manufacturer and d is the recommended separation
distance in meters (m). Field strengths from fixed
RF transmitters, as determined by an electromagnetic
site survey,’ should be less than the compliance level
in each frequency range. ° Interference may occur in
the vicinity of equipment marked with the following
symbol:

()

NOTE 1: At 80 MHz and 800 MHz, the higher frequency range applies.

NOTE 2: These guidelines may not apply in all situations. Electromagnetic propagation is affected by
absorption and reflection from structures, objects and people.

* Field strengths from fixed transmitters, such as base stations for radio (cellular/cordless) tele- phones and land
mobile radios, amateur radio, AM and FM radio broadcast and TV broadcast cannot be predicted theoretically
with accuracy. To assess the electromagnetic environment due to fixed RF transmitters, an electromagnetic site
survey should be considered. If the measured field strength in the location in which the EQUIPMENT is used
exceeds the applicable RF compliance level above, the EQUIPMENT should be observed to verify normal
operation. If abnormal performance is observed, additional measures may be necessary, such as re-orienting or
relocating the EQUIPMENT.

"Over the frequency range 150 kHz to 80 MHz, field strengths should be less than 3 V/m.
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Appendix B EMC Guidance and Manufacturer’s Declaration

B.3

Recommended Separation Distances between Portable and
Mobile RF Communications Equipment and the Equipment

The equipment is intended for use in an electromagnetic environment in which radiated RF disturbances are

controlled. The customer or the user of the equipment can help prevent electromagnetic interference by maintaining

a minimum distance between portable and mobile RF communications equipment (transmitters) and the equipment

as recommended below, according to the maximum output power of the communications equipment.

0.01

0.12

0.12

0.23

0.1

0.38

0.38

0.73

1

1.2

1.2

2.3

10

3.8

3.8

7.3

100

12

12

23

For transmitters rated at a maximum output power not listed above, the recommended separation distance d in

meters (m) can be estimated using the equation applicable to the frequency of the transmitter, where P is the

maximum output power rating of the transmitter in watts (W) according to the transmitter manufacturer.

NOTE 1: At 80 MHz and 800 MHz, the separation distance for the higher frequency range applies.

NOTE 2: These guidelines may not apply in all situations. Electromagnetic propagation is affected by

absorption and reflection from structures, objects and people
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Appendix C In Situ, Derated, and
Water Value Intensities

All intensity parameters are measured in water. Since water absorbs very little acoustic energy, these water
measurements represent a worst case value. Biological tissue does absorb acoustic energy. The true value of the
intensity at any point depends on the amount and type of tissue and the frequency of the ultra-sound that passes
through the tissue. The intensity value in the tissue, In Situ, has been estimated by using the following formula:
In Situ = Water[e"*""]
where: In Situ = In Situ Intensity Value
Water = Water Value Intensity
e=2.7183
a = Attenuation Factor
Tissue = a (dB/cm-MHz)
Amniotic Fluid = 0.006
Brain =0.53
Heart = 0.66
Kidney = 0.79
Liver = 0.43
Muscle = 0.55
1 = Skin line to measurement depth (cm)

f = Center frequency of the transducer/system/mode combination (MHz)

Since the ultrasonic path during an examination is likely to pass through varying lengths and types of tissue, it is
difficult to estimate the true In Situ intensity. An attenuation factor of 0.3 is used for general reporting purposes;
therefore, the In Situ value which is commonly reported uses the formula:

In Situ derated = Water[e"**"]

Since this value is not the true In Situ intensity, the term “derated” is used.
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Appendix D Recommended Coupling
Gel, Cleaner and Disinfectant

NOTE:

« This appendix contains the latest information about the recommended coupling gels,
cleaners and disinfectants when the user manual is released. The appendix is subject to

change without prior notice.

+ Some of the probe models listed in the following tables can be used with this system. For
details, refer to Section 14.1.1 Available Probes.

Coupling Gel

Probe Model

Applicable

Inapplicable

MPTEE Mini 7-4, MPTEE 7-4,
MPTEE, MPTEE mini, 12C-ER

Aquasonic 100, Aquasonic Clear, Sterile
Aquasonic, Clear Image/Single, Sterile
Ultraphonic Gel

Transonic gel, Clear
Scanning Gel, Multigel
Gel

LAP7, C9-5, 1012, 6CI-A, 6CT-A,

Aquasonic 100, Aquasonic Clear, Sterile

Clear Scanning Gel,

7LI4, 1013, 10L-I, 12L-I, 12LI-A, | Aquasonic, Clear Image/Single, Sterile | Multigel Gel
12LT-A,11L-1 Ultraphonic Gel, Transonic gel
EC2, EC9-5, 5VI, 6V1, 6V3, 6V4, | Aquasonic 100, Aquasonic Clear, Sterile | Multigel Gel

6V5, BCC9-4, BCC9-5, BCL10-5,
6V-A, 6VI1A, 6V2A, 6V3A, 6V7, 8V-
A, 6CT4

Aquasonic, Clear Image/Single, Sterile
Ultraphonic Gel, Transonic gel, Clear

Scanning Gel

VC6-2, VC8-3, VC311, VEO9-
5, VL12-5, CWD2.0, CWD4.0,
CWDS5.0, CWDS.0, PWD2.0

Aquasonic 100, Aquasonic Clear, Sterile
Aquasonic, Clear Image/Single, Sterile
Ultraphonic Gel, Transonic gel

Clear Scanning Gel,
Multigel Gel

2P1, 5P1, 10L1, C311, C321, C343,
C344, C351, C352, C361, C362,
C511, C521, C541, C542, C543,
C611, C612, C721, L541, L561V,
L662V, L741, L741V, L742, L743,
L745, L746, L751, L752, L761V,
L744, C312, C322, C345, C353,
C354, C544, C613, C5-1, 3C-A, Cl-
6, 2P2, 3P1, 3P-A, 4P-A, 4P-B, 5P2,
7P-A, 7P-B, 8P1, 12P-A, 12P-B, P5-
1,3C-B, 9L-A, 13L-A, 18L-A, LAP7,
S1-5, 12L-A

Aquasonic 100, Aquasonic Clear, Sterile
Aquasonic, Clear Image/Single, Sterile
Ultraphonic Gel, Transonic gel, Clear
Scanning Gel, Multigel Gel
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Appendix D Recommended Coupling Gel, Cleaner and Disinfectant

D.2  Cleaner
MPTEE Mini 7-4, MPTEE 7-4, MPTEE, MPTEE mini, | Mild soapy water T-spray, T-spray II,
12C-ER Transeptic, 70% IPA
LAP7, C9-5, 1012, 6CI-A, 6CT-A, 7LI4, 1013, 10L-I, 12L-I, | T-spray, T-spray II, | Transeptic, 70% IPA
12LI-A, 12LT-A,11L-I mild soapy water
EC2, EC9-5, 5V1, 6V1, 6V3, 6V4, 6V5, BCC9-4, BCCY9-5, | T-spray, T-spray II, | Transeptic, 70%
BCL10-5, 6V-A, 6V1A, 6V2A, 6V3A, 6V7, 8V-A, 6CT4 mild soapy water IPA,
VC6-2, VC8-3, VC311, VE9-5, VL12-5, CWD2.0, CWD4.0, | T-spray, T-spray II, | Transeptic, 70% IPA
CWD5.0, CWDS.0, PWD2.0 mild soapy water
2P1, 5P1, 10L1, C311, C321, C343, C344, C351, C352, C361, | T-spray, T-spray II, | Transeptic
C362, C511, C521, C541, C542, C543, Co611, C612, C721, | mild soapy water,
L541, L561V, L662V, L741, L741V, L742, L743, L745, L746, | 70% IPA
L751, L752, L761V, L744, C312, C322, C345, C353, C354,
C544, C613, C5-1, 3C-A, C1-6, 2P2, 3P1, 3P-A, 4P-A, 4P-B,
5P2, 7P-A, 7P-B, 8P1, 12P-A, 12P-B, P5-1, 3C-B, 9L-A, 13L-
A, 18L-A, LAP7, S1-5, 12L-A

D.3  Disinfectant

MPTEE Mini 7-4, MPTEE 7-4, MPTEE, MPTEE
mini, 12C-ER

Cidex OPA Solution,
Cidex, Metricide 14

Metricide 28, Metricide
30, Resert XL HLD

LAP7, C9-5, 1012, 6CI-A, 6CT-A, 7LI14, 1013, 10L-I,
12L-1, 12LI1-A, 12LT-A,11L-I

Cidex OPA Solution,
Cidex, Metricide 14

Metricide 28, Metricide
30, Resert XL HLD

EC2, EC9-5, 5V1, 6V1, 6V3, 6V4, 6V5, BCC9-4,
BCC9-5, BCL10-5, 6V-A, 6V1A, 6V2A, 6V3A, 6V7,
8V-A, 6CT4

Cidex OPA Solution,
Cidex, Metricide 14,
Resert XL HLD

Metricide 28, Metricide
30

VCe6-2, VC8-3, VC311, VE9-5, VL12-5, CWD2.0,
CWD4.0, CWD5.0, CWD8.0, PWD2.0

Cidex OPA Solution,
Cidex, Metricide 14

Metricide 28, Metricide
30, Resert XL HLD

2P1, 5P1, 10L1, C311, C321, C343, C344, C351,
€352, C361, C362, C511, C521, C541, C542, C543,
C611, C612, C721, L541, L561V, L662V, L741,
L741V, L742, L743, L745, L746, L751, L752,
L761V, L744, C312, C322, C345, C353, C354, C544,
C613, C5-1, 3C-A, C1-6, 2P2, 3P1, 3P-A, 4P-A, 4P-
B, 5P2, 7P-A, 7P-B, 8P1, 12P-A, 12P-B, P5-1, 3C-B,
9L-A, 13L-A, 18L-A, LAP7, S1-5, 12L-A

Cidex OPA Solution,
Cidex, Metricide 14,
Resert XL HLD

Metricide 28, Metricide
30
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Appendix E Acoustic Output Data

Please refer to Section 4.11.2 Acoustic Output.
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